





7 Creating PDF Templates


This chapter describes creating PDF templates for BI Publisher.

This chapter includes the following sections:

	
Section 7.1, "Overview"


	
Section 7.2, "Requirements"


	
Section 7.3, "Designing the Template"


	
Section 7.4, "Adding Markup to the Template"


	
Section 7.5, "Creating a Placeholder"


	
Section 7.6, "Defining Groups of Repeating Fields"


	
Section 7.7, "Adding Page Numbers and Breaks"


	
Section 7.8, "Performing Calculations"


	
Section 7.9, "Completed PDF Layout Example"


	
Section 7.10, "Runtime Behavior"


	
Section 7.11, "Creating a Layout from a Predefined PDF Form"


	
Section 7.12, "Adding or Designating a Field for a Digital Signature"






7.1 Overview

To create a PDF template, take any existing PDF document and apply the BI Publisher markup. Because you can use a PDF from any source, you have multiple design options. For example:

	
Design the template using any application that generates documents that can be converted to PDF


	
Scan a paper document to use as a template


	
Download a PDF document from a third-party Web site







	
Note:

The steps required to create a template from a third-party PDF depend on whether form fields have been added to the document. For more information, see Section 7.11, "Creating a Layout from a Predefined PDF Form."









If you are designing the template, then when you have converted to PDF, the template is treated like a set background. When you mark up the template, you draw fields on top of this background. To edit the template, you must edit the original document and then convert back to PDF.

For this reason, the PDF template is not recommended for documents that require frequent updates. However, it is appropriate for forms that have a fixed template, such as invoices or purchase orders.






7.2 Requirements

To apply or edit form fields to a PDF document, you must have Adobe Acrobat Professional. BI Publisher supports Adobe Acrobat 5.0 and later as a tool for updating the template. Regardless of version that you are using to design the template, you must save the PDF file as Adobe Acrobat 5.0 (PDF specification version 1.4).




	
Note:

If you are using a later version of Adobe Acrobat Professional, then you must use the Reduce File Size Option (available from the Document menu or from the File menu depending on the version) to save the file as Adobe Acrobat 5.0 compatible.









For PDF conversion, BI Publisher supports any PDF conversion utility, such as Adobe Acrobat Distiller.






7.3 Designing the Template

To design the template you can use any desktop application that generates documents that can be converted to PDF. Or, scan in an original paper document to use as the background for the template.

Figure 7-1 shows a template for a sample purchase order. It was designed using Microsoft Word and converted to PDF using Adobe Acrobat Distiller.


Figure 7-1 Template for a Sample Purchase Order

[image: Description of Figure 7-1 follows]

Description of "Figure 7-1 Template for a Sample Purchase Order"





The following is the XML data that is used as input to this template:


<?xml version="1.0"?>
<POXPRPOP2>
 <G_HEADERS>
  <POH_PO_NUM>1190-1</POH_PO_NUM>
  <POH_REVISION_NUM>0</POH_REVISION_NUM>
  <POH_SHIP_ADDRESS_LINE1>3455 108th Avenue</POH_SHIP_ADDRESS_LINE1>
<POH_SHIP_ADDRESS_LINE2></POH_SHIP_ADDRESS_LINE2>
<POH_SHIP_ADDRESS_LINE3></POH_SHIP_ADDRESS_LINE3>
<POH_SHIP_ADR_INFO>Seattle, WA 98101</POH_SHIP_ADR_INFO>
<POH_SHIP_COUNTRY>United States</POH_SHIP_COUNTRY>
<POH_VENDOR_NAME>Allied Manufacturing</POH_VENDOR_NAME>
<POH_VENDOR_ADDRESS_LINE1>1145 Brokaw Road</POH_VENDOR_ADDRESS_LINE1>
<POH_VENDOR_ADR_INFO>San Jose, CA 95034</POH_VENDOR_ADR_INFO>
<POH_VENDOR_COUNTRY>United States</POH_VENDOR_COUNTRY>
<POH_BILL_ADDRESS_LINE1>90 Fifth Avenue</POH_BILL_ADDRESS_LINE1>
<POH_BILL_ADR_INFO>New York, NY 10022-3422</POH_BILL_ADR_INFO>
<POH_BILL_COUNTRY>United States</POH_BILL_COUNTRY>
<POH_BUYER>Smith, J</POH_BUYER>
<POH_PAYMENT_TERMS>45 Net (terms date + 45)</POH_PAYMENT_TERMS>
<POH_SHIP_VIA>UPS</POH_SHIP_VIA>
<POH_FREIGHT_TERMS>Due</POH_FREIGHT_TERMS>
<POH_CURRENCY_CODE>USD</POH_CURRENCY_CODE>
<POH_CURRENCY_CONVERSION_RATE></POH_CURRENCY_CONVERSION_RATE>
<LIST_G_LINES>
<G_LINES>
<POL_LINE_NUM>1</POL_LINE_NUM>
<POL_VENDOR_PRODUCT_NUM></POL_VENDOR_PRODUCT_NUM>
<POL_ITEM_DESCRIPTION>PCMCIA II Card Holder</POL_ITEM_DESCRIPTION>
<POL_QUANTITY_TO_PRINT></POL_QUANTITY_TO_PRINT>
<POL_UNIT_OF_MEASURE>Each</POL_UNIT_OF_MEASURE>
<POL_PRICE_TO_PRINT>15</POL_PRICE_TO_PRINT>
<C_FLEX_ITEM>CM16374</C_FLEX_ITEM>
<C_FLEX_ITEM_DISP>CM16374</C_FLEX_ITEM_DISP>
<PLL_QUANTITY_ORDERED>7500</PLL_QUANTITY_ORDERED>
<C_AMOUNT_PLL>112500</C_AMOUNT_PLL>
<C_AMOUNT_PLL_DISP> 112,500.00 </C_AMOUNT_PLL_DISP>
</G_LINES>
</LIST_G_LINES>
<C_AMT_POL_RELEASE_TOTAL_ROUND>312420/<C_AMT_POL_RELEASE_TOTAL_ROUND>
</G_HEADERS>
</POXPRPOP2>






7.4 Adding Markup to the Template

After you have converted a document to PDF, you define form fields that display the data from the XML input file. These form fields are placeholders for the data.

The process of associating the XML data to the PDF template is the same as the process for the RTF template. See Section 4.2, "Associating the XML Data to the Template Layout."

When you draw the form fields in Adobe Acrobat, you are drawing them on top of the template that you designed. There is not a relationship between the design elements on the template and the form fields. You therefore must place the fields exactly where you want the data to display on the template.






7.5 Creating a Placeholder

You can define a placeholder as text, a check box, or a radio button, depending on how you want the data presented.




	
Note:

The steps for adding a form field depend on the version of Adobe Acrobat Professional that you are using. See the Adobe documentation for the version. If you are using Adobe Acrobat 9 Pro, then from the Forms menu, select Add or Edit Fields.











7.5.1 Naming the Placeholder

The name of the placeholder must match the XML source field name.






7.5.2 Creating a Text Placeholder

The following describes how to create a text Form Field placeholder using Adobe Acrobat 9 Pro. If you are using a different version of Adobe Acrobat Professional, then refer to the documentation for details.

To create a text placeholder:

	
From the Forms menu, select Add or Edit Fields.


	
From the Add New Field list, choose Text Field. The cursor becomes a crosshair.


	
Place the crosshair in the form where you want the field to reside and click. The Field Name dialog pops up.


	
Enter the name. The name of the text field must match the name of the XML element from the data that is to populate this field at runtime.


	
To set more properties, click Show All Properties

Use the Properties dialog box to set other attributes for the placeholder. For example, enforce maximum character size, set field data type, data type validation, visibility, and formatting.


	
If the field is not placed exactly where desired, or is not the correct size, drag the field for exact placement and resize the field using the handles.


	
Important: When you have added all the fields, you must make the template compatible with Adobe Acrobat 5.0. From the Document menu, select Reduce File Size. From the Make Compatible with list, select Adobe Acrobat 5.0 and later.









7.5.3 Supported Field Properties Options

BI Publisher supports the following options available from the Field Properties dialog box. For more information about these options, see the Adobe Acrobat documentation.

	
General

	
Read Only

The setting of this check box in combination with a set of configuration properties control the read-only/updatable state of the field in the output PDF. See Section 7.10.2, "Setting Fields as Updatable or Read Only."


	
Required


	
Visible/Hidden


	
Orientation (in degrees)





	
Appearance

	
Border Settings: color, background, width, and style


	
Text Settings: color, font, size


	
Border Style





	
Options tab

	
Multi-line


	
Scrolling Text





	
Format tab - Number category options only


	
Calculate tab - all calculation functions









7.5.4 Creating a Check Box

A check box is used to present options from which more than one can be selected. Each check box represents a different data element. You define the value that causes the check box to display as "checked."

For example, a form contains a check box listing of automobile options such as Power Steering, Power Windows, and Sunroof. Each of these represents a different element from the XML file (for example <POWER_STEERING>). If the XML file contains a value of "Y" for any of these fields, you want the check box to display as checked. All or none of these options may be selected.

The following describes how to create a check box field using Adobe Acrobat 9 Pro. If you are using a different version of Adobe Acrobat Professional, refer to the documentation for details.

To create a check box:

	
From the Forms menu, select Add or Edit Fields.


	
From the Add New Field list, choose Check Box. The cursor becomes a crosshair.


	
Place the crosshair in the form where you want the field to reside and click. The Field Name dialog pops up.


	
Enter the name. The name of the check box field must match the name of the XML element from the data that is to determine its state (checked or unchecked).


	
Click Show All Properties


	
Click the Options tab.


	
Select the Check Box Style type from the list.


	
In the Export Value field enter the value that the XML data field should match to enable the "checked" state.

For the example, enter "Y" for each check box field.


	
Set other Properties as desired.









7.5.5 Creating a Radio Button Group

A radio button group is used to display options from which only one can be selected.

For example, the XML data file contains a field called <SHIPMENT_METHOD>. The possible values for this field are "Standard" or "Overnight". You represent this field in the form with two radio buttons, one labeled "Standard" and one labeled "Overnight". Define both radio button fields as placeholders for the <SHIPMENT_METHOD> data field. For one field, define the "on" state when the value is "Standard". For the other, define the "on" state when the value is "Overnight".

The following describes how to create a radio button group using Adobe Acrobat 9 Pro. If you are using a different version of Adobe Acrobat Professional, then refer to the documentation for details.

To create a radio button group:

	
From the Forms menu, select Add or Edit Fields.


	
From the Add New Field list, choose Radio Button. The cursor becomes a crosshair.


	
Place the crosshair in the form where you want the radio button group to reside and click. The Radio Group Name dialog pops up.


	
Enter the name. The name of the radio group must match the name of the XML element from the data that is to determine its state (selected or unselected).


	
In the Button Value field enter the value that the XML data field should match to enable the "on" state.

For the example, enter "Standard" for the field labeled "Standard".


	
To enter another radio button to the group, click Add another button to group. The name of the radio group defaults into the name field.


	
In the Button Value field enter the value that the XML data field should match to enable the "on" state for this button.

For example, enter "Overnight" for the field labeled "Overnight".


	
If you want to change any of the properties, then click Show All Properties. To change the radio button style, click the Options tab.


	
Select Radio Button from the Type drop down list.


	
Set other Properties as desired.











7.6 Defining Groups of Repeating Fields

In the PDF layout, you explicitly define the area on the page that contains the repeating fields. For example, on the purchase order layout, the repeating fields should display in the block of space between the Item header row and the Total field.

To define the area to contain the group of repeating fields:

	
Insert a Text Field at the beginning of the area that is to contain the group.


	
In the Field Name dialog, enter any unique name you choose. This field is not mapped.


	
In the Tooltip field of the Text Field Properties dialog, enter the following syntax:

<?rep_field="BODY_START"?>


	
Define the end of the group area by inserting a Text Field at the end of the area the that is to contain the group.


	
In the Field Name dialog, enter any unique name you choose. This field is not mapped. Note that the name you assign to this field must be different from the name you assigned to the "body start" field.


	
In the Tooltip field of the Text Field Properties dialog, enter the following syntax:

<?rep_field="BODY_END"?>




To define a group of repeating fields:

	
Insert a placeholder for the first element of the group.




	
Note:

The placement of this field in relationship to the BODY_START tag defines the distance between the repeating rows for each occurrence. See Section 7.10.1, "Placement of Repeating Fields."










	
For each element in the group, enter the following syntax in the Tooltip field:

<?rep_field="T1_Gn"?>

where n is the row number of the item on the layout.

For example, the group in the sample report is laid out in three rows.

	
For the fields belonging to the row that begins with "PO_LINE_NUM" enter

<?rep_field="T1_G1"?>


	
For the fields belonging to the row that begins with "C_FLEX_ITEM_DISP" enter

<?rep_field="T1_G2"?>


	
For the fields belonging to the row that begins with "C_SHIP_TO_ADDRESS" enter

<?rep_field="T1_G3"?>




Figure 7-2 shows the entries for the Short Description/Tooltip field.


Figure 7-2 Entries for the Short Description/Tooltip Field

[image: Description of Figure 7-2 follows]

Description of "Figure 7-2 Entries for the Short Description/Tooltip Field"





	
(Optional) Align the fields. To ensure proper alignment of a row of fields, it is recommended that you use Adobe Acrobat's alignment feature.









7.7 Adding Page Numbers and Breaks

This section describes how to add the following page features to the PDF layout:

	
Section 7.7.1, "Adding Page Numbers"


	
Section 7.7.2, "Adding Page Breaks"






7.7.1 Adding Page Numbers

To add page numbers, define a field in the layout where you want the page number to appear and enter an initial value in that field.

To add page numbers:

	
Decide the position on the layout where you want the page number to be displayed.


	
Create a placeholder field called @pagenum@ (See Section 7.5.2, "Creating a Text Placeholder.")


	
Enter a starting value for the page number in the Default field (Text Field Properties > Options tab). If the XML data includes a value for this field, then the start value that is assigned in the layout is overridden. If no start value is assigned, then it defaults to 1.









7.7.2 Adding Page Breaks

You can define a page break in the layout to occur after a repeatable field. To insert a page break after the occurrence of a specific field, add the following to the syntax in the Tooltip field of the Text Field Properties dialog:

page_break="yes"

For example:

<?rep_field="T1_G3", page_break="yes"?>

The following example demonstrates inserting a page break in a layout. The XML sample contains salaries of employees by department:


<?xml version="1.0"?>
<! -  Generated by Oracle Reports version 6.0.8.22.0  - >
<ROOT>
  <LIST_G_DEPTNO>
    <G_DEPTNO>
      <DEPTNO>10</DEPTNO>
      <LIST_G_EMPNO>
        <G_EMPNO>
          <EMPNO>7782</EMPNO>
          <ENAME>CLARK</ENAME>
          <JOB>MANAGER</JOB>
          <SAL>2450</SAL>
        </G_EMPNO>
        <G_EMPNO>
          <EMPNO>7839</EMPNO>
          <ENAME>KING</ENAME>
          <JOB>PRESIDENT</JOB>
          <SAL>5000</SAL>
        </G_EMPNO>
        <G_EMPNO>
          <EMPNO>125</EMPNO>
          <ENAME>KANG</ENAME>
          <JOB>CLERK</JOB>
          <SAL>2000</SAL>
        </G_EMPNO>
        <G_EMPNO>
          <EMPNO>7934</EMPNO>
          <ENAME>MILLER</ENAME>
          <JOB>CLERK</JOB>
          <SAL>1300</SAL>
        </G_EMPNO>
        <G_EMPNO>
          <EMPNO>123</EMPNO>
          <ENAME>MARY</ENAME>
          <JOB>CLERK</JOB>
          <SAL>400</SAL>
        </G_EMPNO>
        <G_EMPNO>
          <EMPNO>124</EMPNO>
          <ENAME>TOM</ENAME>
          <JOB>CLERK</JOB>
          <SAL>3000</SAL>
        </G_EMPNO>
      </LIST_G_EMPNO>
      <SUMSALPERDEPTNO>9150</SUMSALPERDEPTNO>
    </G_DEPTNO>
    
    <G_DEPTNO>
      <DEPTNO>30</DEPTNO>
      <LIST_G_EMPNO>
        .
        .
        .   
        
      </LIST_G_EMPNO>
      <SUMSALPERDEPTNO>9400</SUMSALPERDEPTNO>
    </G_DEPTNO>
  </LIST_G_DEPTNO>
  <SUMSALPERREPORT>29425</SUMSALPERREPORT>
</ROOT>


Suppose the report requirement is to display the salary information for each employee by department as shown in Figure 7-3.


Figure 7-3 Department Salary Summary Example

[image: Department Salary Summary Example]

Description of "Figure 7-3 Department Salary Summary Example"





To insert a page break after each department, insert the page break syntax in the Tooltip field for the SUMSALPERDEPTNO field as follows:


<?rep_field="T1_G3", page_break="yes"?>


The Text Field Properties dialog for the field is shown in Figure 7-4.


Figure 7-4 The Text Field Properties Dialog

[image: Description of Figure 7-4 follows]

Description of "Figure 7-4 The Text Field Properties Dialog"





Note that in order for the break to occur, the field must be populated with data from the XML file.

The sample report with data is shown in Figure 7-5.


Figure 7-5 A Sample Report with Data

[image: Surrounding text describes Figure 7-5 .]

[image: Description of Figure 7-5 follows]

Description of "Figure 7-5 A Sample Report with Data"





The page breaks after each department.








7.8 Performing Calculations

Adobe Acrobat provides a calculation function in the Field Properties dialog box.

To create a field to display a calculated total on a report:

	
Create a text field to display the calculated total. Give the field any Name you choose.


	
In the Field Properties dialog box, select the Format tab.


	
Select Number from the Category list.


	
Select the Calculate tab.


	
Select the radio button next to "Value is the <List of operations> of the following fields:"


	
Select sum (+) from the list.


	
Click the Pick... button and select the fields to be totaled.









7.9 Completed PDF Layout Example

Figure 7-6 shows the completed PDF layout.


Figure 7-6 A Completed PDF Layout

[image: Description of Figure 7-6 follows]

Description of "Figure 7-6 A Completed PDF Layout"









7.10 Runtime Behavior

The following sections describe runtime behavior of PDF templates:

	
Section 7.10.1, "Placement of Repeating Fields"


	
Section 7.10.2, "Setting Fields as Updatable or Read Only"


	
Section 7.10.3, "Overflow Data"






7.10.1 Placement of Repeating Fields

As already noted, the placement, spacing, and alignment of fields that you create on the layout are independent of the underlying form layout. At runtime, BI Publisher places each repeating row of data according to calculations performed on the placement of the rows of fields that you created, as follows:

First occurrence:

The first row of repeating fields displays exactly where you have placed them on the layout.

Second occurrence, single row:

To place the second occurrence of the group, BI Publisher calculates the distance between the BODY_START tag and the first field of the first occurrence. The first field of the second occurrence of the group is placed this calculated distance below the first occurrence.

Second occurrence, multiple rows:

If the first group contains multiple rows, then the second occurrence of the group is placed the calculated distance below the last row of the first occurrence.

The distance between the rows within the group is maintained as defined in the first occurrence.






7.10.2 Setting Fields as Updatable or Read Only

When you define a field in the layout, you have the option of selecting "Read Only" for the field, as shown in Figure 7-7:


Figure 7-7 Read Only Option in The Text Field Properties Dialog

[image: Description of Figure 7-7 follows]

Description of "Figure 7-7 Read Only Option in The Text Field Properties Dialog"





Regardless of what you choose at design time for the Read Only check box, the default behavior of the PDF processing engine is to set all fields to read-only for the output PDF. You can change this behavior using the following report properties, as described in Chapter 10, "Setting Report Processing and Output Document Properties":

	
all-field-readonly


	
all-fields-readonly-asis


	
remove-pdf-fields




Note that in the first two options, you are setting a state for the field in the PDF output. The setting of individual fields can still be changed in the output using Adobe Acrobat Professional. Also note that because the fields are maintained, the data is still separate and can be extracted. In the third option, "remove-pdf-fields" the structure is flattened and no field/data separation is maintained.

To make all fields updatable:

Set the "all-field-readonly" property to "false". This sets the Read Only state to "false" for all fields regardless of the individual field settings at design time.

To make all fields read only:

This is the default behavior. No settings are required.

To maintain the Read Only check box selection for each field:

To maintain the setting of the Read Only check box on a field-by-field basis in the output PDF, set the property "all-fields-readonly-asis" to "true". This property overrides the settings of "all-field-readonly".

To remove all fields from the output PDF:

Set the property "remove-pdf-fields" to "true".






7.10.3 Overflow Data

When multiple pages are required to accommodate the occurrences of repeating rows of data, each page displays identically except for the defined repeating area, which displays the continuation of the repeating data. For example, if the item rows of the purchase order extend past the area defined on the layout, succeeding pages displays all data from the purchase order form with the continuation of the item rows.








7.11 Creating a Layout from a Predefined PDF Form

There are many PDF forms available online that you may want to use as layouts for the report data. For example, government forms that your company is required to submit. You can use these downloaded PDF files as the report layouts, supplying the XML data at runtime to fill in the report fields.

Some of these forms already have form fields defined, some do not. See Section 7.11.1, "Determining If a PDF Has Form Fields Defined" if you are unsure. If the PDF form already has fields defined, then you can use one of the following methods to match the form field names to the data field names:

	
Use Adobe Acrobat Professional to rename the fields in the document to match the names of the elements in the XML data file. See Section 7.11.2, "Using a Predefined PDF Form as a Layout by Renaming the Form Fields."


	
Use BI Publisher's Data Model Editor to rename the XML element names in the data file to match the field names in the PDF form. For information, see the "Structuring Data" chapter in Oracle Fusion Middleware Data Modeling Guide for Oracle Business Intelligence Publisher.




If the form fields are not already defined in the downloaded PDF, then you must create them. See Section 7.4, "Adding Markup to the Template" for instructions on inserting the form field placeholders.



7.11.1 Determining If a PDF Has Form Fields Defined

To determine if the PDF form has form fields defined:

	
Open the document in Adobe Acrobat Reader or Adobe Acrobat Professional.


	
Click Highlight Fields. Form fields that exist in the document are highlighted.




To get a list of the field names:

	
Open the document in Adobe Acrobat Professional.


	
From the Form menu, select Add or Edit Fields. The field names display in the document as well as in the Fields pane.









7.11.2 Using a Predefined PDF Form as a Layout by Renaming the Form Fields

To use a predefined PDF form as a layout:

	
Download or import the PDF file to the local system.


	
Open the file in Adobe Acrobat Professional.


	
From the Form menu, select Add or Edit Fields. This highlights text fields that have already been defined.

Figure 7-8 shows a sample W-2 PDF form after selecting Add or Edit Fields to highlight the text fields.


Figure 7-8 A Sample W-2 PDF Form After Selecting the Add or Edit Fields Option

[image: Description of Figure 7-8 follows]

Description of "Figure 7-8 A Sample W-2 PDF Form After Selecting the Add or Edit Fields Option"





To map the existing form fields to the data from the incoming XML file, rename the fields to match the element names in the XML file.


	
Open the form field Text Field Properties dialog by either double-clicking the field, or by selecting the field then selecting Properties from the right-mouse menu.


	
In the Name field, enter the element name from the input XML file.


	
Repeat for all fields that you want populated by the data file.


	
When all fields have been updated, click Close Form Editing.


	
IMPORTANT: Make the layout compatible with Adobe Acrobat 5.0. From the Document menu, select Reduce File Size. From the Make Compatible with list, choose Adobe Acrobat 5.0 and later.


	
Save the layout.









7.11.3 Using the Comb of Characters Option

The comb of characters option for a PDF form field in Adobe Acrobat spreads the text evenly across the width of the text field. Use this option when the form field requires the characters to be entered in specific positions, as the Routing number field shown in Figure 7-9:


Figure 7-9 Example of PDF Form Field Requiring Characters in Specific Positions

[image: Surrounding text describes Figure 7-9 .]



To use this feature, perform the following:

	
In Adobe Acrobat Professional, add the form field as a text field. An example is shown in the following figure:

[image: Create the routing form field]

	
Open the Text Field Properties dialog and click the Options tab. Clear all check boxes and select the Comb of characters check box.




	
Note:

The Comb of characters option is only enabled when all other options are cleared.









Enter the number of characters in the text field. For the routing number example, a value of 9 is entered as shown in the following figure: [image: Text Field Properties Option tab]


If your data may not contain the number of characters specified each time, you can set the Alignment option to specify whether the value will be aligned to the right, left, or center within the field.




When you run the report, the characters comprising the value for the routing field will be spread across the text field as shown in Figure 7-10:


Figure 7-10 Example with Data

[image: Surrounding text describes Figure 7-10 .]



Figure 7-10 shows how the data will display in the field when the data for the routing field does not contain the full nine characters and the Alignment option is set to left:


Figure 7-11 Example of Left-Aligned Data

[image: Surrounding text describes Figure 7-11 .]









7.12 Adding or Designating a Field for a Digital Signature

Oracle BI Publisher supports digital signatures on PDF output documents. Digital signatures enable you to verify the authenticity of the documents you send and receive. Oracle BI Publisher can access the digital ID file from a central, secure location and at runtime sign the PDF output with the digital ID. The digital signature verifies the signer's identity and ensures that the document has not been altered after it was signed.

Implementing digital signature requires several tasks across the BI Publisher product. This topic describes how to add a new field or configure an existing field in the PDF template for the digital signature. For more information and a description of the other required tasks and options, see the "Implementing a Digital Signature" section in Oracle Fusion Middleware Administrator's Guide for Oracle Business Intelligence Publisher.



7.12.1 About Signature Field Options

For PDF templates you have the following options for designating a digital signature field for the output report:

	
Add a signature field to the PDF layout.

Use this option if you want the digital signature to appear in a specific field and the PDF template does not already include a signature field. See Section 7.12.2, "Adding a Signature Field."


	
Use an existing signature field in the PDF template.

Use this option if the PDF template already includes a signature field that you want to use. To designate an existing field for the digital signature, define the field in the Runtime Configuration page. See Section 7.12.3, "Configuring the Report to Insert the Digital Signature at Runtime."


	
Designate the position of the digital signature on the output report by setting x and y coordinates.

Use this option if you prefer to designate the x and y coordinates for the placement of the digital signature, rather than use a signature field. You set the position using runtime properties. For information on setting these properties, see Section 10.4, "PDF Digital Signature Properties."




All three options require setting configuration properties for the report in the Report Properties page after you have uploaded the template.






7.12.2 Adding a Signature Field

To add a signature field:

	
Open the template in Adobe Acrobat Professional.


	
From the Form menu, select Add or Edit Fields. Then click Add New Field. Choose Digital Signature from the list of fields.


	
Draw the signature field in the desired location on the layout. When you release the mouse button, a dialog prompts you to enter a name for the field.


	
Enter a name for the signature field. Figure 7-12 shows an inserted digital signature field called "My_Signature."


Figure 7-12 An Inserted Digital Signature Field Called My_Signature

[image: Description of Figure 7-12 follows]

Description of "Figure 7-12 An Inserted Digital Signature Field Called My_Signature"





	
Save the template.


	
Proceed to Section 7.12.3, "Configuring the Report to Insert the Digital Signature at Runtime."









7.12.3 Configuring the Report to Insert the Digital Signature at Runtime

After you have uploaded the PDF template to the report definition (see Section 2.5.2, "Adding a Layout by Uploading a Template File"), you must enable digital signature and specify the signature field in the Report Properties.

To configure the report to insert the digital signature:

	
From the edit report page, click Properties and then click the Formatting tab.


	
Scroll to the PDF Digital Signature group of properties.


	
Set Enable Digital Signature to True.


	
For the property Existing signature field name, enter the field name from the PDF template.

No other properties are required for this method.

The following figure shows the "My_Signature" field name entered into the properties field.


Figure 7-13 The My_Signature Field Entered into the Properties Field

[image: Description of Figure 7-13 follows]

Description of "Figure 7-13 The My_Signature Field Entered into the Properties Field"





	
Click OK.

Note that the runtime properties that you have just set are at the report level and not the layout level. Therefore any layouts associated with the report now include the digital signature as specified in the Report Properties. When an Existing signature field name is specified, the template must contain the field for the signature to be applied.














[image: Oracle Corporation]





C Designing Accessible Reports


This appendix describes techniques for designing reports to increase accessibility of report output to users with disabilities. Accessibility support is for HTML output only.

This appendix includes the following sections:

	
Section C.1, "Avoiding Nested Tables or Separated Tables"


	
Section C.2, "Defining a Document Title"


	
Section C.3, "Defining Alternative Text for an Image"


	
Section C.4, "Defining a Table Summary"


	
Section C.5, "Defining a Table Column Header"


	
Section C.6, "Defining a Table Row Header"


	
Section C.7, "Sample Supported Tables"






C.1 Avoiding Nested Tables or Separated Tables

Avoid using nested tables in a report. For a complex report, try breaking down complex tables into several simple, straightforward tables.

Figure C-1 shows a simple table.


Figure C-1 Simple Table

[image: Description of Figure C-1 follows]

Description of "Figure C-1 Simple Table"





Figure C-2 shows an example of a nested table: A table is inserted inside a table-cell.


Figure C-2 Nested Table

[image: Description of Figure C-2 follows]

Description of "Figure C-2 Nested Table"







C.1.1 Examples

The following are examples of table structures that BI Publisher does and does not support for accessibility.



C.1.1.1 Nested Tables

BI Publisher does not support accessibility when nested tables are used in a report, as shown in Figure C-3. In this example, BI Publisher cannot tell to which column data "C1R1data" belongs.


Figure C-3 Unsupported Table Layout: Nested Tables in a Report

[image: Description of Figure C-3 follows]

Description of "Figure C-3 Unsupported Table Layout: Nested Tables in a Report"





Remove the nested table as shown in Figure C-4.


Figure C-4 Supported Table Layout: Nested Tables Removed

[image: Description of Figure C-4 follows]

Description of "Figure C-4 Supported Table Layout: Nested Tables Removed"











C.1.2 Table Headers Must Not Be Separated from the Table Body

The example shown in Figure C-5 is not supported because the header, table body and accessibility fields exist in three different tables.


Figure C-5 Unsupported Table Layout: Header, Body, and Accessibility Fields in Separate Tables

[image: Description of Figure C-5 follows]

Description of "Figure C-5 Unsupported Table Layout: Header, Body, and Accessibility Fields in Separate Tables"





These three tables should be joined into one to support accessibility, as shown in Figure C-6.


Figure C-6 Supported Table Layout: Three Tables Joined into One

[image: Description of Figure C-6 follows]

Description of "Figure C-6 Supported Table Layout: Three Tables Joined into One"











C.2 Defining a Document Title

You can define a document title. The procedure differs slightly depending on the version of Microsoft Word.

To define or change a document title in Microsoft Word 2007:

	
Click the Office button, click Prepare, and then click Properties.




To define or change a document title in previous versions of Word:

	
On the File menu, click Properties, then click the Summary tab.









C.3 Defining Alternative Text for an Image

To define alternative text for an image in the template:

	
Right-click the image.


	
On the menu, click Format Picture.


	
On the Alt Text tab, enter "alt:" followed by the alternative text. For example:


alt:flower picture







	
Note:

In versions of Word prior to 2007, enter the alt:text syntax on the Web tab.














C.4 Defining a Table Summary

Add a table summary to a table by inserting the following command:


<?table-summary: 'My Table Test '?>


in the first column and first row position of the table.






C.5 Defining a Table Column Header

You can define a table column header. The procedure differs slightly depending on the version of Microsoft Word.

To define a table column header in Word 2007:

	
Select the heading row or rows. The selection must include the first row of the table.


	
On the Design tab, in the Table Style Options group, select Header Row.


	
Right-click the table and select Table Properties.


	
In the Table Properties dialog, click the Row tab and then select Repeat as Header row at the top of each page.




To define a table column header in previous versions of Word:

	
Select the heading row or rows. The selection must include the first row of the table.


	
On the Table menu, click Heading Rows Repeat.









C.6 Defining a Table Row Header

To define multiple row headers, use the BI Publisher command:


<?acc-row-header:col_index?> 


Example Usage:


<?acc-row-header:'1,2,4'?>  ==> column 1, 2 and 4 will be row-headers. 



<?acc-row-header:'1,4'?>  ==> column 1 and 4 will be row-headers. 


In Figure C-7, the code behind the ACC field is:


ACC Field=<?table-summary:'My Table Test '?><?acc-row-header:'1,2'?>


which defines the first two columns as row headers.


Figure C-7 First Two Columns as Row Headers

[image: Description of Figure C-7 follows]

Description of "Figure C-7 First Two Columns as Row Headers"









C.7 Sample Supported Tables

Figure C-8, Figure C-9, Figure C-10, and Figure C-11 display sample tables for which accessibility is supported.


Figure C-8 Supported Tables: Double Column and Row Headers

[image: Description of Figure C-8 follows]

Description of "Figure C-8 Supported Tables: Double Column and Row Headers"






Figure C-9 Supported Tables: Group Summary Total

[image: Description of Figure C-9 follows]

Description of "Figure C-9 Supported Tables: Group Summary Total"






Figure C-10 Supported Tables: Separated Row Headers with Shared Column Header

[image: Description of Figure C-10 follows]

Description of "Figure C-10 Supported Tables: Separated Row Headers with Shared Column Header"






Figure C-11 Supported Tables: Separated Row Headers with Individual Column Header

[image: Description of Figure C-11 follows]

Description of "Figure C-11 Supported Tables: Separated Row Headers with Individual Column Header"












New Features for Report Designers

This preface describes changes to Oracle BI Publisher report designing features for Oracle Business Intelligence Publisher 11g Release 1 (11.1.1).

This preface contains the following topics:

	
New Features for Oracle BI Publisher 11g Release 1 (11.1.1.6)


	
New Features for Oracle BI Publisher 11g Release 1 (11.1.1.5)


	
New Features for Oracle BI Publisher 11g Release 1 (11.1.1.3)





New Features for Oracle BI Publisher 11g Release 1 (11.1.1.6)

New features for report designers in Oracle BI Publisher 11g Release 1 (11.1.1.6) include:

	
Improved Create Report Flow


	
Enhancements to Parameter Display Options


	
Support for HTML Formatting in Data


	
Support for PDF/A and PDF/X Output





Improved Create Report Flow

This release streamlines the report creation process introducing a process flow to better guide report designers. For more information, see Section 2.3, "Creating a Report."


Enhancements to Parameter Display Options

Enhancements to parameter display options include:

	
Support for radio button and check box display of values

Parameters that are defined as a menu in the data model can now be configured to display the menu options as a list of radio buttons or check boxes. Parameters configured to support one value support the option to display as radio buttons. Parameters configured to support multiple values support the option to display as check boxes.


	
New options for placement of parameters in the report viewer

Previously the report viewer always displayed the parameters in a horizontal region across the top of the viewer. In this release. the display of the parameter region can also be configured in one of the following ways:

	
In a vertical region along the right side of the viewer


	
As a dialog


	
As a separate full page





	
New report viewer toolbar button to show or hide parameters

This release adds a toolbar button to the report viewer to enable users to hide or show the parameter region. This enhancement complements the new parameter display options. When report parameters are configured to display as a dialog or in a separate full page, the parameter display region is dismissed when the viewer displays the report. Use the Parameters button to redisplay the parameter region to make new selections.


	
Search added to menus

All parameter menus having more than a specified number of options provide a Search option.


	
Option to remove the Apply button

Reports can now be configured to remove the parameter Apply button. In these reports the action of selecting a new parameter value automatically reruns the report.




For more information about these enhancements, see Section 2.7, "Configuring Parameter Settings for the Report."


Support for HTML Formatting in Data

You can now convert stored XHTML to XSL-FO to display the HTML formatting from your data in your generated report. The XHTML data must be extracted wrapped in a CDATA section. Specific syntax must also be used in the RTF template to render it. See Section 4.23, "Rendering HTML Formatted Data in a Report" for more information.


Support for PDF/A and PDF/X Output

PDF/A is a variation of the PDF standard optimized for long term archival of documents. PDF/X is a variation of the PDF standard optimized for professional grade printing. BI Publisher now supports these two types of output. For more information, see Section 2.9, "Generating PDF/A and PDF/X Output."


New Features for Oracle BI Publisher 11g Release 1 (11.1.1.5)

New features in Oracle BI Publisher 11g Release 1 (11.1.1.5) include:

	
Excel Templates


	
Excel Template Builder


	
Interactive List Component for BI Publisher Layouts





Excel Templates

An Excel template is a report layout that you design in Microsoft Excel for retrieving enterprise data in Excel. Excel templates provide a set of special features for controlling the display of data and providing specific formatting instructions. Excel templates support the following features:

	
Define the structure for the data in Excel output


	
Split hierarchical data across multiple sheets and dynamically name the sheets


	
Create sheets of data that have master-detail relationships


	
Use native XSL functions in the data to manipulate it prior to rendering


	
Use native Excel functionality




For more information, see Chapter 6, "Creating Excel Templates."


Excel Template Builder

BI Publisher provides a downloadable add-in to Excel that enables you to preview the Excel template with sample data. This facilitates design by enabling you to test and edit the template without having to upload it to the BI Publisher catalog first. The Template Builder for Excel is installed automatically when you install the Template Builder for Word. The tools can be downloaded from the Home page of Oracle Business Intelligence Publisher or Oracle Business Intelligence Enterprise Edition as follows:

Under the Get Started region, click Download BI Publisher Tools.

For more information, see Section 6.1.5, "Desktop Tools for Excel Templates."


Interactive List Component for BI Publisher Layouts

The list component displays all values of a data element in a vertical or horizontal list. When viewed in interactive mode, clicking an item in the list updates the results shown in the linked components of the report. The list enables the report consumer to quickly see results for each item in the list by clicking the list entry. For more information see Section 3.14, "About Lists."


Redesigned Formula Dialog for BI Publisher

The formula dialog in the BI Publisher layout editor has been redesigned for better usability. For more information, see Section 3.15, "Setting Predefined or Custom Formulas."


New Features for Oracle BI Publisher 11g Release 1 (11.1.1.3)

New features in Oracle BI Publisher 11g Release 1 (11.1.1.3) include:

	
Major User Interface Improvements


	
Shared BI Presentation Catalog


	
Layout Editor Design Tool


	
Interactive Viewer


	
Sub Templates


	
Style Templates





Major User Interface Improvements

The user interface has undergone major improvements in several areas, including a new Home page and redesigned editors and panes. These improvements are intended to make working with Oracle BI Publisher easier and more consistent. For information about working in the new interface, see Oracle Fusion Middleware User's Guide for Oracle Business Intelligence Publisher.


Shared BI Presentation Catalog

For installations of BI Publisher with the Oracle BI Enterprise Edition, BI Publisher now shares the same catalog with Oracle BI Presentation services. For information about the improved catalog, see Oracle Fusion Middleware User's Guide for Oracle Business Intelligence Publisher.


Layout Editor Design Tool

This release introduces a new type of layout template and design tool. The Layout Editor is launched from within BI Publisher and provides an intuitive WYSIWIG drag-and-drop interface for designing report layouts. For a complete description, see Chapter 3, "Creating BI Publisher Layout Templates."


Interactive Viewer

For reports created with the new BI Publisher layout editor, a new interactive output type is available. The interactive viewer enables pop-up chart details, scrollable tables, table filtering, table sorting, and propagated filtering across different components of the report. This interactivity is achieved simply by designing the report in the layout editor, no additional coding is necessary. For more information, see Section 3.1, "Overview of BI Publisher Layouts."


Sub Templates

Previously subtemplates had to be stored outside of the BI Publisher catalog and called at runtime from the external directory. In this release RTF and XSL subtemplates can be saved and managed as objects in the BI Publisher catalog. For more information, see Chapter 12, "Understanding Subtemplates."


Style Templates

A style template is an RTF template that contains style information that can be applied to RTF layouts. The style information in the style template is applied to RTF layouts at runtime to achieve a consistent look and feel across your enterprise reports. Style templates are saved and managed in the BI Publisher catalog. For more information, see Chapter 11, "Creating and Implementing Style Templates."


Zipped PDF Output

This release introduces a feature to split a large PDF output file into smaller, more manageable files, while still maintaining the integrity of the report as one logical unit. When PDF output splitting is enabled for a report, the report is split into multiple files generated in one zip file. The output type is PDFZ. For easy access to the component files, BI Publisher also generates an index file that specifies from and to elements contained in each component PDF file. For more information, see Section A.2, "Generating Zipped PDF Output."
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1 Introduction to Designing Reports


This chapter introduces the components that comprise a BI Publisher report.

This chapter includes the following sections:

	
Section 1.1, "Overview for Report Designers"


	
Section 1.2, "About the Layout Types"


	
Section 1.3, "About Setting Run-Time Properties"


	
Section 1.4, "About Translations"


	
Section 1.5, "About Style Templates"


	
Section 1.6, "About Sub Templates"






1.1 Overview for Report Designers

A report consists of a data model, a layout, and a set of properties. Optionally, a report may also include a style template and a set of translations. A report designers performs the following tasks:

	
Design the layout for the report. The layout can be created using a variety of tools. The output and design requirements of a particular report determine the best layout design tool. Options include the Layout Editor, which is a Web-based layout design tool and enables interactive output, Microsoft Word, Adobe Acrobat, Microsoft Excel, and Adobe Flexbuilder.


	
Set runtime configuration properties for the report.


	
Design style templates to enhance a consistent look and feel of reports in your enterprise.


	
Create sub templates to re-use common functionality across multiple templates


	
Enable translations for a report.









1.2 About the Layout Types

BI Publisher offers several options for designing layouts for reports. The following formats are supported. Note that the layout type determines the types of output documents supported.

	
BI Publisher layout (XPT)

BI Publisher's Layout Editor is a Web-based design tool for creating layouts. Layouts created with the Layout Editor support interactive viewing as well as the full range of output types supported by RTF layouts.


	
Rich Text Format (RTF)

BI Publisher provides a plug-in utility for Microsoft Word that automates layout design and enables you to connect to BI Publisher to access data and upload templates directly from a Microsoft Word session. The RTF format also supports advanced formatting commands providing the most flexible and powerful of the layout options. RTF templates support a variety of output types, including: PDF, HTML, RTF, Excel, PowerPoint, zipped PDF, and MHTML.


	
Portable Document Format (PDF)

PDF templates are used primarily when you must use a predefined form as a layout for a report (for example, a form provided by a government agency). Because many PDF forms already contain form fields, using the PDF form as a template simply requires mapping data elements to the fields that exist on the form. You can also design PDF templates using Adobe Acrobat Professional. PDF templates support only PDF output.


	
Microsoft Excel (XLS)

Excel templates enable you to map data and define calculations and formatting logic in an Excel workbook. Excel templates support Microsoft Excel (.xls) output only.

If you must only view report data in Excel, then you can also use BI Publisher's Analyzer for Microsoft Excel to download report data to an Excel worksheet. Create a layout for the data in Excel and then upload the spreadsheet back to BI Publisher to save as a report layout.


	
XSL Stylesheet

Layouts can also be defined directly in XSL formatting language. Specify whether the layout is for FO, HTML, XML, or Text transformation.


	
eText

These are specialized RTF templates used for creating text output for Electronic Data Interchange (EDI) or Electronic Funds Transfer (EFT) transactions.


	
Flash

BI Publisher's support for Flash layouts enables you to develop Adobe Flex templates that can be applied to BI Publisher reports to generate interactive Flash output documents.









1.3 About Setting Run-Time Properties

BI Publisher provides a variety of user-controlled settings that are specified using an easily accessible Properties dialog. These include security settings for individual PDF reports, HTML output display settings, font mapping, currency formatting, and other output-specific settings. For more information see Chapter 10, "Setting Report Processing and Output Document Properties." These settings are also configured at the system-level, but can be customized per report.






1.4 About Translations

BI Publisher provides the ability to create an XLIFF file from RTF templates. XLIFF is the XML Localization Interchange File Format. It is the standard format used by localization providers. Using BI Publisher's XLIFF generation tool you can generate the standard translation file of an RTF template. You can then translate this file (or send to a translation provider). Once translated, the file can be uploaded to the report definition under the appropriate locale setting so that at runtime the translated report runs automatically for users who select the corresponding locale. For more information, see Chapter 15, "Translation Support Overview and Concepts."






1.5 About Style Templates

A style template is an RTF template that contains style information that can be applied to layout templates. The style information in the style template is applied to report layout templates at runtime to achieve a consistent look and feel across your enterprise reports.

For more information, see Chapter 11, "Creating and Implementing Style Templates."






1.6 About Sub Templates

A Sub Template is a piece of formatting functionality that can be defined once and used multiple times within a single layout template or across multiple layout template files. This piece of formatting can be in an RTF file format or an XSL file format. RTF subtemplates are easy to design as you can use Microsoft Word native features. XSL subtemplates can be used for complex layout and data requirements.

For more information, see Chapter 12, "Understanding Subtemplates."









14 Designing XSL Subtemplates


This chapter describes how to create XSL subtemplates to create reusable advanced functionality for your RTF templates.

This chapter includes the following sections:

	
Section 14.1, "Understanding XSL Subtemplates"


	
Section 14.2, "Process Overview for Creating and Implementing XSL Subtemplates"


	
Section 14.3, "Creating an XSL Subtemplate File"


	
Section 14.4, "Calling an XSL Subtemplate from the Main Template"


	
Section 14.5, "Creating the Sub Template Object in the Catalog"


	
Section 14.6, "Example Uses of XSL Subtemplates"






14.1 Understanding XSL Subtemplates

An XSL subtemplate is an XSL file that consists of one or more <xsl:template> definitions, each containing a block of formatting or processing commands. When uploaded to BI Publisher as a Sub Template object in the Catalog, this XSL file can be called from other RTF templates to execute the formatting or processing commands.

XSL subtemplates can handle complex data and layout requirements. Use XSL subtemplates to transform the data structure for a section of a report (for example, for a chart) or to create a style sheet to manage a complex layout.



14.1.1 Where to Put XSL Code in the RTF Main Template

When you call the XSL subtemplate within a main RTF subtemplate, you use XSL commands. You must put this code inside a BI Publisher field (or Microsoft Word form field). You cannot enter XSL code directly in the body of the RTF template.

For more information on inserting form fields in an RTF template see Section 5.4.1, "Inserting a Field."








14.2 Process Overview for Creating and Implementing XSL Subtemplates

Creating and implementing an XSL subtemplate consists of the following steps:

	
Create the XSL file that contains the common components or processing instructions to include in other templates.

An XSL sub template consists of one or more XSL template definitions. These templates contain rules to apply when a specified node is matched.


	
Create the calling or "main" layout that includes a command to "import" the subtemplate to the main template and a command to apply the XSL subtemplate to the appropriate data element.


	
Upload the main template to the report definition and create the Sub Template object in the catalog.









14.3 Creating an XSL Subtemplate File

Enter the instructions in an editor that enables you to save the file as type ".xsl". An XSL subtemplate consists of one or more XSL template definitions. These templates contain rules to apply when a specified node is matched.

The syntax of the subtemplate definition is as follows:


<xsl:template
  name="name" 
  match="pattern" 
  mode="mode" 
  priority="number">
<!--Content:(<xsl:param>*,template) -->
</xsl:template>


Table 14-1 describes the components of the template declaration.


Table 14-1 Components of the Template Declaration

	Component	Description
	
xsl:template

	
The xsl:template element is used to define a template that can be applied to a node to produce a desired output display.


	
name="name"

	
Optional. Specifies a name for the template.

Note: If this attribute is omitted, a match attribute is required.


	
match="pattern"

	
Optional. The match pattern for the template.

Note: If this attribute is omitted a name attribute is required.


	
priority="number"

	
Optional. A number which indicates the numeric priority of the template. It is possible that more than one template can be applied to a node. The highest priority value template is always chosen. The value ranges from -9.0 to 9.0.








Example:


<xsl:template match="P|p">
  <fo:block white-space-collapse="false" padding-bottom="3pt" linefeed-treatment="preserve">
     <xsl:apply-templates select="text()|*|@*"/>
  </fo:block>
</xsl:template>

<xsl:template match="STRONG|B|b">
   <fo:inline font-weight="bold">
     <xsl:apply-templates/>
   </fo:inline>
</xsl:template>






14.4 Calling an XSL Subtemplate from the Main Template

To implement the subtemplate in the main template, make two entries in the main template:

First, import the subtemplate file to the main template. The import syntax tells the BI Publisher engine where to find the Sub Template in the catalog.

Second, enter a call command to render the contents of the subtemplate at the position desired.



14.4.1 Importing the Subtemplate

Enter the import command anywhere in the main template prior to the call template command as follows:


<?import:xdoxsl:///{path to subtemplate.xsb}?>


where

path to subtemplate.xsb is the path to the subtemplate .xsb object in the catalog.

For example:


<?import:xdoxsl:///Executive/Financial Reports/mySubtemplate.xsb?>






14.4.2 Calling the Subtemplate

The template statements that you defined within the XSL subtemplate file are applied to data elements. There are two ways you can call a template defined in the imported XSL subtemplate:

	
By matching the data content with the match criteria:


<xsl:apply-templates select="data_element"/>


This method applies all the templates that are defined in the XSL subtemplate to the data_element specified. Based on the data content of data_elment, appropriate functions in those templates are applied. See the following use case for a detailed example: Section 14.6.1, "Handling XML Data with HTML Formatting."


	
By calling a template by name:


<xsl:call-template name="templateName"/>


This method calls the template by name and the template executes, similar to a function call. Here also parameters can be passed to the template call, similarly to an RTF subtemplate. See the next section: Section 14.4.3, "Passing Parameters to an XSL Subtemplate."

See the following use case for a detailed example: Section 14.6.2, "Dynamically Applying Formatting to a Portion of Data."









14.4.3 Passing Parameters to an XSL Subtemplate

To pass parameters to the XSL subtemplate:

	
Declare the parameter in the <xsl:template> definition, as follows:


<xsl:template name="templateName" match="/">
   <xsl:param name="name" />
</xsl:template>


	
Then call this template using the following syntax:


<xsl:call-template name="templateName">
  <xsl:with-param name="name" select="expression">
    <?--- Content:template -->
  </xsl:with-param>
</xsl:call-template>











14.5 Creating the Sub Template Object in the Catalog

To upload the subtemplate file:

	
On the global header click New and then click Sub Template. This launches an untitled Sub Template page.


	
In the Templates region, click Upload to launch the Upload Template File dialog.


	
Browse for and select the subtemplate file.

	
Type: Select xsl for an XSL subtemplate file.


	
Locale: Select the appropriate locale for the subtemplate file.





	
Click Upload.

The subtemplate file is displayed in the Templates region as the locale name that you selected (for example: en_US).


	
Click Save. In the Save As dialog choose the catalog folder in which to save the Sub Template. Enter the Name and click Save. Figure 14-1 shows a Sub Template named "My Subtemplate".


Figure 14-1 Sub Template

[image: Description of Figure 14-1 follows]

Description of "Figure 14-1 Sub Template"







The Sub Template object is saved with the extension ".xsb". Use the Name that you choose here with the .xsb extension when you import the Sub Template to the report (for example: MySubtemplate.xsb).

Translations are not supported for XSL Sub Templates.






14.6 Example Uses of XSL Subtemplates

The following are examples of formatting that can be achieved in a report by using XSL subtemplates:

	
Section 14.6.1, "Handling XML Data with HTML Formatting"


	
Section 14.6.2, "Dynamically Applying Formatting to a Portion of Data"






14.6.1 Handling XML Data with HTML Formatting

If you have XML data that already contains HTML formatting and you want to preserve that formatting in the report, then you can preserve that formatting by using an XSL subtemplate to map the HTML formatting commands to XSL equivalents that can be handled by BI Publisher.

Note that the HTML must be in XHTML format. This means that all HTML tags must have start and end tags in the data. For example, if the data uses a simple <BR> for a break, then you must add the closing </BR> before you can use this solution.

Following is some sample data with HTML formatting:


<DATA>
  <ROW>
    <PROJECT_NAME>Project Management</PROJECT_NAME>
    <PROJECT_SCOPE>
      <p>Develop an application to produce <i>executive-level summaries</i> and detailed project reports. The application will allow users to: </p>
       <p>Import existing MS Project files </p>
       <p>Allow the user to map file-specific resources to a central database entities (i.e., people) and projects; </p>
       <p>Provide structured output that can be viewed by staff and executives. </p>
   </PROJECT_SCOPE>
   <PROJECT_DEFINITION><b>Information about current projects is not readily available to executives.</b> Providing this information creates a reporting burden for IT staff, who may already maintain this information in Microsoft Project files. </PROJECT_DEFINITION>
  </ROW>
</DATA>


Note in this sample the following HTML tags:

	
<p> - paragraph tag


	
<i> - italics tag


	
<b> - bold tag




Assume a report requirement to display this to retain the formatting supplied by these tags as shown in Figure 14-2.


Figure 14-2 Sample HTML Tags

[image: Description of Figure 14-2 follows]

Description of "Figure 14-2 Sample HTML Tags"





The following subtemplate uses XSL syntax to match the three HTML tags in the XML data. The template then replaces the matched HTML string with its XSLFO equivalent.


<xsl:template match="P|p">
 <fo:block white-space-collapse="false" padding-bottom="3pt" linefeed-treatment="preserve">
  <xsl:apply-templates select="text()|*|@*"/> 
 </fo:block>
</xsl:template>

<xsl:template match="STRONG|B|b">
        <fo:inline font-weight="bold">
                <xsl:apply-templates/>
        </fo:inline>
</xsl:template>

<xsl:template match="EM|I|i">
        <fo:inline font-style="italic">
                <xsl:apply-templates/>
        </fo:inline>
</xsl:template>


To use this XSL syntax:

	
Upload this XSL subtemplate file to the BI Publisher catalog location: Shared Folders/Projects. Save this subtemplate file as "htmlmarkup.xsb".


	
In the main template enter the following to import the subtemplate file:


<?import:xdoxsl:///Projects/htmlmarkup.xsb?>


	
For each field that has HTML markup, call the xsl apply-template command. In this example, there are two fields:


<xsl:apply-templates select="PROJECT_SCOPE"/>
<xsl:apply-templates select="PROJECT_DEFINITION"/>
       


Figure 14-3 shows the field definitions in the template.


Figure 14-3 Field Definitions

[image: Description of Figure 14-3 follows]

Description of "Figure 14-3 Field Definitions"





The command tells the processor to apply all templates to the value of the element PROJECT_SCOPE and PROJECT_DEFINITION. It then cycles through the subtemplate functions looking for a match.









14.6.2 Dynamically Applying Formatting to a Portion of Data

This application of subtemplates is useful for documents that require chemical formulae, mathematical calculations, or superscripts and subscripts.

For example, in the sample XML data below CO2 is expected to display as CO2 and H2O is expected to display as H2O.


<ROWSET> 
  <ROW> 
    <FORMULA>CO2</FORMULA> 
  </ROW> 
  <ROW> 
   <FORMULA>H2O</FORMULA> 
  </ROW>
</ROWSET>


This can be achieved by using an XSL subtemplate. Using XSL syntax you can define a template with any name, for example, "chemical_formatter" that accepts the FORMULA field as a parameter, and then read one character at a time. It compares the character with 0 - 9 digits, and if there is a match, then that character is subscripted using the following XSL FO syntax:


<fo:inline baseline-shift="sub" font-size="75%">


Here is sample code for the XSL template statement:


<xsl:template name="chemical_formatter"> 
<! -  accepts a parameter e.g. H2O  - > 
<xsl:param name="formula"/> 
<! -  Takes the first character of the string and tests it to see if it is a number between 0-9 - > <xsl:variable name="each_char" 
select="substring($formula,1,1)"/> 
<xsl:choose> 
   <xsl:when test="$each_char='1' or $each_char='2' 
   or $each_char='3' or $each_char='4' or $each_char='5' 
   or $each_char='6' or $each_char='7' or $each_char='8' 
   or $each_char='9' or $each_char='0'"> 
   <! -  if it is numeric it sets the FO subscripting properties  - > 
     <fo:inline baseline-shift="sub" font-size="75%"> 
        <xsl:value-of select="$each_char"/> 
     </fo:inline> 
   </xsl:when> 
   <xsl:otherwise> 
   <! -  otherwise the charater is left as is  - > 
       <fo:inline baseline-shift="normal"> 
         <xsl:value-of select="$each_char"/> 
       </fo:inline> 
   </xsl:otherwise> 
 </xsl:choose> 
 <! -  test if there are other chars in the string, if so the recall the template  - >
   <xsl:if test="substring-after($formula,$each_char) !=''"> 
      <xsl:call-template name="chemical_formater"> 
        <xsl:with-param name="formula"> 
           <xsl:value-of select="substring-after($formula,$each_char)"/> 
        </xsl:with-param> 
     </xsl:call-template> 
   </xsl:if> 
</xsl:template>


To use this XSL template statement:

	
Save this file as chemical.xsl.


	
Follow the instructions in Section 12.4, "Creating the Sub Template Object in the Catalog." Assume that you name the Sub Template "Chemical" (it is saved as Chemical.xsb) and place it in the following location: Shared Folders/Subtemplates.


	
In the main RTF template enter the import syntax:


<?import:xdoxsl:///Subtemplates/Chemical.xsb?>


	
To render the XSL code in the report, create a loop over the data and in the VALUE field use:


<xsl:call-template name="chemical_formatter">
<xsl:with-param name="formula" select="VALUE"/> </xsl:call-template>




This calls the formatting template with the FORMULA value that is, H2O. Once rendered, the formulae are shown as expected: H2O.











11 Creating and Implementing Style Templates


A style template is an RTF template that contains style information that can be applied to other RTF layouts to achieve a consistent look and feel across your enterprise reports.

This chapter describes how to create and implement style templates. It includes the following sections:

	
Section 11.1, "Understanding Style Templates"


	
Section 11.2, "Creating a Style Template RTF File"


	
Section 11.3, "Uploading a Style Template File to the Catalog"


	
Section 11.4, "Assigning a Style Template to a Report Layout"


	
Section 11.5, "Updating a Style Template"


	
Section 11.6, "Adding Translations to a Style Template Definition"






11.1 Understanding Style Templates

A style template is an RTF template that contains style information that can be applied to RTF layouts. The style information in the style template is applied to RTF layouts at runtime to achieve a consistent look and feel across your enterprise reports. You associate a style template to a report layout in the report definition. Using a style template has the following benefits:

	
Enables the same look and feel across your enterprise reports


	
Enables same header and footer content, such as company logos, headings, and page numbering


	
Simplifies changing the elements and styles across all reports






11.1.1 About Styles Defined in the Style Template

The styles of the following elements can be defined in the style template:



11.1.1.1 Paragraph and Heading Styles

You can create a paragraph style in a style template. When this same named style is used in a report layout, the report layout inherits the following from the style template definition: font family, font size, font weight (normal, bold), font style (normal, italic), font color, and text decoration (underline, overline, or strike through).






11.1.1.2 Table Styles

Following are some of the style elements inherited from the table style definition: font style, border style, gridline definition, shading, and text alignment.






11.1.1.3 Header and Footer Content

The header and footer regions of the style template are applied to the report layout. This includes images, dates, page numbers, and any other text-based content. If the report layout also includes header and footer content, then it is overwritten.








11.1.2 Style Template Process Overview

Design Time

For the Style Template:

	
Open Microsoft Word.


	
Define named styles for paragraphs, tables, headings, and static header and footer content. This is the style template.


	
Save this document as a .RTF file.


	
To ensure that you do not lose custom styles in Microsoft Word, also save the document as a Word Template file (.dot) or save the styles to the Normal.dot file. This file can be shared with other report designers.


	
Upload the RTF style template file to the catalog.




For the layout template using the style template:

	
In the RTF template, use the same named styles for paragraph and table elements that you want to be inherited from the style template.


	
Open the report in BI Publisher's Report Editor and select the style template to associate to the report. Then enable the style template for the specific report layout.




Runtime

When you run the report with the selected layout, BI Publisher applies the styles, header, and footer from the style template.








11.2 Creating a Style Template RTF File

The following sections describe how to define the style types in the Microsoft Word document. For more complete information see the Microsoft Word documentation.



11.2.1 Defining Styles for Paragraphs and Headings

Use a paragraph style to define formatting such as font type, size, color, text positioning and spacing. A paragraph style can be applied to one or more paragraphs. Use a paragraph style to format headings and titles in the report as well.

To define a paragraph style type:

	
In the Microsoft Word document, from the Format menu, select Styles and Formatting.


	
From the Styles and Formatting task pane, select New Style.


	
In the New Style dialog, enter a name for the style. Choose style type: Paragraph. Format the style using the options presented in the dialog. To see additional paragraph options (such as font color and text effects), click Format.


	
When finished, click OK and the new style is displayed in the list of available formats in the Styles and Formatting task pane.


	
Choose the new style and make an entry in the style template to display the style.




To apply the paragraph style type in the document:

	
Position the cursor within the paragraph (or text) to which you want to apply the style.


	
Select the style from list of available formats in the Styles and Formatting task pane. The style is applied to the paragraph.




To modify an existing style type:

	
In the Microsoft Word document, from the Format menu, select Styles and Formatting.


	
From the Styles and Formatting task pane, select and right-click the style to modify.


	
From the menu, select Modify.









11.2.2 Defining Styles for Tables

To define a table style type:

	
In the Microsoft Word document, from the Format menu, select Styles and Formatting.


	
From the Styles and Formatting task pane, select New Style.


	
In the New Style dialog, enter a name for the style. Choose style type: Table. Format the style using the options presented in the dialog. To see additional table options (such as Table Properties and Borders and Shading), click Format.


	
When finished, click OK and the new style is displayed in the list of available formats in the Styles and Formatting task pane.


	
Choose the new style and make an entry in the style template to display the style.




To apply the table style type in the document:

	
Position the cursor within the table to which you want to apply the style.


	
Select the table style from list of available formats in the Styles and Formatting task pane. The style is applied to the table.









11.2.3 Defining a Header and Footer

You can define a header and footer in the style template. The contents and sizing of the header and footer in the style template are applied to the report layouts.




	
Important:

If a header and footer have been defined in the report layout, then they are overwritten. The header and footer from the style template are applied.









To define a header and footer:

	
In the Microsoft Word document, from the View menu, select Header and Footer.


	
Enter header and footer content. This can include a logo or image file, static text, current date and time stamps, page numbers, or other content supported by Microsoft Word.











11.3 Uploading a Style Template File to the Catalog

You can place a style template in any folder in the catalog to which you have access. Your organization may have a designated folder for style templates.

To upload a style template file:

	
On the global header click New and then click Style Template. This launches an untitled Style Template properties page.


	
From the Templates region, click the Upload toolbar button.


	
In the Upload Template File dialog (shown in Figure 11-1), use the Browse button to select the Template File. Select rtf as the Type, and select the appropriate Locale, as shown in Figure 11-2. Then click OK.


Figure 11-1 Upload Template File Dialog

[image: Description of Figure 11-1 follows]

Description of "Figure 11-1 Upload Template File Dialog"






Figure 11-2 Select the Appropriate Locale

[image: Description of Figure 11-2 follows]

Description of "Figure 11-2 Select the Appropriate Locale"





The style template file is displayed in the Templates region as the locale name that you selected (for example: en_US).


	
Click Save.


	
In the Save As dialog choose the catalog folder in which to save the style template. Enter the Name and click Save.




	
Note:

You may only upload one RTF file per locale to a Style Template definition. If you upload additional template files to this Style Template, each file is automatically named as the locale regardless of the name that you give the file before upload.










	
If you are uploading multiple localized files, then select the file that is to be used as the default. For more information on localization of template files see Section 11.6, "Adding Translations to a Style Template Definition."









11.4 Assigning a Style Template to a Report Layout

To assign a style template to a report layout:

	
Navigate to the report in the catalog and click Edit to open the report editor.


	
From the default thumbnail view, select View a List. In the Layout Region, click the Choose icon to search for and select the style template from the BI Publisher catalog..


	
For the layout templates that you want to use the style template, select the Apply Style Template box for the template. Note that the box is only enabled for RTF templates.




Figure 11-3 shows the actions required to enable a style template in the Report Editor.


Figure 11-3 Enabling a Style Template in the Report Editor

[image: Description of Figure 11-3 follows]

Description of "Figure 11-3 Enabling a Style Template in the Report Editor"









11.5 Updating a Style Template

To update or edit a saved style template:

	
Navigate to the file in the catalog.


	
Click Edit to open the Style Template properties page.


	
Delete the existing file.


	
Upload the edited file, choosing the same locale.









11.6 Adding Translations to a Style Template Definition

Style templates offer the same support for translations as RTF template files.

You can upload multiple translated RTF files under a single Style Template definition and assign the appropriate locale. These are displayed in the Templates region, as shown in Figure 11-4.


Figure 11-4 Templates Region

[image: Description of Figure 11-4 follows]

Description of "Figure 11-4 Templates Region"





Or you can generate an XLIFF (.xlf) file of the translatable strings, translate the strings, and upload the translated file. These are displayed in the Translations region, as shown in Figure 11-5.


Figure 11-5 Translations Region

[image: Description of Figure 11-5 follows]

Description of "Figure 11-5 Translations Region"





At runtime, the appropriate style template is applied based on the user's account Preference setting for Report Locale for reports viewed online; or, for scheduled reports, based on the user's selection for Report Locale for the scheduled report.

The XLIFF files for style templates can be generated individually, then translated, and uploaded individually. Or, if you perform a catalog translation that includes the style template folders, the strings from the style template files are extracted and included in the larger catalog translation file. When the catalog translation file is uploaded to BI Publisher, the appropriate translations from the catalog file are displayed in the Translations region of the Style Template definition.

For more information on translations, see Chapter 15, "Translation Support Overview and Concepts."









Preface

Oracle Business Intelligence Publisher (BI Publisher) is a reporting and publishing application that enables you to extract data from multiple data sources, create layouts for report data, and publish the report to numerous output formats. BI Publisher also enables you to schedule reports and deliver the reports to multiple delivery destinations required by your business.


Audience

This document is intended for report designers and developers using Oracle Business Intelligence Publisher to create reports, configure reports, add translations, and use other BI Publisher report design features.

This guide describes how to create report layouts and use BI Publisher's report editor to assemble the components of a report. See the guides that are listed in the following table for more information about using the product for other business roles.


	Role	Sample Tasks	Guide
	
Administrator

	
Configuring Security

Configuring System Settings

Diagnosing and Monitoring System Processes

	
Oracle Fusion Middleware Administrator's Guide for Oracle Business Intelligence Publisher



	
Application developer or integrator

	
Integrating BI Publisher into existing applications using the application programming interfaces

	
Oracle Fusion Middleware Developer's Guide for Oracle Business Intelligence Publisher



	
Report consumer

	
Viewing reports

Scheduling report jobs

Managing report jobs

	
Oracle Fusion Middleware User's Guide for Oracle Business Intelligence Publisher



	
Data Model developer

	
Fetching and structuring the data to use in reports

	
Oracle Fusion Middleware Data Modeling Guide for Oracle Business Intelligence Publisher
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For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.


Related Documentation and Other Resources

See the Oracle Business Intelligence documentation library for a list of related Oracle Business Intelligence documents.

In addition, go to the Oracle Learning Library for Oracle Business Intelligence-related online training resources.


System Requirements and Certification

Refer to the system requirements and certification documentation for information about hardware and software requirements, platforms, databases, and other information. Both of these documents are available on Oracle Technology Network (OTN).

The system requirements document covers information such as hardware and software requirements, minimum disk space and memory requirements, and required system libraries, packages, or patches:

http://www.oracle.com/technetwork/software/products/ias/files/fusion_requirements.htm

The certification document covers supported installation types, platforms, operating systems, databases, JDKs, and third-party products:

http://www.oracle.com/technetwork/software/products/ias/files/fusion_certification.html


System Requirements and Certification

Refer to the system requirements and certification documentation for information about hardware and software requirements, platforms, databases, and other information. Both of these documents are available on Oracle Technology Network (OTN).

The system requirements document covers information such as hardware and software requirements, minimum disk space and memory requirements, and required system libraries, packages, or patches:

http://www.oracle.com/technology/software/products/ias/files/fusion_requirements.htm

The certification document covers supported installation types, platforms, operating systems, databases, JDKs, and third-party products:

http://www.oracle.com/technology/software/products/ias/files/fusion_certification.html


Conventions

The following text conventions are used in this document:


	Convention	Meaning
	
boldface

	
Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.


	
italic

	
Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.


	
monospace

	
Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.













Part III


Translating Reports and Catalog Objects

This part provides information about translating reports and catalog objects. It includes the following chapters:

	
Chapter 15, "Translation Support Overview and Concepts"


	
Chapter 16, "Translating Individual Templates"


	
Chapter 17, "Translating Catalog Objects, Data Models, and Templates"










5 Creating RTF Templates Using the Template Builder for Word


This chapter describes creating RTF templates in BI Publisher using the Template Builder for Word add-in.

This chapter includes the following sections:

	
Section 5.1, "Overview"


	
Section 5.2, "Getting Started"


	
Section 5.3, "Accessing Data for Building Templates"


	
Section 5.4, "Inserting Components to the Template"


	
Section 5.5, "Previewing a Template"


	
Section 5.6, "Template Editing Tools"


	
Section 5.7, "Uploading a Template to the BI Publisher Server"


	
Section 5.8, "Using the Template Builder Translation Tools"


	
Section 5.9, "Setting Options for the Template Builder"


	
Section 5.10, "Setting Up a Configuration File"


	
Section 5.11, "BI Publisher Menu Reference"






5.1 Overview

The Template Builder is an add-in to Microsoft Word that simplifies the development of RTF templates. While the Template Builder is not required to create RTF templates, it provides many functions that increase productivity.

The Template Builder is tightly integrated with Microsoft Word and enables you to perform the following functions:

	
Insert data fields


	
Insert tables


	
Insert forms


	
Insert charts


	
Preview the template with sample XML data


	
Browse and update the content of form fields


	
Extract boilerplate text into an XLIFF translation file and test translations




The Template Builder automates insertion of the most frequently used components of an RTF template. RTF templates also support much more complex formatting and processing. For the full description of RTF template features, see Chapter 4, "Creating RTF Templates."



5.1.1 Before You Get Started

The Template Builder installation provides samples and demo files to help you get started. The demos can be accessed from the Windows Start menu as follows:

Select Start, Programs, Oracle BI Publisher Desktop, and Demos.

You can also access the demos from the BI Publisher\BI Publisher Desktop\demos folder where you installed BI Publisher Desktop (for example: C:\Program Files\Oracle\BI Publisher\BI Publisher Desktop\demos).

The following demos are provided:

	
TemplateBuilderDemo.exe - Demonstrates building a report layout using many key features of the Template Builder, including: connecting to the BI Publisher server, loading data for a report, inserting tables and charts, and defining conditional formatting.


	
TemplateBuilderInvoice.exe - Demonstrates how to take a prepared layout and use the Template Builder to insert the required fields to fill the template with data at runtime.


	
LocalizationDemo.exe - Demonstrates the localization capabilities of the Template Builder and shows you how to extract an XLIFF file from the base RTF template. The XLIFF file can then be translated and the translations previewed in the Template Builder.




The sample files are located in the BI Publisher\BI Publisher Desktop\Samples folder. The Samples folder contains the subfolders:

	
eText templates


	
Excel templates


	
PDF templates


	
RTF templates




The eText, PDF, and Excel template samples can be used as references to create these types of templates. The Template Builder is only available for the RTF templates. The RTF templates folder contains eight subfolders to provide samples of different types of reports. Refer to the TrainingGuide.html located in the RTF templates folder for additional information on what is contained in each sample.






5.1.2 Prerequisites and Limitations

The following list describes prerequisites and limitation for this feature:

	
Prerequisites:

	
The report data model has been created and runs successfully. For information on creating Data Models, see the Oracle Fusion Middleware Data Modeling Guide for Oracle Business Intelligence Publisher.


	
Supported versions of Microsoft Word and Microsoft Windows are installed on the client.




	
Note:

See System Requirements and Certification for the most up-to-date information on supported hardware and software.










	
The BI Publisher Template Builder has been downloaded and installed on the client.

The Template Builder can be downloaded from the Get Started region of the Home page.





	
Limitations:

	
The Template Builder does not support bidirectional display of text in the user interface.














5.2 Getting Started

This section describes how to get started. It contains the following topics:

	
Section 5.2.1, "Features of the Oracle BI Publisher Template Builder for Word"


	
Section 5.2.2, "Building and Uploading a Template"


	
Section 5.2.2.1, "Working in Connected Mode"






5.2.1 Features of the Oracle BI Publisher Template Builder for Word

When you open Microsoft Word after installing the Template Builder, you see the Oracle BI Publisher menu.

For versions of Microsoft Word prior to 2007, the menu and toolbar are displayed as shown in Figure 5-1.


Figure 5-1 Display of the Menu and Toolbar in Versions of Microsoft Word Prior to 2007

[image: Description of Figure 5-1 follows]

Description of "Figure 5-1 Display of the Menu and Toolbar in Versions of Microsoft Word Prior to 2007"





For Microsoft Word 2007 users, the BI Publisher commands are displayed in the ribbon format, as shown in Figure 5-2.


Figure 5-2 BI Publisher Commands Displayed in the Ribbon Format

[image: Description of Figure 5-2 follows]

Description of "Figure 5-2 BI Publisher Commands Displayed in the Ribbon Format"





Use the menu (or toolbar) to perform the following:

	
Insert data fields into age RTF templates


	
Insert tables, forms, charts, and pivot tables


	
Preview the template in multiple outputs


	
Browse and update the content of form fields


	
Validate the template


	
Perform calculations on fields within the template


	
Connect to the Oracle BI Publisher catalog to retrieve data to build the template


	
Upload the template to the Oracle BI Publisher server


	
Extract boilerplate text into an XLIFF translation file and test translations









5.2.2 Building and Uploading a Template

You can build and upload the template using a direct connection with the BI Publisher server, or you can build and upload the template in disconnected mode.



5.2.2.1 Working in Connected Mode

To work in connected mode:

	
Open Microsoft Word.


	
From the Oracle BI Publisher menu, select Log On.


	
Enter your BI Publisher credentials and the URL for the BI Publisher server, for example: http://www.example.com:7001/xmlpserver. (Contact your system administrator if you do not know the URL.)


	
The Open Template dialog presents the same folder structure as the BI Publisher catalog. Select the report or data model for which you want to build a template.


	
If you selected a data model:

Click Create Report to create a report for this data model in the BI Publisher catalog. This is the report that you upload the template to.

Enter a Report Name and select the folder in which to save it.

Click Save.

The sample data from the data model is loaded to the Template Builder.

If you selected a report:

Click Open Report to load the data to the Template Builder; or double-click <New> in the Layout Templates pane, as shown in Figure 5-3.

Any existing templates are listed in the Layout Templates pane.


Figure 5-3 The Layout Templates Pane

[image: Description of Figure 5-3 follows]

Description of "Figure 5-3 The Layout Templates Pane"





	
Follow the guidelines in this chapter to insert data fields and design the template using features such as tables, charts, and graphics. Use Microsoft Word to apply formatting to fonts and other objects in the template.

For more advanced template options, use the guidelines in Chapter 4, "Creating RTF Templates."


	
To upload the template file to the BI Publisher server and add it to the report definition, select Upload Template As from the Oracle BI Publisher menu.

If you have not saved the template, then you are prompted to save it in Rich Text Format.


	
Enter a name and select a locale in the Upload as New dialog. This is the name that is displayed under Layouts in the Report Editor. This is also the layout name that is displayed when a user runs this report.


	
Configure properties for this layout.

Navigate to the BI Publisher report editor to configure properties for this layout, such as output formats. See Section 2.6.3, "Configuring the Layout Settings Using the List View" for more information.









5.2.2.2 Working in Disconnected Mode

To work in disconnected mode, you must have a sample data file available in the local work environment.

To work in disconnected mode:

	
Save a sample data file to your local computer. See Section 5.3, "Accessing Data for Building Templates."


	
Open Microsoft Word with the Template Builder installed.


	
On the Oracle BI Publisher menu in the Load Data group select Sample XML. Locate the sample data file in the local directory and click Open.




	
Note:

The Template Builder also supports using XML Schema to design an RTF template. However, because the schema contains no data, the preview of the report also contains no data.










	
Follow the guidelines in this chapter to insert data fields and design the template using features such as tables, charts, graphics, and other layout components. Use Microsoft Word to apply formatting to fonts and other objects in the template.

For more advanced template options, use the guidelines in Chapter 4, "Creating RTF Templates."


	
Upload the layout template file.

In the BI Publisher catalog, open the report in the Report Editor. Click Add New Layout.

Complete the fields in the dialog and then select Upload. The template now appears as a layout for the report.


	
Configure properties for this layout.

See Section 2.6, "Configuring Layouts Using the List View" for more information.













5.3 Accessing Data for Building Templates

The data model defines the XML format that is merged with the RTF template. The Template Builder requires sample data to build the template. You must load sample data to use most of the template builder functionality.

If you are not connected to BI Publisher, then use the procedure in Section 5.3.1, "Loading XML Data from a Local File." If you are connected, then use the procedure in Section 5.3.2, "Loading Data from the BI Publisher Catalog."



5.3.1 Loading XML Data from a Local File

One method of loading data to the Template Builder is to save a sample of the report data to a local directory.

For information on saving sample data from a report data model, see the "Testing Data Models and Generating Sample Data" section in Oracle Fusion Middleware Data Modeling Guide for Oracle Business Intelligence Publisher.

If you do not have access to the report data model, but you can access the report, then you can alternatively save sample data from the report viewer.

To save data from the report viewer:

	
In the BI Publisher catalog, navigate to the report.


	
Click Open to run the report in the report viewer.


	
Click the Actions icon, then click Export, then click Data. You are prompted to save the XML file.


	
Save the file to a local directory.


	
Use the Load Sample XML feature below to load the saved XML file to the Template Builder.




The Load Data group from the Oracle BI Publisher menu enables you to select and load the saved XML file to the Template Builder.

	
Sample XML - Enables you to load a sample XML file that contains all fields that you want to insert into the template as a data source. If you are not connected to the BI Publisher server, then use this method to load the data.


	
XML Schema - Enables you to load an XML Schema file (.xsd) that contains the fields available in the report XML data. The XML schema has the advantage of being complete (a sample XML file might not contain all the fields from the data source). For the preview, the Template Builder can generate dummy sample data for an XML Schema. However, the preview works better if you also upload real sample data.









5.3.2 Loading Data from the BI Publisher Catalog

You can connect directly to the BI Publisher Server to load the BI Publisher report data to the Template Builder to use as sample data for designing layouts. You can also download an existing template to modify it.

To connect to BI Publisher and load a data source:

	
Log on to the BI Publisher Server: From the Oracle BI Publisher menu, select Log On. For more information on logging in to the BI Publisher server, see Section 5.2.2.1, "Working in Connected Mode."


	
After you area logged on, you can select Open. The Open Template dialog launches.


	
Navigate to the folder that contains the report or data model for which you want to create a template.

When you select a report, you can either select from the Layout Templates to open an existing template, select Open Report to load just the XML sample data to create a new layout, or double-click <New> to load the data to the Template Builder to build a new layout.

When you select a data model, you are prompted to create a report in the catalog.











5.4 Inserting Components to the Template

This section includes the following topics:

	
Section 5.4.1, "Inserting a Field"


	
Section 5.4.2, "Inserting a Table Using the Table Wizard"


	
Section 5.4.3, "Inserting a Table or Form Using the Insert Table/Form Dialog"


	
Section 5.4.4, "Inserting a Chart"


	
Section 5.4.5, "Inserting a Pivot Table"


	
Section 5.4.6, "Inserting a Repeating Group"


	
Section 5.4.7, "Creating Grouping Fields Around an Existing Block"


	
Section 5.4.8, "Inserting and Editing Conditional Regions"


	
Section 5.4.9, "Inserting Conditional Formatting"






5.4.1 Inserting a Field

This dialog enables you to select data elements from the data source and insert them into the template.

In the Insert group select Field to open the Field dialog. The dialog shows the structure of the loaded data source in a tree view, as shown in Figure 5-4.


Figure 5-4 The Field Dialog

[image: Description of Figure 5-4 follows]

Description of "Figure 5-4 The Field Dialog"





Select a field that represents a single data field (a leaf node of the tree) and select Insert (you can also insert the field by dragging and dropping it into the document, or by double-clicking the field). A text form field with hidden BI Publisher commands is inserted at the cursor position in the template. You may either select and insert additional data fields or close the dialog by clicking the Close button.



5.4.1.1 About the Insert Field Dialog

The Insert Field dialog fields are described in the following sections:






5.4.1.2 Find

For an XML document with a large and complicated structure, use the find functionality to find a specific field. Enter a partial string of the field name you are searching into the Find field and click Find Next. The next occurrence of a data element that includes the search expression is selected. Click the Find Next button again to see the next occurrence.






5.4.1.3 Example

When you select a field name in the tree view, an example value for this field is shown.






5.4.1.4 Force LTR (Left-to-Right) Direction

This check box is only needed if you are using the template in a language that prints the characters from right to left, such as Arabic or Hebrew. Use this feature to force left-to-right printing for fields such as phone numbers, addresses, postal codes, or bank account numbers.






5.4.1.5 Calculation

This feature enables you to perform aggregation functions on data fields, such as sum, average, count, minimum, and maximum.

For example, if you select sum for a data field, then the field shows the sum of all occurring values for this data field, depending on the grouping.

It is important to understand the grouping context (marked by G and E form fields) to know exactly which fields are accumulated. If you insert a data field with an accumulation function into a repeating section (marked by G and E processing instruction form fields), you must select On Grouping to accumulate the data for the occurrences within the group. If you do not want the accumulation to be restricted to the group, you must place the accumulation field outside the group.

Figure 5-5 shows an example.


Figure 5-5 Grouping Context Example

[image: Description of Figure 5-5 follows]

Description of "Figure 5-5 Grouping Context Example"





Also note that the data field must be a valid XSL number for the accumulation functions to work. Formatted numbers cannot be processed by BI Publisher (for example a number using a thousands separator: 10,000,000.00 cannot be processed).

For more information on groups in s template using the Template Builder, see Section 5.4.6, "Inserting a Repeating Group" and Section 4.4, "Defining Groups."








5.4.2 Inserting a Table Using the Table Wizard

The Insert Table Wizard enables you to create standard reports. On the Insert menu select Table Wizard and complete the following steps:

	
Section 5.4.2.1, "Step 1: Selecting Report Format"


	
Section 5.4.2.2, "Step 2: Selecting Table Data"


	
Section 5.4.2.3, "Step 3: Selecting Data Fields"


	
Section 5.4.2.4, "Step 4: Grouping the Table"


	
Section 5.4.2.5, "Step 5: Inserting a Break for the Group"


	
Section 5.4.2.6, "Step 6: Sorting the Table"


	
Section 5.4.2.7, "Step 7: Clicking Finish"


	
Section 5.4.2.8, "Step 8: Customizing the Table Using Microsoft Word Functionality"






5.4.2.1 Step 1: Selecting Report Format

Start by selecting the basic report format. Choose from Table, Form, or Free Form. Figure 5-6 shows examples of each format.


Figure 5-6 Examples of Table, Form, and Free Form Formats

[image: Description of Figure 5-6 follows]

Description of "Figure 5-6 Examples of Table, Form, and Free Form Formats"









5.4.2.2 Step 2: Selecting Table Data

An XML document can include multiple grouped data sets. For example, a purchase order XML document may contain header level information, lines, shipments and contacts.

In this step, select the data group that contains the data that is required for the table.

For example, in the Balance Letter sample RTF template (found in the Template Builder installed files under Oracle\BI Publisher\BI Publisher Desktop\samples\RTF Templates), the sample XML file contains three data groups as follows:

	
ARXCOBLX/G_CUSTOMER


	
ARXCOBLX/G_CUSTOMER/G_CURRENCY


	
ARXCOBLX/G_CUSTOMER/G_CURRENCY/G_INVOICES




The Table Wizard presents a list of the available data groups in the XML data file. Select the group that contains the data fields for the table.

Figure 5-7 shows the Table Wizard Step 2: Selecting Table Data.


Figure 5-7 The Table Wizard Step 2: Selecting Table Data

[image: Description of Figure 5-7 follows]

Description of "Figure 5-7 The Table Wizard Step 2: Selecting Table Data"





To build a table to list the invoices contained in the data, select:

ARXCOBLX/G_CUSTOMER/G_CURRENCY/G_INVOICES

as the data set.






5.4.2.3 Step 3: Selecting Data Fields

The Table Wizard presents the data fields from the selected data set.

Figure 5-8 shows the Table Wizard Step 3: Selecting Data Fields.


Figure 5-8 The Table Wizard Step 3: Selecting Data Fields

[image: Description of Figure 5-8 follows]

Description of "Figure 5-8 The Table Wizard Step 3: Selecting Data Fields"





Use the shuttle buttons to select the data fields to show in the table. Use the up and down arrows to reorder the fields after selecting them.






5.4.2.4 Step 4: Grouping the Table

This step enables you to regroup the data by a particular field. This is optional.

For example, if you are building a table of invoices, you may want to group all invoices of a particular type or date to be grouped together in the report.

Figure 5-9 shows the Table Wizard Step 4: Grouping the Table.


Figure 5-9 The Table Wizard Step 4: Grouping the Table

[image: Description of Figure 5-9 follows]

Description of "Figure 5-9 The Table Wizard Step 4: Grouping the Table"





There are two options for grouping: Group Left or Group Above. Group Left creates a nested table. The Group By field displays to the left in the outer table. Group Above creates a new table for each new value of the group by field, displaying the value of the group by field as a table title.

Examples follow:

Group Left groups the group by element occurrences together, as shown in Figure 5-10.


Figure 5-10 Results of the Group Left Option

[image: Description of Figure 5-10 follows]

Description of "Figure 5-10 Results of the Group Left Option"





Group Above shows the result as a table with a header, as shown in Figure 5-11.


Figure 5-11 Results of the Group Above Option

[image: Surrounding text describes Figure 5-11 .]
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Description of "Figure 5-11 Results of the Group Above Option"





When you select an element to group by, BI Publisher sorts the data by the grouping element. If the data is already sorted by the grouping element, then select the Data already sorted check box. This selection improves performance.






5.4.2.5 Step 5: Inserting a Break for the Group

Use the Break option to insert either a Page break or Section break after each occurrence of this group. Note that a Section break can only be created on the top-level group. The subsequent grouping options only display the Page break option.

A page break starts the next group on a new page; a section break starts the next group on a new page, reset page numbering, reset headers and footers, and reset any running calculations for each occurrence of the group.






5.4.2.6 Step 6: Sorting the Table

You can sort the data in the table by up to four different fields. Select a field and then define the sorting order (ascending or descending), and select the correct data type for the field. For example, if text is selected, "12" comes before "2" (alphanumerical order). If number is selected, "2" comes before "12".

Figure 5-12 shows the Table Wizard Step 6: Sorting the Table.


Figure 5-12 The Table Wizard Step 6: Sorting the Table

[image: Description of Figure 5-12 follows]

Description of "Figure 5-12 The Table Wizard Step 6: Sorting the Table"









5.4.2.7 Step 7: Clicking Finish

Click Finish to create the table and insert it to the Microsoft Word document.






5.4.2.8 Step 8: Customizing the Table Using Microsoft Word Functionality

Customize the table by changing fonts, colors, column sizing, borders, shading, and so on, using Microsoft Word formatting commands.








5.4.3 Inserting a Table or Form Using the Insert Table/Form Dialog

The Insert Table/Form dialog is the most flexible tool of the template builder. It allows you to perform the following tasks:

	
Create a simple or nested table with a variable number of rows.


	
Associate a group of data elements, such as a complete invoice or a purchase order line, with a form in the document that is repeated for each occurrence of the data element.


	
Select and define a layout for all the data fields in the template.


	
Group or re-group the data.




The Insert Table/Form dialog shows you two tree view panes. The left pane shows the data source structure, while the right pane shows the elements that are copied to the template when you click the Insert button.



5.4.3.1 Selecting Data Fields

First select the data fields to insert in the template and then define how to format them. Drag an XML element from the left Data Source pane to the right Template pane. If the XML element has children, you see a pop-up menu with the following options:

	
Drop Single Node


	
Drop All Nodes


	
Cancel




Select Drop Single Node if you want to move only the selected node or Drop All Nodes if you want to move the node and all its children.

If you drag an additional data field from the left Data Source pane to the right Template pane, it is either inserted at the same level (Same Level) or below the node (Child) where you release the node. The Insert Position box defines where the node is inserted.




	
Note:

If you use the left mouse button for drag and drop, then the node and all children are copied. However, if you use the right mouse button for dragging, a dialog is displayed when you release the mouse button. The dialog gives you the option to copy either only the selected node or the selected node and all children.














5.4.3.2 Defining the Layout

When you select an element in the right Template pane, you see its properties as well as a preview of how the node is rendered. There are two kinds of nodes:

	
Data Fields


	
Data Groups




Data Field nodes (leaf nodes) do not have any child nodes. They represent simple attributes such as the total amount for an invoice or the subtotal for a purchase order line.

Data Group nodes (parent nodes) are nodes that do have child nodes. Typically, they do not represent data attributes, but groups of data - such as an invoice, a purchase order, a purchase order line or a shipment.






5.4.3.3 Data Field Properties

If a Data Field node is selected, its properties are shown in the Properties pane. You have the following options to describe how the Template Builder should show the field:

	
Calculation

You can select one of the aggregation functions for the data fields. These functions (besides count) only have an effect when there is more than one of the data fields in the context where you use the function.


	
Force LTR (Left-to-Right) Direction

This option is only needed if you are using the template in a language that displays characters from right to left, such as Arabic or Hebrew. Use this option to force left-to-right printing for fields such as phone numbers, addresses, postal codes, or bank account numbers.









5.4.3.4 Data Group Properties

The order in which the data elements are shown reflects the order of the columns in the table. If you want to reorder the columns, change the Insert Position box from Child to Same Level. Then drag the elements into the correct order.

If a Data Group node is selected, its properties are shown in the Properties pane. You have the following options to describe how the Template Builder should render the group:

	
Style

To display the data as a horizontal table with a header, select Table. To display the fields below each other with labels in a table, use Form. If you want to insert the fields into a free-form text section that should to repeated for this element select Free Form.


	
Grouping

Grouping is an advanced operation that allows you to group the data by a specific element in the data. For example, you might want to group all invoices by customer. You can select a child element of the selected element as a grouping criterion. For more information see Section 5.4.3.6, "Grouping."


	
Show Grouping Value

This property is shown only if you have selected a node created by the Grouping functionality. By default, the field you have selected to group the data by is displayed in the report. If you do not want the grouping data field displayed, then select No.


	
Sort By

Select an element by which the data groups are sorted.


	
Sort Order

If you have selected an element for Sort By you can select if the data should be sorted either ascending or descending.


	
Sort Data Type

If you have selected an element for Sort By the data is by default sorted as text. That means that 12 is shown after 111. If the data is numeric, select Number as the sort data type.


	
Break

This property allows you to insert a page break or a section break between every data group. If you select New Page per Element, then a page break is inserted between each element after the first occurrence.




	
Tip:

To insert a page break before the first occurrence of an element, use Microsoft Word's page break command.









If you select New Section per Element, then a section break is created for each data group. A section break has the following effects: it inserts page break, it resets the page numbers and new data can be displayed in the header and footer. You typically use this option if you want to print multiple documents (for example invoices or purchase orders) to a single PDF file.









5.4.3.5 Inserting Tables and Forms

Once you have dragged all data fields over and defined the layout, select the Insert button to place the tables and forms at the cursor position in the document.






5.4.3.6 Grouping

You can group any Data Group node, by any of its child Data Field Nodes. For example if you have sales data for multiple quarters, you may want to show the sales data organized by quarter. In this case you would group the sales data rows by the quarter element.

Assume the following structure:


Sales Transaction
       Quarter
       Customer
       Amount


To group the child nodes of a node (Sales Transaction), you select one of the child nodes (Quarter) as the grouping property of the parent node (Sales Transaction). The Template Builder makes this node (e.g. quarter) the parent of the other child nodes (Customer and Amount).

The new structure looks like the following:


Sales Transaction
       Quarter
            Customer
            Amount


The grouping criterion (Quarter) now behaves like any other Data Group Node with children. That means that you can define the layout of its children using the Create As Table, Style, Label, Grouping, and Show Grouping Value properties.






5.4.3.7 Understanding Fields Inserted to the Template

The Insert Table/Form Dialog creates two kinds of form fields:

	
Form fields representing data elements


	
Form fields with processing instructions for repeating table rows or document sections




Form fields representing data elements are replaced with the data when the template is processed. Form fields indicating repeating sections are shown as for-each and end for-each in the document.




	
Note:

If you have selected the Abbreviated form field display option, then the for-each and end for-each form fields are displayed as F and E. The section of the document encapsulated by these two elements is repeated, if the associated data element is repeated in the data.
















5.4.4 Inserting a Chart

Use the Chart dialog to insert a chart into a template.

Figure 5-13 shows the Chart dialog.


Figure 5-13 The Chart Dialog

[image: Description of Figure 5-13 follows]
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5.4.4.1 Chart Type

BI Publisher supports a large variety of chart types. Expand the Type list to select the chart type for this template.






5.4.4.2 Values

Drag and drop the data value you want to measure to the Values field (for example, SALES). You can select multiple Value elements (measures).

The Values field changes depending on the Chart Type that you select:

	
Combination Graph - Enables three fields for the Value selections.


	
Scatter Graph  - Compares pairs of values. Drag and drop the X and Y data elements to compare.


	
Bubble Graph - Compares sets of three values. Similar to the scatter graph, the third value is displayed as the size of the bubble.


	
Stock Graph - Drag and drop the elements that represent the Open, High, Low, Close, and Volume values for the stock graph.









5.4.4.3 Aggregation

You can choose to aggregate the Values data as a sum, a count, or an average.






5.4.4.4 Labels

Drag and drop the data element for which you want to see the Value charted (for example, Year). Select Group Data to group the occurrences of the label element before rendering it in the chart. For example, if you are charting Sales by Year, then selecting Group Data accumulates the values for Year, so that only one occurrence of each year is displayed in the chart. If you do not select Group Data, then the value for every occurrence of Year in the data is plotted separately.






5.4.4.5 Color

If you want to add a series element to the chart, then drag and drop the element to display as a series. Each value is displayed as a new color in the graph.






5.4.4.6 Chart is Inside Group

Select this box if the chart is inside a grouping and you want the chart to display data only for the occurrences of the data elements within the group.






5.4.4.7 Style

Select a color scheme and style for the chart.






5.4.4.8 Properties

The properties region enables you to change value and label display names, select color, font, and other display options for the chart. The properties list changes depending on the chart selection.






5.4.4.9 Preview

Click Preview to display the chart with the sample data.






5.4.4.10 Group Data

By default the data is grouped by the Value element and aggregated by sum.

If you deselect the Group Data check box, the each occurrence of the value element is charted and aggregation functions are not available.






5.4.4.11 Editing an Inserted Chart

To edit a chart that you have already inserted into the template, right-click the chart and select BI Publisher Chart from the menu. This invokes the chart dialog to enable you to edit the chart.








5.4.5 Inserting a Pivot Table

To insert a pivot table:

	
On the BI Publisher menu on the Insert group, click Pivot Table. The Pivot Table dialog presents the data in the left pane with empty Layout panes on the right for you to drag and drop data elements. Figure 5-14 shows the Pivot Table dialog.


Figure 5-14 The Pivot Table Dialog

[image: Description of Figure 5-14 follows]

Description of "Figure 5-14 The Pivot Table Dialog"





	
Drag and drop the elements from the Data pane to the Layout pane to build the pivot table structure. In Figure 5-15, the layout shows Sales by Industry accumulated by Year and by Month.


Figure 5-15 A Layout Showing Sales by Industry Accumulated by Year and by Month

[image: Description of Figure 5-15 follows]

Description of "Figure 5-15 A Layout Showing Sales by Industry Accumulated by Year and by Month"





	
Use the Properties pane to select Aggregation. You can choose Sum, Count, or Average. Then choose a number Format, as shown in Figure 5-16.


Figure 5-16 The Format Option

[image: Description of Figure 5-16 follows]
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By default subtotals for rows and columns are displayed. You can choose not to display the subtotals by setting the properties to False.

Figure 5-17 shows the properties for setting totals and subtotals.


Figure 5-17 Properties for Setting Totals and Subtotals

[image: Description of Figure 5-17 follows]

Description of "Figure 5-17 Properties for Setting Totals and Subtotals"





	
Click Preview to see how the pivot table is displayed before you insert it into the template. Click OK to insert the pivot table into the template. Figure 5-18 shows how the pivot table is displayed in the template.


Figure 5-18 Example of a Pivot Table in a Template

[image: Description of Figure 5-18 follows]

Description of "Figure 5-18 Example of a Pivot Table in a Template"





At runtime, this pivot table is generated as shown in Figure 5-19.


Figure 5-19 A Pivot Table at Runtime

[image: Description of Figure 5-19 follows]
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5.4.6 Inserting a Repeating Group

To insert a repeating group:

	
Select the section of the template that contains the elements you want repeated.


	
On the Oracle BI Publisher menu, in the Insert group, click Repeating Group.


	
Enter the appropriate fields in the BI Publisher Properties dialog, as shown in Figure 5-20.


Figure 5-20 The BI Publisher Properties Dialog

[image: Description of Figure 5-20 follows]
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For Each

Select the element that for each occurrence, you want the loop to repeat. When you select the For Each data field you are telling BI Publisher that for each occurrence of the selected field in the data you want the elements and processing instructions contained within the loop to be repeated.

For example, assume that the data contains invoice data for customers and you want to create a table with each customer's invoices. In this case, for each customer number you want the table to repeat. You would therefore select the customer number in the For Each field to create a new loop (or group) for each customer.

Note the following about creating repeating groups:

	
For loops and groupings not inside another group (that is, outer groups or loops) you must select the repeating XML element to be used. For example if the data set is flat, the only repeatable element is /DATA/ROWSET/ROW. In cases with multiple data sources or hierarchical XML you can choose the data set.


	
If you are creating nested groups (inserting a loop or group inside of another loop in the template), the For Each field is not updatable because it is already defined by the preexisting outer loop. The For Each field is displayed as "Group Item" to inform you that an outer group is already defined.




Absolute Path

Select this check box to use the Absolute Path to the element in the XML structure. This is important if the data contains the same element name grouped under different parent elements.

Group By

Select a field from the list by which you want to group the data. If you just want to create a simple loop, do not select a group by element. Selecting a group by element actually regroups the data into a new hierarchy based on the group by element.

Break

Use this option to create either a Page break or Section break if you want to insert a break after each occurrence of this group.

A Section break can only be created on outer groups that surround the whole document. If the selected field is not an outer group, the Section break option is not available.

Note also that when you insert a section break, the page numbering is reset, headers and footers are reset, and any running calculations are reset for each occurrence of the group.


	
To sort the grouped data, select the Sorting tab. You can select up to four sort-by fields. For each sort by field, select the following:

Sort order - Select Ascending or Descending.

Data Type - Select Number or Date/Text. It is important that you select the correct data type to achieve the expected sort order.

If you are sorting by four criteria and the XML data element names are long, then you might exceed the character length limitation (393 characters) of the Microsoft Word form field.


	
The Advanced tab enables you to edit the code directly and to enter Text to Display for the field.

The Code region displays the code and processing instructions that the Template Builder has inserted for the field. You can edit this if you want to change the processing instructions for this field.

The Text to Display field shows how this field displays in the template. You can choose to enter descriptive text to enable you to understand each field better when reading the template, or you can enter abbreviated text entries that are less intrusive to the look and feel of the template.




	
Note:

You can set the default display text as Descriptive or Abbreviated using the Options tab.









Figure 5-21 shows the Advanced tab of the BI Publisher Properties dialog.


Figure 5-21 The BI Publisher Properties Dialog: Advanced Tab

[image: Description of Figure 5-21 follows]
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When you have completed the dialog options, click OK. This inserts the form fields in the template. By default, the beginning for-each form field displays the text "F" and is inserted at the beginning of the selected template section. At the end of the selection, an "E" form field is inserted to denote the end of the repeating group.









5.4.7 Creating Grouping Fields Around an Existing Block

To create a group around an existing block of text or elements in a template:

	
Select the block of text. For example, a table row.

If any preexisting BI Publisher tags are included in the block, then you must include the beginning and ending tags. For example, if the block contains any opening for-each, if, or for-each-group tags, then you must include the end for-each, end-if, and end for-each-group tags in the selection.


	
On the Oracle BI Publisher menu, on the Insert group, click Repeating Group.


	
In the BI Publisher Properties dialog, enter the fields to define the group as described in Section 5.4.6, "Inserting a Repeating Group."


	
Click OK to insert the grouping fields around the block. For example, if the block is a table row, then the begin field is inserted at the beginning of the first cell and the end field is inserted at the end of the last field.









5.4.8 Inserting and Editing Conditional Regions

A conditional region is an area that is surrounded by a conditional statement. If the statement tests true, the area is displayed in the report; if the condition tests false, the area is suppressed from the report.

For example, the data contains sales information. The report contains a table that displays sales by industry. You want this table in the report to display information for industries with sales amounts lower than 100,000. Using the insert conditional region functionality, you can select the region that contains the sales table and insert the condition that the sales element must be less than 100,000.

	
Select the region that you want to apply the condition to. For example, if you want to display a table only for a certain condition, then select the region that contains the table. Note that the region must be inside a loop.


	
On the Oracle BI Publisher menu, on the Insert group, click Conditional Region. Figure 5-22 shows the BI Publisher Properties dialog for a Conditional Region.


Figure 5-22 The BI Publisher Properties Dialog for a Conditional Region

[image: Description of Figure 5-22 follows]
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Enter the following fields:

Data Field - Select the field to test for the condition. Select the data type of the field: Number or Date/Text.

(Condition 1) Data field - Select the comparison operator.

Select the value to meet the condition. Note that you can enter an integer, enter text, or select another data element to define a comparison based on the incoming values.


	
Click OK. The form fields that contain the conditional logic are inserted around the region. The beginning form field displays the text "C" and the form field closing the region displays the text "EC".




To edit the conditional region, double-click the inserted form field to launch the dialog for editing; or, right-click the form field and select BI Publisher, then Properties.






5.4.9 Inserting Conditional Formatting

Using the Conditional Format feature you can insert simple conditional formats to apply to table rows or cells. The dialog provides several common options that you can select and the Template Builder inserts the code automatically. The Conditional Format dialog supports two conditions per field.




	
Note:

The Conditional Format dialog cannot be used inside of pivot tables. You must insert the conditional formatting logic directly to the appropriate form fields.









To insert a conditional format:

	
Place the cursor in the table cell of the data element for which you want to define the condition.


	
On the Oracle BI Publisher menu, on the Insert group, click Conditional Format. Figure 5-23 shows the BI Publisher Properties dialog for a Conditional Format.


Figure 5-23 The BI Publisher Properties dialog for a Conditional Format

[image: Description of Figure 5-23 follows]
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Enter the following in the Conditional Format dialog

Data Field - Select the element to test for the condition and the data type of the element (Number or Date/Text).

Apply to Entire Table Row - If you want the format applied to the entire table row, not just the cell of the selected element, then select this box.

Condition 1) Data field - Select the comparison operator.

Select the value to meet the condition. You can enter an integer, enter text, or select another data element to define a comparison based on the incoming values.


	
Click Format to define the format you want to apply when the condition is met. Options are background color, font color, and font style (regular, bold, italic, bold italic). Select the box and format of each option you want to apply. After you select the format, the Preview region displays the format chosen.

Figure 5-24 shows the Format dialog.


Figure 5-24 The Format Dialog
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Define a second condition if desired.


	
Click OK. The conditional format field is inserted as a form field with the display text "C".




To edit the conditional format, double-click the inserted form field to launch the dialog for editing; or, right-click the form field and select BI Publisher, then Properties.








5.5 Previewing a Template

The Preview menu group enables you to preview the RTF template with sample XML data.




	
Note:

If you have not already done so, then you must load sample data to the Template Builder to preview the report. See Section 5.3, "Accessing Data for Building Templates."









From the Preview group, select the output format. If you have not yet saved the template as an RTF file, then you are prompted to do so.

	
PDF

You must have Adobe Acrobat Reader version 5.0 or higher installed to preview documents in PDF format.


	
HTML

Launches the default browser to display the report.


	
EXCEL

To use this option, you must have Microsoft Excel 2003 or later. If you have Excel 2003 this option generates the document in MHTML and opens the document in Excel. If you have Excel 2007, this option generates the document in .xlsx, the default Office Excel 2007 XML-based file format.


	
EXCEL 2000

Generates HTML and launches Microsoft Excel to render it. Embedded images such as charts and logos are not supported in this output type. If you do not have Microsoft Excel 2003 or later, use this option.


	
RTF

Generates the report in Rich Text Format.


	
PowerPoint

Requires Microsoft PowerPoint 2003 or 2007.









5.6 Template Editing Tools

This section describes additional tools provided with the Template Builder to help you validate and edit the template. This section includes:

	
Section 5.6.1, "Editing and Viewing Field Properties"


	
Section 5.6.2, "Validating a Template"


	
Section 5.6.3, "Using the Field Browser"


	
Section 5.6.4, "Checking Accessibility"






5.6.1 Editing and Viewing Field Properties

Once you have inserted a data field (see Section 5.4.1, "Inserting a Field") you can view or edit the field properties in the BI Publisher Properties dialog.

To invoke the BI Publisher Properties dialog, perform one of the following:

	
Double-click the field


	
Right-click the field, from the menu select BI Publisher, then Properties




Figure 5-25 shows the BI Publisher Properties dialog: note the Properties tab, the Advanced tab, and the Word Properties button. Some fields might display only the Advanced tab.


Figure 5-25 The BI Publisher Properties Dialog

[image: Description of Figure 5-25 follows]
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5.6.1.1 About the Properties Tab

You can set the following properties for a data field:

Data Field - Select the data field from the list of available fields from the loaded data source.

Text to Display - Enter the display text for the form field in the template. This text is replaced at runtime by the value in the data.

Type - Select the type of data. Options are Regular Text, Number, Date, Current Date, Current Time. The selection in this field determines the format options.

Format - For any data type except Regular Text, you can select from several number or date display formatting masks or enter your own.

Force LTR - (Force Left-to-Right) Use this check box when you are publishing the template in a language that prints the characters from right to left, such as Arabic or Hebrew. Use this option to force left-to-right printing for fields such as phone numbers, addresses, postal codes, or bank account numbers.

Function - This feature enables you to perform aggregation functions (Sum, Average, Count, Minimum, Maximum) on data fields. For example, if you select sum for a data field, then the field shows the sum of all occurring values for this data field depending on the scope (see below). See also Section 5.4.1, "Inserting a Field" for information on aggregation functions.

Scope (informational only) - This field has two possible values:

	
Group Item - Indicates that the data field is inside a group. If you choose to perform a function on the field, then only the occurrences of the field within the current group are included in the aggregation.


	
Normal - Indicates that the field is not inside a group. Aggregation functions are performed on all occurrences of the field in the data.









5.6.1.2 About the Advanced Tab

The Advanced tab displays the underlying code. If the code pattern within the form field is not recognized (for example, because you added commands manually to the field), then the BI Publisher Properties dialog displays this tab only.

Use this tab to edit or add code to the form field manually. Click OK to update the template. Figure 5-26 shows the Advanced tab.


Figure 5-26 The BI Publisher Properties Dialog: Advanced Tab
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5.6.1.3 About the Word Properties Button

The Word Properties button opens the Microsoft Word Text Form Field Options dialog. You can also use this dialog to set the data type and number format. The underlying code used by BI Publisher is also available by clicking the Add Help Text button.








5.6.2 Validating a Template

The Template Builder provides a validation tool to check the template for incorrect use of BI Publisher commands and unsupported elements in the RTF file.

To validate the template:

	
On the BI Publisher menu, on the Tools group, click Validate Template.




If there are no validation errors, then a "No Error found" message is returned. If an error is found, then an error message is displayed. You can use the Field Browser to help locate the error.






5.6.3 Using the Field Browser

The field browser dialog provides a fast way to review and update the BI Publisher instructions hidden in the Microsoft Word form fields. This dialog is particularly useful to understand and modify existing templates.

On the Tools group, click Field Browser.

Figure 5-27 shows the Field Browser dialog.


Figure 5-27 The Field Browser Dialog
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The Field Browser dialog shows a table with the display text of the form field in the Text column and the underlying code instructions in the second Code column. When you select a specific row in the dialog, the matching form field is selected in the Microsoft Word document.

If you select some part of the text before opening the Field Browser, then the dialog shows only the fields in the selection. If no text is selected, then the field browser shows all fields in the document.

The options in the Field Browser are described in the Table 5-1.


Table 5-1 Field Browser Options

	Option	Description
	
Edit

	
You can update processing instructions directly from the Field Browser dialog. Select a field in the Text table. The Edit box shows the processing instructions for the field. To change the instructions for the field modify the text in the Edit field and click Update.


	
Refresh

	
The Field Browser dialog is not aware of any form fields that you have added or modified while the dialog is open. Click Refresh to show any changes to the document since the Field Browser dialog has been opened.


	
Show All

	
If you opened the browser with a part of the document selected, then you see only the form fields in the selected area. Click Show All to see all the form fields in the document.


	
Close

	
Click Close to close the field property browser. The only button does not automatically update any changes in the edit field, therefore ensure that you select Update if you want to save edits.












5.6.4 Checking Accessibility

The Template Builder provides an accessibility checker to check the template for features to enhance the accessibility of the report for report consumers who may need assistive technologies to view the report.

To check for the presence of accessibility features: On the BI Publisher tab, in the Tools group, click Check Accessibility. The tool generates a report that indicates areas of a template that do not include the following accessibility features:

	
document title


	
alternative text for images


	
table summary for data tables


	
column header for data tables


	
row header for data tables




In some cases the accessibility checker cannot determine if the accessibility feature is present and generates a warning. The report designer can then verify that the accessibility features are present.

For information on how to add these features to the template, see Appendix C, "Designing Accessible Reports."








5.7 Uploading a Template to the BI Publisher Server

If you used the Open Template dialog to connect to BI Publisher, and load the data to the Template Builder, or if you downloaded an existing template from the BI Publisher catalog, then you can upload the new or updated layout back to the report definition on the server. See Section 5.2.2.1, "Working in Connected Mode."

If you downloaded an existing template and want to upload the modifications to the template, then select Upload Template from the Oracle BI Publisher menu.

If this is a new template for the report definition, then use the Upload Template As option to upload the layout to the report definition on the server. Also use this option to upload modifications to an existing template under a different name.






5.8 Using the Template Builder Translation Tools

The Template Builder provides tools to help you create and test translations for templates.



5.8.1 About Translations

There are two options for adding translated templates to a BI Publisher report definition:

	
Create a separate RTF template that is translated (a localized template)


	
Generate an XLIFF file from the original template (at runtime the original template is applied for the layout and the XLIFF file is applied for the translation)




Use the first option if the translated template requires a different layout from the original template.

If you only require translation of the text strings of the template layout, use the XLIFF option.

For detailed information, see Chapter 15, "Translation Support Overview and Concepts."

To use the Template Builder translation tools to create templates for translations, see the following topics in this section:

	
Extracting Text to an XLIFF File for Translation


	
Previewing a Translation


	
Localizing a Template




For a demo on BI Publisher's localization capabilities, see the LocalizationDemo.exe demo provided with the Template Builder installation (located in the BI Publisher\BI Publisher Desktop\demos folder where you installed BI Publisher Desktop).






5.8.2 Extracting Text to an XLIFF File for Translation

This menu item allows you to create a standard XLIFF translation file that contains the boilerplate text from the template. XLIFF is a standard file format that is understood by many translation software packages. Since an XLIFF is an XML file, you can translate the text in a regular text editor.

A "translatable string" is any text in the template that is intended for display in the published report, such as table headers and field labels. Text supplied at runtime from the data is not translatable, nor is any text that you supply in the Microsoft Word form fields.

To extract text to an XLIFF file for translation:

	
From the BI Publisher menu, select Tools, then Translate Template, then Extract Text.


	
You are prompted to save the extract file as an XML file type. Enter a name for the extract file and save to the desired location.


	
If you want to translate the template manually, open the .xlf file using a text editor and enter the translated strings in the file. For a detailed description of working with the BI Publisher generated .xlf files, see Section 15.2, "Working with Translation Files."


	
When done, you can preview the translation. Then upload the file to the BI Publisher report definition.









5.8.3 Previewing the Template and Translation File

To preview the template with the translated XLIFF file applied:

	
From the BI Publisher, in the Tools group, click Translation, then Preview Translation.


	
You are prompted to select the saved XLIFF file. Locate the file, and click Open.




The Template Builder merges the sample data, the translation file, and the RTF template to generate a PDF for preview.






5.8.4 Localizing a Template

Localizing a template means that you are creating a template to be used for a specific language.

Because BI Publisher enables you to extract the boilerplate text strings from a template into an XLIFF file that can be translated and then applied at runtime, if the reports for additional languages only require the translation of these text strings, then you only need to supply translated XLIFF files to accompany the base template.

However, you would localize a template when the requirements for the report in the specific language go beyond the simple translation of the text in the layout.

To save a template as a localized template:

	
From the Oracle BI Publisher menu, in the Tools group, select Translations, then Localize Template. This invokes a warning message that localizing the template overwrites the template. Click OK.


	
You are prompted to select the XLIFF translation file. Locate the appropriate file and click Open.

The translated XLIFF file is applied to the template that you currently have open in Microsoft Word.


	
Save the localized template.


	
Upload the template file to the appropriate report definition in the BI Publisher catalog. Select the appropriate locale in the upload dialog.











5.9 Setting Options for the Template Builder

Access the Options dialog as follows: In the Options group, click Options.

The Options dialog contains four tabs: UI, Preview, Build, and Connection, as described in the following sections.



5.9.1 Setting UI Options

Use the Options dialog: UI tab to set options that influence the look and feel of the Template Builder.

Figure 5-28 shows the Options dialog: UI tab.


Figure 5-28 Options Dialog: UI Tab

[image: Description of Figure 5-28 follows]
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The tree view that shows the data source can show either the correct XML tag names of the data source or they can show a slightly modified version that is easier to read. Select the option Element Names for Report XML to show the modified labels. These labels contain no <> characters, use "Title case" and use spaces (" ") instead of underscores ("_").






5.9.2 Setting Preview Options

The Options dialog: Preview tab allows you to specify options that influence the Preview functionality of the Template Builder.

Figure 5-29 shows the Options dialog: Preview tab.


Figure 5-29 The Options Dialog: Preview Tab

[image: Description of Figure 5-29 follows]
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Table 5-2 describes the options available from the Preview tab.


Table 5-2 Preview Options

	Option	Description
	
Style Template

	
If you have a BI Publisher Style Template available locally, then you can specify it here. A style template is an RTF template that contains style information that can be applied to RTF layouts, similar to a style sheet. The style information in the style template is applied to RTF layouts at runtime to achieve a consistent look and feel across your enterprise reports. For more information, Chapter 11, "Creating and Implementing Style Templates."


	
Locale

	
You can choose the language and territory used for previewing the template. While this change does not automatically translate any files, it is important to set the correct locale for the preview to use the correct direction of the text (left-to-right or right-to-left), and to correctly set locale-specific date, number, and currency formats.


	
Java Home

	
The Preview (and export functionality) requires Java code. You can change the path to the JAVA HOME directory. If this option is not specified, the Template Builder assumes that the Java virtual machine (java.exe) is accessible in the PATH specified in the environment variables of Windows.


	
Java Option

	
Specify the memory to reserve for the Template Builder to process the template. The default value is -Xmx256M.












5.9.3 Setting Build Options

Use the Options dialog: Build tab to specify options that influence how the Template Builder generates tables and forms.

Figure 5-30 shows the Options dialog: Build tab.


Figure 5-30 The Options Dialog: Build Tab
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Table 5-3 describes the options available from the Build tab.


Table 5-3 Build Tab Options

	Option	Description
	
For-each form field

	
Select how the Template Builder creates the form fields for processing instructions in the Insert Table/Form dialog.

The Descriptive option (for example: for-each Invoice) renders a descriptive form field for the processing instructions. This option makes the layout template easier to understand. However, the longer fields may distract from the visual layout of the template. Note that the descriptive option does not apply to fields within table cells.

The Abbreviated option (for example: F) provides a one letter abbreviation for each instruction.

Select the Hidden box to generate the processing instruction form fields using Microsoft Word's hidden font effect. Hidden text is hidden in the Print Preview and you may display or hide the hidden text by changing the Hidden Text setting in the Display group of the Microsoft Word Options.


	
Form Field Size

	
Large - inserts the BI Publisher code to a document variable. The document variable field can accommodate approximately 48 kilobytes of code line.

It is important to note that this setting affects only fields that are created or edited while this option is set. The form fields created with the Large setting cannot be understood by Oracle BI Publisher 10g. If the template is intended for use with the 10g version of BI Publisher, use the Backward Compatibility setting.

Backward Compatible - in previous versions of the Template Builder the BI Publisher code was inserted to the Microsoft Word Form Field Help Text box. This limited the length of code that could be inserted for a single form field. By default, the Large option is used because it can accommodate much larger code strings. However, the Large option is not compatible with Oracle BI Publisher 10g.


	
Table Header Color

	
When you insert a table using the Table Wizard or the Insert Table/Form dialog the Template Builder applies the Table Header Color specified here to the table header background. Customize the default color for the templates.


	
Generate XSLT 2.0 compliant code

	
BI Publisher uses the XSLT processor provided by Oracle XDK 11.1.0.7.0, which supports the W3C XSL Transformations 1.0 recommendation. The processor also implements the current working drafts of the XSLT and XPath 2.0 standards. For more information about Oracle XDK, see Oracle XML Developer's Kit Programmer's Guide.

By default, BI Publisher is compatible with XSLT 1.0. If you want to use XSLT and XPath 2.0 features in the template, then enable this option. This configuration is performed at the template level. The template-level setting overrides the server setting.












5.9.4 Setting Connection Options

Options on this tab are reserved for a future release.








5.10 Setting Up a Configuration File

The Template Builder can be used with a BI Publisher configuration file.

The configuration file must be named xdoconfig.xml and must be stored in the config directory (example path: C:\Program Files\Oracle\BI Publisher Desktop\Template Builder for Word\config) under the BI Publisher directory.

Alternatively, you can use the file name xdo.cfg, which is used by the BI Publisher server. The configuration file allows you to:

	
Define additional fonts such as Windings to test the templates


	
Use security settings for PDF files




See the appendix "Configuration File Reference" in Oracle Fusion Middleware Administrator's Guide for Oracle Business Intelligence Publisher for the syntax of the configuration file.






5.11 BI Publisher Menu Reference

When you install the Template Builder the next time you open Microsoft Word, you see the Oracle BI Publisher menu.




	
Note:

If you are using Microsoft Word 2007, then you might have to modify the Add-In settings. Click the Office Button, click Word Options, then click Add-Ins.











5.11.1 About the Online Group

The Online group of commands enable you to initiate interaction with the BI Publisher application. For more information about working with the online commands, see Section 5.2.2.1, "Working in Connected Mode."

Figure 5-31 shows the Online group of commands.


Figure 5-31 The Online Group of Commands
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Table 5-4 describes the commands available for the Online group.


Table 5-4 Online Group Commands

	Command	Description
	
Log on

	
Enables you to log in to BI Publisher. Enter your user name and password. Select or enter the URL for the BI Publisher Report Server (see your Administrator if you do not know the URL). When you log on, the Open Template dialog is displayed.

Note: You must log in directly to the BI Publisher server. For example: http://www.example.com:7001/xmlpserver.


	
Open

	
After you log on, this command becomes available to enable you to open a report in the BI Publisher catalog.


	
Upload Template

	
If you used the Open Template dialog to download a template from the BI Publisher catalog, use this option to upload the updated layout back to the report definition in the catalog.


	
Upload Template As

	
If you used the Open Template dialog to download a template or to open a report from the catalog, use this option to upload the layout to the report definition in the catalog. Also use this option to upload modifications to an existing template under a different name.


	
Save XML Data

	
If you are working in connected mode, then use this command to save the data to a local directory if you also need access to the data in disconnected mode.












5.11.2 About the Load Data Group

The Load Data group of commands enables you to load a saved sample data file or sample schema to the Template Builder. You must load data to use most of the Template Builder functionality. See Section 5.3, "Accessing Data for Building Templates" for more options for loading data to the Template Builder.

Figure 5-32 shows the Load Data group of commands.


Figure 5-32 The Load Data Group of Commands
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Table 5-5 describes the commands available for the Load Data group.


Table 5-5 Load Data Group Commands

	Command	Description
	
Sample XML

	
This command enables you to load a previously saved sample XML file from the report data source. If you are not connected to the BI Publisher server, use this method to load the data.


	
XML Schema

	
This command enables you to load an XML Schema file (.xsd) that contains the fields available in the report XML data. The XML schema has the advantage of being complete (a sample xml file may not contain all the fields from the data source). For the preview, the Template Builder can generate dummy sample data for an XML Schema. However, the preview works better if you also upload real sample data.












5.11.3 About the Insert Group

Use the Insert group of commands to insert the layout components to the template. For more information, see Section 5.4, "Inserting Components to the Template."

Figure 5-33 shows the Insert group of commands.


Figure 5-33 The Insert Group of Commands
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Table 5-6 describes the commands available for the Insert group.


Table 5-6 Insert Group Commands

	Command	Description
	
Table Wizard

	
This function provides a wizard that guides you through the creation of tables used in typical reports.


	
Pivot Table

	
The Pivot Table function enables you to drag and drop the data elements to a pivot table structure.


	
Chart

	
BI Publisher does not recognize native Microsoft Word charts. The Insert Chart function allows you to insert a chart that is understood by Oracle BI Publisher.


	
Field

	
This function allows you to select fields from the data source and insert them into the template.

Note: As a beginner, you should use Insert Fields only for data fields that are unique - none repeating - in the document. See Section 5.4.2, "Inserting a Table Using the Table Wizard" for additional information on how to insert repetitive fields.


	
Table/Form

	
Use this function to insert data fields to be organized as a simple or nested table or as a form that is repeated with different data. You may even organize all the data fields for the whole document before inserting them.


	
Repeating Group

	
Enables you to select or define a group of elements that you want repeated for each occurrence of an element in the data.


	
Conditional Format

	
Enables you to define simple conditional formats to apply to table rows or cells.


	
Conditional Region

	
Enables you to insert a conditional statement around a region of the template.


	
All Fields

	
This function inserts all fields found in the XML data into the document. It also inserts processing instructions into the document that repeats a section - such as a table row - when the associated XML element is repeated.

Note: XML documents often contain a large number of fields in a deeply nested hierarchy. For example, an Oracle Purchasing purchase order contains purchase order lines, which contain shipments, which contain distributions. The purchase order line alone contains more than 150 data fields. In these cases, you should use the Insert Table/Form function to have more control over which fields are inserted.












5.11.4 About the Preview Group

The Preview group of commands enables you to preview the RTF template with the sample XML data. The preview menu offers PDF, HTML, RTF, PowerPoint, Excel (MHTML format) and EXCEL2000 as output formats. When you select any of these output formats, the Template Builder merges the data into the template and creates the output document.

Figure 5-34 shows the Preview group of commands.


Figure 5-34 The Preview Group of Commands
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Note:

You must have Adobe Acrobat Reader version 5.0 or higher installed to preview documents in PDF format.














5.11.5 About the Tools Group

For more information about using the commands in the Tools group refer to Section 5.6, "Template Editing Tools" and Section 5.8, "Using the Template Builder Translation Tools."

Figure 5-35 shows the Tools group of commands.


Figure 5-35 The Tools Group of Commands
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Table 5-7 describes the commands available for the Tools group.


Table 5-7 Tools Group Commands

	Command	Description
	
Field Browser

	
The field browser is a tool for advanced users who must change the BI Publisher commands that are hidden in the form fields. It shows the commands behind each form field and allows you to change them. Use this tool to correct flawed RTF templates or to update multiple fields efficiently.


	
Validate Template

	
The validation function checks the template for incorrect use of BI Publisher commands and unsupported elements in the Word file.


	
Translation

	
Includes the following subcommands:

	
Extract Text - Enables you to create a standard XLIFF translation file that contains the boilerplate text from the template. XLIFF is a standard file format that is understood by many translation software packages. Because an XLIFF is an XML file, you can translate the text in a text editor. For more information on working with XLIFF files, see Section 15.2, "Working with Translation Files."


	
Preview Translation - Enables you to preview the template as a PDF file using a specified XLIFF translation file. This functionality enables you to test translation files.


	
Localize Template - Applies a translation file to an RTF template. This means that in the current RTF template all boilerplate text is translated. The main function of this feature is to create a language-specific version of a template.





	
Export

	
Includes the following functions:

	
XSL-FO Stylesheet - Allows you to convert the RTF template into an enhanced XSL-FO stylesheet. This function can be used to generate XSL-FO for debugging or further customization.


	
Formatted XML - Enables you to apply the XSL-FO stylesheet generated from the Word document to the sample data and save the intermediate FO format. This function is mainly for debugging.


	
PDF - Converts the Word document to PDF.















5.11.6 About the Options Group

The Options group of commands allows you to define preferences and options for using BI Publisher and access online help.

Figure 5-36 shows the Options group of commands.


Figure 5-36 The Options Group of Commands
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See Section 5.9, "Setting Options for the Template Builder."
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B Extended Function Support in RTF Templates


This appendix describes SQL and XSL functions extended by BI Publisher for use in RTF templates.

It includes the following sections:

	
Section B.1, "Extended SQL and XSL Functions"


	
Section B.2, "XSL Equivalents"


	
Section B.3, "Using FO Elements"






B.1 Extended SQL and XSL Functions

BI Publisher has extended a set of SQL and XSL functions for use in RTF templates. The syntax for these extended functions is

<?xdofx:expression?>

for extended SQL functions or

<?xdoxslt:expression?>

for extended XSL functions.

You cannot mix xdofx statements with XSL expressions in the same context. For example, assume that you had two elements, FIRST_NAME and LAST_NAME to concatenate into a 30-character field and right pad the field with the character "x". You could not use the following:

Incorrect:


<?xdofx:rpad(concat(FIRST_NAME,LAST_NAME),30, 'x')?>


because concat is an XSL expression. Instead, you could use the following:

Correct:


<?xdofx:rpad(FIRST_NAME||LAST_NAME),30,'x')?>


The supported functions are shown in Table B-1.


Table B-1 Supported Functions

	SQL Statement or XSL Expression	Usage	Description
	
2+3

	
<?xdofx:2+3?>

	
Addition


	
2-3

	
<?xdofx:2-3?>

	
Subtraction


	
2*3

	
<?xdofx:2*3?>

	
Multiplication


	
2 div 3

	
<?xdofx:2 div 3?>

	
Division


	
2**3

	
<?xdofx:2**3?>

	
Exponential


	
3||2

	
<?xdofx:3||2?>

	
Concatenation


	
sdiv()

	
<?xdoxslt:sdiv(num1,num2, string)?>

	
Safe divide function returns a specified value if the result of the function is not a number (NaN). In the syntax shown, num1 is the dividend; num2 is the divisor and string is the value to be returned if NaN is returned.

Examples:

<?xdoxslt:sdiv(10,0, '0')?> would yield '0'

<?xdoxslt:sdiv(10,0, 'None')?> would yield 'None'.


	
lpad('aaa',10,'.')

	
<?xdofx:lpad('aaa',10,'.')?>

	
The lpad function pads the left side of a string with a specific set of characters. The syntax for the lpad function is: lpad(string1,padded_length,[pad_string])string1 is the string to pad characters to (the left-hand side).padded_length is the number of characters to return.pad_string is the string that is padded to the left-hand side of string1 .


	
rpad('aaa',10,'.')

	
<?xdofx:rpad('aaa',10,'.')?>

	
The rpad function pads the right side of a string with a specific set of characters. The syntax for the rpad function is: rpad(string1,padded_length,[pad_string]).string1 is the string to pad characters to (the right-hand side).padded_length is the number of characters to return.pad_string is the string that is padded to the right-hand side of string1


	
trim()

	
<?xdoxslt:trim(' a ')?>

	
Removes spaces in a string. Enter the text to be trimmed, the function returns the trimmed text.


	
ltrim()

	
<?xdoxslt:ltrim(' a ')?>

	
Removes the leading white spaces in a string.


	
rtrim()

	
<?xdoxslt:rtrim(' a ')?>

	
Removes the trailing white spaces in a string.


	
truncate

	
<?xdoxslt:truncate ( number [, integer ] )?>

	
The truncate function returns number truncated to integer places right of the decimal point. If integer is omitted, then number is truncated to the whole integer value. integer can be negative to truncate values left of the decimal point. integer must be an integer. Example: <?xdoxslt:truncate(-2.3333)?> returns -2 Example: <?xdoxslt:truncate(2.7777, 2)?> returns 2.77 Example: <?xdoxslt:truncate(27.7777, -1)?> returns 20


	
replicate

	
<?xdoxslt:replicate('string', integer)?>

	
The replicate function replicates the specified string the specified number of times. Example: <?xdoxslt:replicate('oracle', 3)?> returns oracleoracleoracle


	
decode('xxx','bbb','ccc','xxx','ddd')

	
<?xdofx:decode('xxx','bbb','ccc','xxx','ddd')?>

	
The decode function has the functionality of an IF-THEN-ELSE statement. The syntax for the decode function is: decode(expression, search, result [,search, result]...[, default])expression is the value to compare.search is the value that is compared against expression.result is the value returned, if expression is equal to search.default is returned if no matches are found.


	
Instr('abcabcabc','a',2)

	
<?xdofx:Instr('abcabcabc','a',2)?>

	
The instr function returns the location of a substring in a string. The syntax for the instr function is: instr(string1,string2,[start_position],[nth_appearance])string1 is the string to search.string2 is the substring to search for in string1.start_position is the position in string1 where the search starts. The first position in the string is 1. If the start_position is negative, the function counts back start_position number of characters from the end of string1 and then searches towards the beginning of string1.nth appearance is the nth appearance of string2.


	
substr('abcdefg',2,3)

	
<?xdofx:substr('abcdefg',2,3)?>

	
The substr function allows you to extract a substring from a string. The syntax for the substr function is: substr(string, start_position, length)string is the source string.start_position is the position for extraction. The first position in the string is always 1.length is the number of characters to extract.


	
left

	
<?xdoxslt:left('abcdefg', 3)?>

	
Enables you to extract the specified number of characters from a string, starting from the left. The syntax is left(string, Numchars) For example, <?xdoxslt:left('abcdefg', 3)?> returns abc


	
right

	
<?xdoxslt:right('abcdefg', 3)?>

	
Enables you to extract the specified number of characters from a string, starting from the right. The syntax is right(string, Numchars) For example, <?xdoxslt:right('abcdefg', 3)?> returns efg


	
replace(name,'John','Jon')

	
<?xdofx:replace(name,'John','Jon')?>

	
The replace function replaces a sequence of characters in a string with another set of characters. The syntax for the replace function is: replace(string1,string_to_replace,[replacement_string])string1 is the string to replace a sequence of characters with another set of characters.string_to_replace is the string that is searched for in string1.replacement_string is optional. All occurrences of string_to_replace are replaced with replacement_string in string1.


	
to_number('12345')

	
<?xdofx:to_number('12345')?>

	
Function to_number converts char, a value of CHAR, VARCHAR2, NCHAR, or NVARCHAR2 datatype that contains a number in the format that is specified by the optional format model fmt, to a value of NUMBER datatype.


	
format_number

	
<?xdoxslt:format_number(12345, n, $_XDOLOCALE)?>

	
Converts a number to a string and formats the number according to the locale specified in $_XDOLOCALE and to the number of decimal positions specified in n using Java's default symbols. For example: <?xdoxslt:format_number(-12345, 2, 'fr-FR')?> returns -12 345,00


	
format_number

	
<?xdoxslt:format_number(12345, n, s1, s2,$_XDOLOCALE)?>

	
Converts a number to a string and uses the specified separators: s1 for the thousand separator and s2 for the decimal separator. For example: <?xdoxslt:format_number(12345, 2, 'g', 'd', $_XDOLOCALE)?> returns 12g345d00


	
pat_format_number

	
<?xdoxslt:pat_format_number(12345, '##,##0.00', $_XDOLOCALE)?>

	
Returns a number formatted with the specified pattern. For example: <?xdoxslt:pat_format_number(12345, '##,##0.00', $_XDOLOCALE)?> returns 12,345.00


	
to_char(12345)

	
<?xdofx:to_char('12345')?>

	
Use the TO_CHAR function to translate a value of NUMBER datatype to VARCHAR2 datatype.


	
to_date

	
<?xdofx:to_date ( char [, fmt [, 'nlsparam']] )

	
TO_DATE converts char of CHAR, VARCHAR2, NCHAR, or NVARCHAR2 datatype to a value of DATE datatype. The fmt is a date format specifying the format of char. If you omit fmt, then char must be in the default date format. If fmt is 'J', for Julian, then char must be an integer.


	
format_date()

	
<?xdoxslt:format_date(./AnyDate,'yyyy-MM-dd','MM/dd/yyyy', $_XDOLOCALE, $_XDOTIMEZONE)?>

	
Reads date in one format and creates in another format.


	
sysdate()

	
<?xdofx:sysdate()?>

	
SYSDATE returns the current date and time in XML canonical date format (for example: 1997-07-16T19:20:30.45+01:00). The datatype of the returned value is DATE. The function requires no arguments. See Section 4.15.13, "Displaying the System Date (sysdate) in Reports" for information on properly formatting the sysdate in report output.


	
current_date()

	
<?xdoxslt:current_date($_XDOLOCALE, $_XDOTIMEZONE)?> Example: <?xdoxslt:current_date('ja-JP', 'Asia/Tokyo')?>

	
Returns the current date in "yyyy-MM-dd" format in the given locale and timezone. This function supports only the Gregorian calendar.


	
current_time()

	
<?xdoxslt:current_time($_XDOLOCALE, $_XDOTIMEZONE)?> Example: <?xdoxslt:current_time('ja-JP', 'Asia/Tokyo')?>

	
Returns the current time in the given locale and timezone. This function supports only the Gregorian calendar.


	
minimum

	
<?xdoxslt:minimum(ELEMENT_NAME)?>

	
Returns the minimum value of the element in the set.


	
date_diff

	
<?xdoxslt:date_diff('y', 'YYYY-MM-DD', 'YYYY-MM-DD', $_XDOLOCALE, $_XDOTIMEZONE)?>

	
This function provides a method to get the difference between two dates in the given locale. The dates must be in "yyyy-MM-dd" format. This function supports only the Gregorian calendar. The syntax is as follows: <?xdoxslt:date_diff('format', 'YYYY-MM-DD', 'YYYY-MM-DD', $_XDOLOCALE, $_XDOTIMEZONE)?> where format is the time value for which the difference is to be calculated. Valid values are:

	
y - for year


	
m - for month


	
w - for week


	
d - for day


	
h - for hour


	
mi - for minute


	
s - for seconds


	
ms - for milliseconds




Example: <?xdoxslt:date_diff('y', '2000-04-08', '2001-05-01', $_XDOLOCALE, $_XDOTIMEZONE)?>

returns 1

Example: <?xdoxslt:date_diff('m', '2001-04-08', '2000-02-01', $_XDOLOCALE, $_XDOTIMEZONE)?>

returns -14

Example: <?xdoxslt:date_diff('d', '2006-04-08', '2006-04-01', $_XDOLOCALE, 'America/Los_Angeles')?>

returns -7


	
sec_diff

	
<?xdoxslt:sec_diff('2000-04-08T20:00:00', '2000-04-08T21:00:00', $_XDOLOCALE, $_XDOTIMEZONE?>

	
This function provides a method to get the difference between two dates in seconds in the given locale. The dates must be in "yyyy-MM-dd'T'HH:mm:ss". This function supports only Gregorian calendar. Example: <?xdoxslt:sec_diff('2000-04-08T20:00:00', '2000-04-08T21:00:00', $_XDOLOCALE, $_XDOTIMEZONE?> returns 3600


	
get_day

	
<?xdoxslt:get_day('2000-04-08', $_XDOLOCALE)?>

	
This function provides a method to get the day value of a date in "yyyy-MM-dd" format in the given locale. This function supports only the Gregorian calendar. Example: <?xdoxslt:get_day('2000-04-08', $_XDOLOCALE)?> returns 8


	
get_month

	
<?xdoxslt:get_month('2000-04-08', $_XDOLOCALE)?>

	
This function provides a method to get the month value of a date in "yyyy-MM-dd" format in the given locale. This function supports only the Gregorian calendar. Example: <?xdoxslt:get_month('2000-04-08', $_XDOLOCALE)?> returns 4


	
get_year

	
<?xdoxslt:get_year('2000-04-08', $_XDOLOCALE)?>

	
This function provides a method to get the year value of a date in "yyyy-MM-dd" format in the given locale. This function supports only the Gregorian calendar. Example: <?xdoxslt:get_year('2000-04-08', $_XDOLOCALE)?> returns 2000


	
month_name

	
<?xdoxslt:month_name(1, 0, $_XDOLOCALE)?>

	
This function provides a method to get the name of the month in the given locale. This function supports only the Gregorian calendar. The syntax for this function is: <?xdoxslt:month_name(month, [abbreviate?], $_XDOLOCALE)?> where month is the numeric value of the month (Januany = 1) and [abbreviate?] is the value 0 for do not abbreviate or 1 for abbreviate. Example: <?xdoxslt:month_name(12, 1, 'fr-FR')?> returns dec. Example" <?xdoxslt:month_name(1, 0, $_XDOLOCALE)?> returns January


	
maximum

	
<?xdoxslt:maximum(ELEMENT_NAME)?>

	
Returns the maximum value of the element in the set.


	
abs

	
<?xdoxslt:abs(-123.45)?>

	
Returns the absolute value of the number entered. Example: <?xdoxslt:abs(-123.45)?> Returns: 123.45


	
chr

	
<?xdofx:chr(n)?>

	
CHR returns the character having the binary equivalent to n in either the database character set or the national character set.


	
ceil

	
<?xdofx:ceil(n)?>

	
CEIL returns smallest integer greater than or equal to n.


	
floor

	
<?xdofx:floor(n)?>

	
FLOOR returns largest integer equal to or less than n.


	
round (SQL function)

	
<?xdofx:round ( number [, integer ] )?>

	
ROUND returns number rounded to integer places right of the decimal point. If integer is omitted, then number is rounded to 0 places. integer can be negative to round off digits left of the decimal point. integer must be an integer. Example: <?xdofx:round (2.777)?> returns 3 Example: <?xdofx:round (2.777, 2)?> returns 2.78


	
round (XSLT function)

	
<?xdoxslt:round ( number [, integer ] )?>

	
ROUND returns number rounded to integer places right of the decimal point. If integer is omitted, then number is rounded to 0 places. integer can be negative to round off digits left of the decimal point. integer must be an integer. Example: <?xdoxslt:round (2.777)?> returns 3 Example: <?xdoxslt:round (2.777, 2)?> returns 2.78


	
lower

	
<?xdofx:lower (char)?>

	
LOWER returns char, with all letters lowercase. char can be any of the datatypes CHAR, VARCHAR2, NCHAR, NVARCHAR2, CLOB, or NCLOB. The return value is the same datatype as char.


	
upper

	
<?xdofx:upper(char)?>

	
UPPER returns char, with all letters uppercase. char can be any of the datatypes CHAR, VARCHAR2, NCHAR, NVARCHAR2, CLOB, or NCLOB. The return value is the same datatype as char.


	
length

	
<?xdofx:length(char)?>

	
The "length" function returns the length of char. LENGTH calculates length using characters as defined by the input character set.


	
greatest

	
<?xdofx:greatest ( expr [, expr]... )?>

	
GREATEST returns the greatest of the list of exprs. All exprs after the first are implicitly converted to the datatype of the first expr before the comparison.


	
least

	
<?xdofx:least ( expr [, expr]... )?>

	
LEAST returns the least of the list of exprs. All exprs after the first are implicitly converted to the datatype of the first expr before the comparison.


	
next_element

	
<?xdoxslt:next_element(current-group(),.,'<element-name>')?>

	
Method to get the next element in the current group. Returns the element that occurs after the element named. For example: <?xdoxslt:next_element(current-group(),.,'employee')?> returns the element that occurs in the current group after "employee".


	
prev_element

	
<?xdoxslt:prev_element(current-group(),..,'<element-name')?>

	
Method to get the previous element in the current group. Returns the element that occurs before the element named. For example: <?xdoxslt:prev_element(current-group(),.,'employee')?> returns the element that occurs in the current group before "employee".


	
set_array

	
<?xdoxslt:set_array($_XDOCTX, '<name of hash table>', n, '<value>')?>

	
Sets a value in a hash table. Syntax is <?xdoxslt:set_array($_XDOCTX, '<name of hash table>', n, '<value>')?> where $_XDOCTX is required to set the context, <name of hash table> is the name that you supply for your table n is the index of the hash table <value> is the value to set in the hash table. For example: <?xdoxslt:set_array($_XDOCTX, 'Employee', 2, 'Jones')?> See get_array below.


	
get_array

	
<?xdoxslt:get_array($_XDOCTX, '<name of hash table>', n)?>

	
Returns the value at the specified index of the hash table. Syntax is <?xdoxslt:get_array($_XDOCTX, '<name of hash table>', n)?> where $_XDOCTX is required to set the context, <name of hash table> is the name you supplied for your table in set_array n is the index value of the element you want returned. For example, used in conjunction with the set_array example above, <?xdoxslt:get_array($_XDOCTX, 'Employee', 2)?> returns Jones








Table B-2 shows supported combination functions.


Table B-2 Supported Combination Functions

	SQL Statement	Usage
	
(2+3/4-6*7)/8

	
<?xdofx:(2+3/4-6*7)/8?>


	
lpad(substr('1234567890',5,3),10,'^')

	
<?xdofx:lpad(substr('1234567890',5,3),10,'^')?>


	
decode('a','b','c','d','e','1')||instr('321',1,1)

	
<?xdofx:decode('a','b','c','d','e','1')||instr('321',1,1)?>










B.1.1 Number-To-Word Conversion

This function enables the conversion of numbers to words for RTF template output. This is a common requirement for check printing.

The new function is "to_check_number". The syntax of this function is


<?xdofx:to_check_number(amount, precisionOrCurrency, caseType, decimalStyle)?>



Table B-3 describes the function attributes.


Table B-3 Function Attributes

	Attribute	Description	Valid Value
	
amount

	
The number to be transformed.

	
Any number


	
precisionOrCurrency

	
For this attribute you can specify either the precision, which is the number of digits after the decimal point; or the currency code, which governs the number of digits after the decimal point. The currency code does not generate a currency symbol in the output.

	
An integer, such as 2; or a currency code, such as 'USD'.


	
caseType

	
The case type of the output.

	
Valid values are: 'CASE_UPPER', 'CASE_LOWER', 'CASE_INIT_CAP'


	
decimalStyle

	
Output type of the decimal fraction area.

	
Valid values are: 'DECIMAL_STYLE_FRACTION1', 'DECIMAL_STYLE_FRACTION2', 'DECIMAL_STYLE_WORD'








Table B-4 displays the example function as entered in an RTF template and the returned output.


Table B-4 Function as Entered in an RTF Template

	RTF Template Entry	Returned Output
	
<?xdofx:to_check_number(12345.67, 2)?>

	
Twelve thousand three hundred forty-five and 67/100


	
<?xdofx:to_check_number(12345.67, 'USD')?>

	
Twelve thousand three hundred forty-five and 67/100


	
<?xdofx:to_check_number(12345, 'JPY', 'CASE_UPPER')?>

	
TWELVE THOUSAND THREE HUNDRED FORTY-FIVE


	
<?xdofx:to_check_number(12345.67, 'EUR', 'CASE_LOWER', 'DECIMAL_STYLE_WORDS')?>

	
twelve thousand three hundred forty-five and sixty-seven














B.2 XSL Equivalents

Table B-5 lists the BI Publisher simplified syntax with the XSL equivalents.


Table B-5 BI Publisher Syntax with XSL Equivalents

	Supported XSL Elements	Description	BI Publisher Syntax
	
<xsl:value-of select= "name">

	
Placeholder syntax

	
<?name?>


	
<xsl:apply-templates select="name">

	
Applies a template rule to the current element's child nodes.

	
<?apply:name?>


	
<xsl:copy-of select="name">

	
Creates a copy of the current node.

	
<?copy-of:name?>


	
<xsl:call-template name="name">

	
Calls a named template to be inserted into/applied to the current template.

	
<?call:name?>


	
<xsl:sort select="name">

	
Sorts a group of data based on an element in the dataset.

	
<?sort:name?>


	
<xsl:for-each select="name">

	
Loops through the rows of data of a group, used to generate tabular output.

	
<?for-each:name?>


	
<xsl:choose>

	
Used in conjunction with when and otherwise to express multiple conditional tests.

	
<?choose?>


	
<xsl:when test="exp">

	
Used in conjunction with choose and otherwise to express multiple conditional tests

	
<?when:expression?>


	
<xsl:otherwise>

	
Used in conjunction with choose and when to express multiple conditional tests

	
<?otherwise?>


	
<xsl:if test="exp">

	
Used for conditional formatting.

	
<?if:expression?>


	
<xsl:template name="name">

	
Template declaration

	
<?template:name?>


	
<xsl:variable name="name">

	
Local or global variable declaration

	
<?variable:name?>


	
<xsl:import href="url">

	
Import the contents of one stylesheet into another

	
<?import:url?>


	
<xsl:include href="url">

	
Include one stylesheet in another

	
<?include:url?>


	
<xsl:stylesheet xmlns:x="url">

	
Define the root element of a stylesheet

	
<?namespace:x=url?>












B.3 Using FO Elements

You can use most FO elements in an RTF template inside the Microsoft Word form fields. The FO elements listed in Table B-6 have been extended for use with BI Publisher RTF templates. The BI Publisher syntax can be used with either RTF template method.

The full list of FO elements supported by BI Publisher can be found in the Appendix D, "Supported XSL-FO Elements."


Table B-6 FO Elements

	FO Element	BI Publisher Syntax
	
<fo:page-number-citation ref-id="id">

	
<?fo:page-number-citation:id?>


	
<fo:page-number>

	
<?fo:page-number?>


	
<fo:ANY NAME WITHOUT ATTRIBUTE>

	
<?fo:ANY NAME WITHOUT ATTRIBUTE?>















4 Creating RTF Templates


This chapter describes the concepts of associating XML data to layout elements in an RTF report template. It describes basic and advanced techniques for creating complex and highly conditionalized report formats.

This chapter includes the following topics:

	
Section 4.1, "Getting Started"


	
Section 4.2, "Associating the XML Data to the Template Layout"


	
Section 4.3, "Adding Markup to the Template Layout"


	
Section 4.4, "Defining Groups"


	
Section 4.5, "Defining Headers and Footers"


	
Section 4.6, "Inserting Images and Charts"


	
Section 4.7, "Adding Drawings, Shapes, and Clip Art"


	
Section 4.8, "Supported Formatting Features of Microsoft Word"


	
Section 4.9, "Template Features"


	
Section 4.10, "Using Conditional Formatting"


	
Section 4.11, "Inserting Page-Level Calculations"


	
Section 4.12, "Handling Data"


	
Section 4.13, "Setting Variables, Parameters, and Properties"


	
Section 4.14, "Using Advanced Report Layouts"


	
Section 4.15, "Formatting Numbers, Dates, and Currencies"


	
Section 4.16, "Supporting Calendars and Time Zones"


	
Section 4.17, "Using External Fonts"


	
Section 4.18, "Controlling the Placement of Instructions Using the Context Commands"


	
Section 4.19, "Using XPath Commands"


	
Section 4.20, "Declaring Namespaces"


	
Section 4.21, "Using FO Elements and XSL Elements"


	
Section 4.22, "Guidelines for Designing RTF Templates for Microsoft PowerPoint Output"


	
Section 4.23, "Rendering HTML Formatted Data in a Report"






4.1 Getting Started

This chapter describes the concepts of associating XML data to layout elements in a report template. It describes basic techniques as well as advanced techniques for creating complex and highly conditionalized report formats.

If you are using Microsoft Word to create RTF templates, then see Chapter 5, "Creating RTF Templates Using the Template Builder for Word" before reading this chapter. The demos and samples provided in the Template Builder installation can help orient you to the process of creating templates in Microsoft Word.

It is not required to have Microsoft Word or the Template Builder to create RTF templates and this chapter describes how to add components without using the Template Builder. Many of the layout components described in this chapter can also be inserted in a template using the Template Builder.

This section covers the following topics:

	
Section 4.1.1, "What Are RTF Templates?"


	
Section 4.1.2, "Prerequisites for Designing Templates"


	
Section 4.1.3, "What is XSLT Compatibility?"


	
Section 4.1.4, "Key Concepts"


	
Section 4.1.5, "Designing the Template Layout"


	
Section 4.1.6, "About Adding BI Publisher Code"






4.1.1 What Are RTF Templates?

Rich Text Format (RTF) is a specification used by common word processing applications, such as Microsoft Word. When you save a document, RTF is a file type option.

BI Publisher converts documents saved as the RTF file type to XSL-FO enabling you to create report layouts using many standard word processor features.

During design time, you add data fields and other markup to the template using BI Publisher's simplified tags for XSL expressions. These tags associate the XML report data to the report layout and include other processing instructions.

In addition to the word processor's formatting features, BI Publisher supports other advanced reporting features such as conditional formatting, dynamic data columns, running totals, and charts.

If you are familiar with XSL and prefer not to use the simplified tags, BI Publisher also supports the use of pure XSL elements in the template. If you want to include code directly in the template, then you can include any XSL element, many FO elements, and a set of SQL expressions that BI Publisher extends.






4.1.2 Prerequisites for Designing Templates

Before you design a template, you must:

	
Know the business rules that apply to the data from the source report.


	
Generate sample data from the report data model.

For information on generating sample data from a data model, see the "Testing Data Models and Generating Sample Data" in Oracle Fusion Middleware Data Modeling Guide for Oracle Business Intelligence Publisher.


	
Be familiar with the formatting features of Microsft Word.









4.1.3 What is XSLT Compatibility?

BI Publisher uses the XSLT processor provided by Oracle XDK 11.1.0.7.0, which supports the W3C XSL Transformations 1.0 recommendation. The processor also implements the current working drafts of the XSLT and XPath 2.0 standards. For more information about Oracle XDK, see Oracle XML Developer's Kit Programmer's Guide.

By default, BI Publisher is compatible with XSLT 1.0. If you want to use XSLT and XPath 2.0 features in the template, then you must disable XSLT 1.0 compatibility. This configuration is performed at the template level. The template-level setting overrides the server setting.

XSLT compatibility is set as a Build Option in the Template Builder for Word. See Section 5.9.1, "Setting UI Options."






4.1.4 Key Concepts

When you design the template layout, you must understand how to associate the XML input file to the layout. This chapter presents a sample template layout with its input XML file to illustrate how to make the proper associations to add the markup tags to the template.






4.1.5 Designing the Template Layout

Use the word processor's formatting features to create the design.

For example:

	
Select the size, font, and alignment of text


	
Insert bullets and numbering


	
Draw borders around paragraphs


	
Include a watermark


	
Include images (jpg, gif, or png)


	
Use table autoformatting features


	
Insert a header and footer

For additional information on inserting headers and footers, see Section 4.5, "Defining Headers and Footers."




For a detailed list of supported formatting features in Microsoft Word, see Section 4.8, "Supported Formatting Features of Microsoft Word."






4.1.6 About Adding BI Publisher Code

When you create an RTF template, you add BI Publisher code to the RTF document. BI Publisher supports the following methods for adding code:

	
Basic RTF Method

Use any word processor that supports RTF version 1.6 writer (or later) to design a template using BI Publisher's simplified syntax.


	
Form Field Method

Using Microsoft Word's form field feature allows you to place the syntax in hidden form fields, rather than directly into the design of the template.




	
Note:

If you use XSL or XSL:FO code rather than the simplified syntax, then you must use the form field method.












This chapter describes how to create RTF templates using the preceding methods.

If you are using Microsoft Word, you can use the BI Publisher Template Builder for Word to facilitate inserting BI Publisher code fields. For detailed information, see Chapter 5, "Creating RTF Templates Using the Template Builder for Word."








4.2 Associating the XML Data to the Template Layout

Figure 4-1 shows a sample layout for a Payables Invoice Register.


Figure 4-1 Sample Layout for Payables Invoice Register

[image: Description of Figure 4-1 follows]

Description of "Figure 4-1 Sample Layout for Payables Invoice Register"





Note the following:

	
The data fields that are defined on the template.

For example: Supplier, Invoice Number, and Invoice Date


	
The elements of the template that are repeated when the report is run.

For example, all the fields on the template are repeated for each Supplier that is reported. Each row of the invoice table is repeated for each invoice that is reported.






4.2.1 Using an XML Input File

Following is the XML file that is used as input to the Payables Invoice Register report template. To simplify the example, the XML output shown has been modified from the actual output from the Payables report.


<?xml version="1.0" encoding="WINDOWS-1252" ?>
 - <VENDOR_REPORT>
  - <LIST_G_VENDOR_NAME>
   - <G_VENDOR_NAME>
     <VENDOR_NAME>COMPANY A</VENDOR_NAME>
   -  <LIST_G_INVOICE_NUM>
    -  <G_INVOICE_NUM>
       <SET_OF_BOOKS_ID>124</SET_OF_BOOKS_ID>
       <GL_DATE>10-NOV-03</GL_DATE>
       <INV_TYPE>Standard</INV_TYPE>
       <INVOICE_NUM>031110</INVOICE_NUM>
       <INVOICE_DATE>10-NOV-03</INVOICE_DATE>
       <INVOICE_CURRENCY_CODE>EUR</INVOICE_CURRENCY_CODE>
       <ENT_AMT>122</ENT_AMT>
       <ACCTD_AMT>122</ACCTD_AMT>
       <VAT_CODE>VAT22%</VAT_CODE>
      </G_INVOICE_NUM>
     </LIST_G_INVOICE_NUM>
     <ENT_SUM_VENDOR>1000.00</ENT_SUM_VENDOR>
     <ACCTD_SUM_VENDOR>1000.00</ACCTD_SUM_VENDOR>  
    </G_VENDOR_NAME>
   </LIST_G_VENDOR_NAME>
  <ACCTD_SUM_REP>108763.68</ACCTD_SUM_REP>
  <ENT_SUM_REP>122039</ENT_SUM_REP>
 </VENDOR_REPORT> 


XML files are composed of elements. Each tag set is an element. For example <INVOICE_DATE> </INVOICE_DATE> is the invoice date element. "INVOICE_DATE" is the tag name. The data between the tags is the value of the element. For example, the value of INVOICE_DATE is "10-NOV-03".

The elements of the XML file have a hierarchical structure. Another way of saying this is that the elements have parent-child relationships. In the XML sample, some elements are contained within the tags of another element. The containing element is the parent and the included elements are its children.

Every XML file has only one root element that contains all the other elements. In this example, VENDOR_REPORT is the root element. The elements LIST_G_VENDOR_NAME, ACCTD_SUM_REP, and ENT_SUM_REP are contained between the VENDOR_REPORT tags and are children of VENDOR_REPORT. Each child element can have child elements of its own.






4.2.2 Identifying Placeholders and Groups

The template content and layout must correspond to the content and hierarchy of the input XML file. Each data field in the template must map to an element in the XML file. Each group of repeating elements in the template must correspond to a parent-child relationship in the XML file.

To map the data fields you define placeholders. To designate the repeating elements, you define groups.




	
Note:

BI Publisher supports regrouping of data if the report requires grouping that does not follow the hierarchy of the incoming XML data. For information on using this feature, see Section 4.12.3, "Regrouping the XML Data."














4.2.3 Using Placeholders

Each data field in the report template must correspond to an element in the XML file. When you mark up the template design, you define placeholders for the XML elements. The placeholder maps the template report field to the XML element. At runtime the placeholder is replaced by the value of the element of the same name in the XML data file.

For example, the "Supplier" field from the sample report layout corresponds to the XML element VENDOR_NAME. When you mark up the template, you create a placeholder for VENDOR_NAME in the position of the Supplier field. At runtime, this placeholder is replaced by the value of the element from the XML file (the value in the sample file is COMPANY A).






4.2.4 Identifying the Groups of Repeating Elements

The sample report lists suppliers and their invoices. There are fields that repeat for each supplier. One of these fields is the supplier's invoices. There are fields that repeat for each invoice. The report therefore consists of two groups of repeating fields:

	
Fields that repeat for each supplier


	
Fields that repeat for each invoice




The invoices group is nested inside the suppliers group. This can be represented as follows:

Suppliers

	
Supplier Name


	
Invoices

	
Invoice Num


	
Invoice Date


	
GL Date


	
Currency


	
Entered Amount


	
Accounted Amount





	
Total Entered Amount


	
Total Accounted Amount




Compare this structure to the hierarchy of the XML input file. The fields that belong to the Suppliers group shown above are children of the element G_VENDOR_NAME. The fields that belong to the Invoices group are children of the element G_INVOICE_NUM.

By defining a group, you are notifying BI Publisher that for each occurrence of an element (parent), you want the included fields (children) displayed. At runtime, BI Publisher loops through the occurrences of the element and displays the fields each time.








4.3 Adding Markup to the Template Layout

BI Publisher converts the formatting that you apply in the word processor to XSL-FO. You add markup to create the mapping between the layout and the XML file and to include features that cannot be represented directly in the format.

The most basic markup elements are placeholders, to define the XML data elements; and groups, to define the repeating elements.

BI Publisher provides tags to add markup to the template. For the XSL equivalents of the BI Publisher tags, see Section B.2, "XSL Equivalents."



4.3.1 Creating Placeholders

The placeholder maps the template field to the XML element data field. At runtime the placeholder is replaced by the value of the element of the same name in the XML data file.

Enter placeholders in the document using the following syntax:

<?XML element tag name?>

The placeholder must match the XML element tag name exactly. It is case sensitive.

There are two ways to insert placeholders in the document, as described in the following sections:

	
Section 4.3.1.1, "Using the Basic RTF Method": Insert the placeholder syntax directly into the template document.


	
Section 4.3.1.2, "Using the Form Field Method": (Requires Microsoft Word) Insert the placeholder syntax in Microsoft Word's Text Form Field Options window. This method allows you to maintain the appearance of the template.

For more information, see Section 5.4.1, "Inserting a Field."






4.3.1.1 Using the Basic RTF Method

Enter the placeholder syntax in the document where you want the XML data value to appear.

Enter the element's XML tag name using the syntax:

<?XML element tag name?>

In the example, the template field "Supplier" maps to the XML element VENDOR_NAME. In the document, enter:

<?VENDOR_NAME?>

The entry in the template is shown in Figure 4-2.


Figure 4-2 Template Entry

[image: Description of Figure 4-2 follows]

Description of "Figure 4-2 Template Entry"









4.3.1.2 Using the Form Field Method

To use Microsoft Word's Form Field method to insert the placeholder tags:

	
Enable the Forms toolbar in the Microsoft Word application.


	
Position the cursor in the location where you want to create a placeholder.


	
Select the Text Form Field toolbar icon. This action inserts a form field area in the document.


	
Double-click the form field area to invoke the Text Form Field Options dialog box.


	
(Optional) Enter a description of the field in the Default text field. The entry in this field populates the placeholder's position on the template.

For the example, enter "Supplier 1".


	
Select the Add Help Text button.


	
In the help text entry field, enter the XML element's tag name using the syntax:

<?XML element tag name?>

You can enter multiple element tag names in the text entry field.

In the example, the report field "Supplier" maps to the XML element VENDOR_NAME. In the Form Field Help Text field enter:

<?VENDOR_NAME?>

Figure 4-3 shows the Text Form Field Options dialog and the Form Field Help Text dialog with the appropriate entries for the Supplier field.


Figure 4-3 Dialogs for Supplier Field

[image: Description of Figure 4-3 follows]

Description of "Figure 4-3 Dialogs for Supplier Field"








	
Tip:

For longer strings of BI Publisher syntax, use the Help Key (F1) tab instead of the Status Bar tab. The text entry field on the Help Key (F1) tab allows more characters.










	
Click OK to apply.

The Default text is displayed in the form field on the template.

Figure 4-4 shows the Supplier field from the template with the added form field markup.


Figure 4-4 Supplier Field with Added Markup

[image: Description of Figure 4-4 follows]

Description of "Figure 4-4 Supplier Field with Added Markup"












4.3.1.3 Completing the Example

Table 4-1 shows the entries made to complete the example. The Template Field Name is the display name from the template. The Default Text Entry is the value entered in the Default Text field of the Text Form Field Options dialog box (form field method only). The Placeholder Entry is the XML element tag name entered either in the Form Field Help Text field (form field method) or directly on the template.


Table 4-1 Entries to Complete the Example

	Template Field Name	Default Text Entry (Form Field Method)	Placeholder Entry (XML Tag Name)
	
Invoice Num

	
1234566

	
<?INVOICE_NUM?>


	
Invoice Date

	
1-Jan-2004

	
<?INVOICE_DATE?>


	
GL Date

	
1-Jan-2004

	
<?GL_DATE?>


	
Curr

	
USD

	
<?INVOICE_CURRENCY_CODE?>


	
Entered Amt

	
1000.00

	
<?ENT_AMT?>


	
Accounted Amt

	
1000.00

	
<?ACCTD_AMT?>


	
(Total of Entered Amt column)

	
1000.00

	
<?ENT_SUM_VENDOR?>


	
(Total of Accounted Amt column)

	
1000.00

	
<?ACCTD_SUM_VENDOR?>








Figure 4-5 shows the Payables Invoice Register with the completed form field placeholder markup. See Figure 4-6 for the completed basic RTF markup.


Figure 4-5 Payables Invoice Register with Form Field Markup

[image: Description of Figure 4-5 follows]

Description of "Figure 4-5 Payables Invoice Register with Form Field Markup"













4.4 Defining Groups

By defining a group, you notify BI Publisher that for each occurrence of an element, you want the included fields displayed. At runtime, BI Publisher loops through the occurrences of the element and displays the fields each time.

In the example, for each occurrence of G_VENDOR_NAME in the XML file, you want the template to display its child elements VENDOR_NAME (Supplier Name), G_INVOICE_NUM (the Invoices group), Total Entered Amount, and Total Accounted Amount. And, for each occurrence of G_INVOICE_NUM (Invoices group), you want the template to display Invoice Number, Invoice Date, GL Date, Currency, Entered Amount, and Accounted Amount.

To designate a group of repeating fields, insert the grouping tags around the elements to repeat.

Insert the following tag before the first element:

<?for-each:XML group element tag name?>

Insert the following tag after the final element:

<?end for-each?>




	
Note:

For more information, see Section 5.4.6, "Inserting a Repeating Group."











4.4.1 Grouping Scenarios

When grouping, note that the group element must be a parent of the repeating elements in the XML input file.

	
If you insert the grouping tags around text or formatting elements, then the text and formatting elements between the group tags are repeated.


	
If you insert the tags around a table, then the table is repeated.


	
If you insert the tags around text in a table cell, then the text in the table cell between the tags is repeated.


	
If you insert the tags around two different table cells, but in the same table row, then the single row is repeated.


	
If you insert the tags around two different table rows, then the rows between the tags are repeated (this does not include the row that contains the "end group" tag).









4.4.2 Using the Basic RTF Method

Enter the tags in the document to define the beginning and end of the repeating element group.

To create the Suppliers group in the example, insert the tag

<?for-each:G_VENDOR_NAME?>

before the Supplier field that you previously created.

Insert <?end for-each?> in the document after the summary row.

Figure 4-6 shows the Payables Invoice Register with the basic RTF grouping and placeholder markup.


Figure 4-6 Payables Invoice Register with Basic RTF Grouping Markup

[image: Description of Figure 4-6 follows]

Description of "Figure 4-6 Payables Invoice Register with Basic RTF Grouping Markup"









4.4.3 Using the Form Field Method

To use Microsoft Word's Form Field method to defining a group:

	
Insert a form field to designate the beginning of the group.

In the help text field enter:

<?for-each:group element tag name?>

To create the Suppliers group in the example, insert a form field before the Suppliers field that you previously created. In the help text field enter:

<?for-each:G_VENDOR_NAME?>

For the example, enter the Default text "Group: Suppliers" to designate the beginning of the group on the template. The Default text is not required, but can make the template easier to read.


	
Insert a form field after the final placeholder element in the group. In the help text field enter <?end for-each?>.

For the example, enter the Default text "End: Suppliers" after the summary row to designate the end of the group on the template.

Figure 4-7 shows the template after the markup to designate the Suppliers group was added.





Figure 4-7 Template with Suppliers Group Added

[image: Description of Figure 4-7 follows]

Description of "Figure 4-7 Template with Suppliers Group Added"









4.4.4 Completing the Example

The second group in the example is the invoices group. The repeating elements in this group are displayed in the table. For each invoice, the table row should repeat. Create a group within the table to contain these elements.




	
Note:

For each invoice, only the table row should repeat, not the entire table. Placing the grouping tags at the beginning and end of the table row repeats only the row. If you place the tags around the table, then for each new invoice the entire table with headings is repeated.









To mark up the example, insert the grouping tag <?for-each:G_INVOICE_NUM?> in the table cell before the Invoice Num placeholder. Enter the Default text "Group:Invoices" to designate the beginning of the group.

Insert the end tag inside the final table cell of the row after the Accounted Amt placeholder. Enter the Default text "End:Invoices" to designate the end of the group.

Figure 4-8 shows the completed example using the form field method.


Figure 4-8 Payables Invoice Register with Groups

[image: Description of Figure 4-8 follows]

Description of "Figure 4-8 Payables Invoice Register with Groups"











4.5 Defining Headers and Footers

You can define headers and footers as part of the template. This section covers the following topics:

	
Section 4.5.1, "Native Support for Headers and Footers"


	
Section 4.5.2, "Inserting Placeholders in the Headers and Footers"


	
Section 4.5.3, "Creating Multiple or Complex Headers and Footers"


	
Section 4.5.4, "Defining Different First Page and Different Odd and Even Pages"






4.5.1 Native Support for Headers and Footers

BI Publisher supports the use of the native RTF header and footer feature. To create a header or footer, use the word processor's header and footer insertion tools. As an alternative, or if you have multiple headers and footers, you can use start:body and end body tags to distinguish the header and footer regions from the body of the report.






4.5.2 Inserting Placeholders in the Headers and Footers

At the time of this writing, Microsoft Word does not support form fields in the header and footer. You must therefore insert the placeholder syntax directly into the template (basic RTF method), or use the start body/end body syntax described in the next section.






4.5.3 Creating Multiple or Complex Headers and Footers

If the template requires multiple headers and footers, then create them by using BI Publisher tags to define the body area of the report. You may also want to use this method if the header and footer contain complex objects that you want to place in form fields. When you define the body area, the elements occurring before the beginning of the body area compose the header. The elements occurring after the body area compose the footer.

Use the following tags to enclose the body area of the report:

<?start:body?>

<?end body?>

Use the tags either directly in the template, or in form fields.

The Payables Invoice Register contains a simple header and footer and therefore does not require the start body/end body tags. However, if you wanted to add another header to the template, define the body area.

To define the body area:

	
Insert <?start:body?> before the Suppliers group tag:

<?for-each:G_VENDOR_NAME?>


	
Insert <?end body?> after the Suppliers group closing tag:

<?end for-each?>




Figure 4-9 shows the Payables Invoice Register with the start body/end body tags inserted.


Figure 4-9 Payables Invoice Register with Body Tags

[image: Description of Figure 4-9 follows]

Description of "Figure 4-9 Payables Invoice Register with Body Tags"









4.5.4 Defining Different First Page and Different Odd and Even Pages

If the report requires a different header and footer on the first page of the report; or, if the report requires different headers and footers for odd and even pages, then you can define this behavior using Microsoft Word's Page Setup dialog.




	
Note:

This feature is supported for PDF and RTF output only.









To define different page setups:

	
Select Page Setup from the File menu.


	
In the Page Setup dialog, select the Layout tab.


	
In the Headers and footers region of the dialog, select the appropriate check box:

Different odd and even

Different first page


	
Insert the headers and footers into the template as desired.




At runtime the generated report exhibits the defined header and footer behavior.








4.6 Inserting Images and Charts

BI Publisher supports several methods for including images in the published document, as described in the following sections:

	
Section 4.6.1, "Directly Inserting Images"


	
Section 4.6.2, "Inserting Images with URL References"


	
Section 4.6.3, "Inserting Images with an Element Reference from an XML File"


	
Section 4.6.4, "Rendering an Image Retrieved from BLOB Data"


	
Section 4.6.5, "Adding Charts to Templates"






4.6.1 Directly Inserting Images

Insert the jpg, gif, or png image directly in the template.






4.6.2 Inserting Images with URL References

To insert images with URL references:

	
Insert a dummy image in the template.


	
In Microsoft Word's Format Picture dialog box select the Web tab. Enter the following syntax in the Alternative text region to reference the image URL:

url:{'http://<image location>'}

For example, enter:

url:{'http://www.example.com/images/ora_log.gif'}









4.6.3 Inserting Images with an Element Reference from an XML File

To insert images with element references:

	
Insert a dummy image in the template.


	
In Microsoft Word's Format Picture dialog box select the Web tab. Enter the following syntax in the Alternative text region to reference the image URL:

url:{IMAGE_LOCATION}

where IMAGE_LOCATION is an element from the XML file that holds the full URL to the image.

You can also build a URL based on multiple elements at runtime. Just use the concat function to build the URL string. For example:

url:{concat(SERVER,'/',IMAGE_DIR,'/',IMAGE_FILE)}

where SERVER, IMAGE_DIR, and IMAGE_FILE are element names from the XML file that hold the values to construct the URL.

This method can also be used with the OA_MEDIA reference as follows:

url:{concat('${OA_MEDIA}','/',IMAGE_FILE)}









4.6.4 Rendering an Image Retrieved from BLOB Data

If results XML contains image data that had been stored as a BLOB in the database, then use the following syntax in a form field inserted in the template where you want the image to render at runtime:


<fo:instream-foreign-object content-type="image/jpg">
<xsl:value-of select="IMAGE_ELEMENT"/>
</fo:instream-foreign-object>


where

image/jpg is the MIME type of the image (other options might be: image/gif and image/png)

and

IMAGE_ELEMENT is the element name of the BLOB in the XML data.

Note that you can specify height and width attributes for the image to set its size in the published report. BI Publisher scales the image to fit the box size that you define. For example, to set the size of the example above to three inches by four inches, enter the following:


<fo:instream-foreign-object content-type="image/jpg" height="3 in" width="4 in">
<xsl:value-of select="IMAGE_ELEMENT"/>
</fo:instream-foreign-object>


Specify in pixels as follows:


<fo:instream-foreign-object content-type="image/jpg" height="300 px" width="4 px">
...


or in centimeters:


<fo:instream-foreign-object content-type="image/jpg" height="3 cm" width="4 cm">
...


or as a percentage of the original dimensions:


<fo:instream-foreign-object content-type="image/jpg" height="300%" width="300%">
...






4.6.5 Adding Charts to Templates

The following list summarizes the steps to add a chart to the template. These steps are discussed in detail in this section through the use of an example.

	
Insert a dummy image in the template to define the size and position of the chart.


	
Add the definition for the chart to the Alternative text box of the dummy image. The chart definition requires XSL commands.


	
At runtime BI Publisher calls the charting engine to render the image that is then inserted into the final output document.




Note that RTF output is limited to raster images. PDF and HTML output support raster and vector images.




	
Note:

For more information, see Section 5.4.4, "Inserting a Chart."











4.6.5.1 Adding a Sample Chart

Following is a piece of XML data showing total sales by company division.


<sales year=2004>
 <division>
  <name>Groceries</name>
  <totalsales>3810</totalsales>
  <costofsales>2100</costofsales>
 </division>
 <division>
  <name>Toys</name>
  <totalsales>2432</totalsales>
  <costofsales>1200</costofsales>
 </division>
 <division>
  <name>Cars</name>
  <totalsales>6753</totalsales>
  <costofsales>4100</costofsales>
 </division>
 <division>
  <name>Hardware</name>
  <totalsales>2543</totalsales>
  <costofsales>1400</costofsales>
 </division>
 <division>
  <name>Electronics</name>
  <totalsales>5965</totalsales>
  <costofsales>3560</costofsales>
 </division>
</sales>


This example describes how to insert a chart into the template to display it as a vertical bar chart, as shown in Figure 4-10.


Figure 4-10 Bar Chart of Sales Data

[image: Description of Figure 4-10 follows]

Description of "Figure 4-10 Bar Chart of Sales Data"





Note the following attributes of this chart:

	
The style is a vertical bar chart.


	
The chart displays a background grid.


	
The components are colored.


	
Sales totals are shown as Y-axis labels.


	
Divisions are shown as X-axis labels.


	
The chart is titled.


	
The chart displays a legend.




Each of these properties can be customized to suit individual report requirements.






4.6.5.2 Inserting the Dummy Image

The first step is to add a dummy image to the template in the position you want the chart to appear. The image size defines how large the chart image is in the final document.




	
Note:

You must insert the dummy image as a "Picture" and not any other kind of object.









Figure 4-11 shows an example of a dummy image.


Figure 4-11 Sample Dummy Image

[image: Description of Figure 4-11 follows]

Description of "Figure 4-11 Sample Dummy Image"





The image can be embedded inside a for-each loop like any other form field if you want the chart to be repeated in the output based on the repeating data. In this example, the chart is defined within the sales year group so that a chart is generated for each year of data present in the XML file.

Right-click the image to open the Format Picture palette and select the Web tab. Use the Alternative text entry box to enter the code to define the chart characteristics and data definition for the chart.






4.6.5.3 Adding Code to the Alternative Text Box

Figure 4-12 shows an example of the BI Publisher code in the Format Picture Alternative text box.


Figure 4-12 Alternate Text Box

[image: Description of Figure 4-12 follows]

Description of "Figure 4-12 Alternate Text Box"





The content of the Alternative text represents the chart that is rendered in the final document. For this chart, the text is as follows:


chart:
<Graph graphType = "BAR_VERT_CLUST">
 <Title text="Company Sales 2004" visible="true" horizontalAlignment="CENTER"/>
 <Y1Title text="Sales in Thousands" visible="true"/>
 <O1Title text="Division" visible="true"/>
 <LocalGridData colCount="{count(//division)}" rowCount="1">
  <RowLabels>
   <Label>Total Sales $1000s</Label>
  </RowLabels>
  <ColLabels>
   <xsl:for-each select="//division">
    <Label>
      <xsl:value-of select="name"/>
    </Label>
   </xsl:for-each>
  </ColLabels>
  <DataValues>
   <RowData>
    <xsl:for-each select="//division">
      <Cell>
       <xsl:value-of select="totalsales"/>
     </Cell>
    </xsl:for-each>
   </RowData>
  </DataValues>
 </LocalGridData>
</Graph>


The first element of the chart text must be the chart: element to inform the RTF parser that the following code describes a chart object.

Next is the opening <Graph> tag. Note that the whole of the code resides within the tags of the <Graph> element. This element has an attribute to define the chart type: graphType. If this attribute is not declared, the default chart is a vertical bar chart. BI Beans supports many different chart types. Several more types are presented in this section. For a complete listing, see the BI Beans graph DTD documentation.

The following code section defines the chart type and attributes:


<Title text="Company Sales 2004" visible="true" horizontalAlignment="CENTER"/>
 <Y1Title text="Sales in Thousands" visible="true"/>
 <O1Title text="Division" visible="true"/>
 


All of these values can be declared or you can substitute values from the XML data at runtime. For example, you can retrieve the chart title from an XML tag by using the following syntax:


<Title text="{CHARTTITLE}" visible="true" horizontalAlighment="CENTER"/>


where "CHARTTITLE" is the XML tag name that contains the chart title. Note that the tag name is enclosed in curly braces.

The next section defines the column and row labels:


<LocalGridData colCount="{count(//division)}" rowCount="1">
  <RowLabels>
   <Label>Total Sales $1000s</Label>
  </RowLabels>
  <ColLabels>
   <xsl:for-each select="//division">
    <Label>
      <xsl:value-of select="name"/>
    </Label>
   </xsl:for-each>
  </ColLabels>



The LocalGridData element has two attributes: colCount and rowCount. These define the number of columns and rows that are shown at runtime. In this example, a count function calculates the number of columns to render:


colCount="{count(//division)}"


The rowCount has been hard-coded to 1. This value defines the number of sets of data to be charted. In this case it is 1.

Next the code defines the row and column labels. These can be declared, or a value from the XML data can be substituted at runtime. The row label is used in the chart legend (that is, "Total Sales $1000s").

The column labels for this example are derived from the data: Groceries, Toys, Cars, and so on. This is done using a for-each loop:


<ColLabels>
   <xsl:for-each select="//division">
    <Label>
      <xsl:value-of select="name"/>
    </Label>
   </xsl:for-each>
  </ColLabels>



This code loops through the <division> group and inserts the value of the <name> element into the <Label> tag. At runtime, this code generates the following XML:


<ColLabels>
  <Label>Groceries</Label>
  <Label>Toys</Label>
  <Label>Cars</Label>
  <Label>Hardware</Label>
  <Label>Electronics</Label>
</ColLabels>



The next section defines the actual data values to chart:


<DataValues>
   <RowData>
    <xsl:for-each select="//division">
      <Cell>
       <xsl:value-of select="totalsales"/>
     </Cell>
    </xsl:for-each>
   </RowData>
  </DataValues>



Similar to the labels section, the code loops through the data to build the XML that is passed to the BI Beans rendering engine. This code generates the following XML:


<DataValues>
  <RowData>
    <Cell>3810</Cell>
    <Cell>2432</Cell>
    <Cell>6753</Cell>
    <Cell>2543</Cell>
    <Cell>5965</Cell>
  </RowData>
</DataValues>







4.6.5.4 Additional Chart Samples

You can also display this data in a pie chart as shown in Figure 4-13.


Figure 4-13 Sample Pie Chart

[image: Description of Figure 4-13 follows]

Description of "Figure 4-13 Sample Pie Chart"





The following is the code added to the template to render this chart at runtime:


chart:
<Graph graphType="PIE">
 <Title text="Company Sales 2004" visible="true"    
   horizontalAlignment="CENTER"/>
 <LocalGridData rowCount="{count(//division)}" colCount="1">
  <RowLabels>
  <xsl:for-each select="//division">     
  <Label>
   <xsl:value-of select="name"/>
  </Label>
  </xsl:for-each>
  </RowLabels>
  <DataValues>
   <xsl:for-each select="//division">
    <RowData>
      <Cell>
       <xsl:value-of select="totalsales"/>
      </Cell>
    </RowData>
   </xsl:for-each>
  </DataValues>
 </LocalGridData>
</Graph>






4.6.5.5 Horizontal Bar Chart Sample

The following example shows total sales and cost of sales charted in a horizontal bar format. This example also adds the data from the cost of sales element (<costofsales>) to the chart, as shown in Figure 4-14.


Figure 4-14 Sample Horizontal Bar Chart

[image: Description of Figure 4-14 follows]

Description of "Figure 4-14 Sample Horizontal Bar Chart"





The following code defines this chart in the template:


chart:
<Graph graphType = "BAR_HORIZ_CLUST">
 <Title text="Company Sales 2004" visible="true" horizontalAlignment="CENTER"/>
 <LocalGridData colCount="{count(//division)}" rowCount="2">
 <RowLabels>
  <Label>Total Sales ('000s)</Label>
  <Label>Cost of Sales ('000s)</Label>
 </RowLabels>
 <ColLabels>
  <xsl:for-each select="//division">
   <Label><xsl:value-of select="name"/></Label>
  </xsl:for-each>
 </ColLabels>
 <DataValues>
  <RowData>
   <xsl:for-each select="//division">
     <Cell><xsl:value-of select="totalsales"/></Cell>
   </xsl:for-each>
  </RowData>
  <RowData>
   <xsl:for-each select="//division">
    <Cell><xsl:value-of select="costofsales"/></Cell>
    </xsl:for-each>
  </RowData>
  </DataValues>
 </LocalGridData>
</Graph>


To accommodate the second set of data, the rowCount attribute for the LocalGridData element is set to 2. Also note the DataValues section defines two sets of data: one for Total Sales and one for Cost of Sales.






4.6.5.6 Changing the Appearance of the Chart

There are many attributes available from the BI Beans graph DTD that you can manipulate to change the look and feel of the chart. For example, the previous chart can be changed to remove the grid, place a graduated background, and change the bar colors and fonts, as shown in Figure 4-15.


Figure 4-15 Changed Bar Chart

[image: Description of Figure 4-15 follows]

Description of "Figure 4-15 Changed Bar Chart"





The code to support this is as follows:


chart:
<Graph graphType = "BAR_HORIZ_CLUST">
<SeriesItems>
 <Series id="0" color="#ffcc00"/>
 <Series id="1" color="#ff6600"/>
</SeriesItems> 
<O1MajorTick visible="false"/>
<X1MajorTick visible="false"/>
<Y1MajorTick visible="false"/>
<Y2MajorTick visible="false"/>
<MarkerText visible="true" markerTextPlace="MTP_CENTER"/>
<PlotArea borderTransparent="true">
 <SFX fillType="FT_GRADIENT" gradientDirection="GD_LEFT" 
 gradientNumPins="300">
 <GradientPinStyle pinIndex="1" position="1" 
  gradientPinLeftColor="#999999" 
  gradientPinRightColor="#cc6600"/>
 </SFX>
</PlotArea>
<Title text="Company Sales 2004" visible="true">
 <GraphFont name="Tahoma" bold="false"/>
</Title>
. . . 
</Graph>


The colors for the bars are defined in the SeriesItems section. The colors are defined in hexadecimal format as follows:


<SeriesItems>  
  <Series id="0" color="#ffcc00"/>  
  <Series id="1" color="#ff6600"/> 
</SeriesItems>  


The following code hides the chart grid:


<O1MajorTick visible="false"/> 
  <X1MajorTick visible="false"/> 
  <Y1MajorTick visible="false"/> 
  <Y2MajorTick visible="false"/>


The MarkerText tag places the data values on the chart bars:


<MarkerText visible="true" markerTextPlace="MTP_CENTER"/> 


The PlotArea section defines the background. The SFX element establishes the gradient and the borderTransparent attribute hides the plot border:


<PlotArea borderTransparent="true">  
  <SFX fillType="FT_GRADIENT" gradientDirection="GD_LEFT"   
     gradientNumPins="300">  
     <GradientPinStyle pinIndex="1" position="1"    
       gradientPinLeftColor="#999999"    
       gradientPinRightColor="#cc6600"/>  
   </SFX> 
</PlotArea>


The Title text tag has also been updated to specify a new font type and size:


<Title text="Company Sales 2004" visible="true">  
  <GraphFont name="Tahoma" bold="false"/> 
</Title>










4.7 Adding Drawings, Shapes, and Clip Art

BI Publisher supports Microsoft Word drawing, shape, and clip art features. You can add these objects to the template and they are rendered in the final PDF output or HTML output (not supported for other output types).

The following AutoShape categories are supported:

	
Lines - Straight, arrows, connectors, curve, free form, and scribble


	
Connectors - Straight connectors only are supported. Curved connectors can be achieved by using a curved line and specifying the end styles to the line.


	
Basic Shapes - All shapes are supported.


	
Block arrows - All arrows are supported.


	
Flowchart - All flowchart objects are supported.


	
Stars and Banners - All objects are supported.


	
Callouts - The "line" callouts are not supported.


	
Clip Art - Add images to the templates using the Microsoft Clip Art libraries






4.7.1 Adding Freehand Drawings

Use the freehand drawing tool in Microsoft Word to create drawings in the template to be rendered in the final PDF output.






4.7.2 Adding Hyperlinks

You can add hyperlinks to shapes. See Section 4.9.5, "Inserting Hyperlinks."






4.7.3 Layering Shapes

You can layer shapes on top of each other and use the transparency setting in Microsoft Word to allows shapes on lower layers to show through. Figure 4-16 shows an example of layered shapes.


Figure 4-16 Layered Shapes

[image: Description of Figure 4-16 follows]

Description of "Figure 4-16 Layered Shapes"









4.7.4 Using 3-D Effects

BI Publisher does not currently support the 3-D option for shapes.






4.7.5 Adding Microsoft Equations

Use the equation editor to generate equations in the output. Figure 4-17 shows an example of an equation.


Figure 4-17 Sample Equation

[image: Description of Figure 4-17 follows]

Description of "Figure 4-17 Sample Equation"









4.7.6 Adding Organization Charts

Use the organization chart functionality in the templates and the chart that is rendered in the output. Figure 4-18 shows an example of an organization chart.


Figure 4-18 Sample Organization Chart

[image: Description of Figure 4-18 follows]

Description of "Figure 4-18 Sample Organization Chart"









4.7.7 Adding WordArt

You can use Microsoft Word's WordArt functionality in the templates. Figure 4-19 shows a WordArt example.


Figure 4-19 Sample WordArt Example

[image: Description of Figure 4-19 follows]

Description of "Figure 4-19 Sample WordArt Example"








	
Note:

Some Microsoft WordArt uses a bitmap operation that currently cannot be converted to SVG. To use the unsupported WordArt in the template, you can take a screenshot of the WordArt then save it as an image (gif, jpeg, or png) and replace the WordArt with the image.














4.7.8 Adding Data-Driven Shapes

In addition to supporting the static shapes and features in the templates, BI Publisher supports the manipulation of shapes based on incoming data or parameters, as well. The following manipulations are supported:

	
Replicate


	
Move


	
Change size


	
Add text


	
Skew


	
Rotate




These manipulations not only apply to single shapes, but you can use the group feature in Microsoft Word to combine shapes together and manipulate them as a group.






4.7.9 Including Manipulation Commands

Enter manipulation commands for a shape in the Web tab of the shape's properties dialog as shown in Figure 4-20.


Figure 4-20 Format AutoShape Dialog

[image: Description of Figure 4-20 follows]

Description of "Figure 4-20 Format AutoShape Dialog"









4.7.10 Replicating Shapes

You can replicate a shape based on incoming XML data in the same way you replicate data elements in a for-each loop. To do this, use a for-each@shape command in conjunction with a shape-offset declaration. For example, to replicate a shape down the page, use the following syntax:


<?for-each@shape:SHAPE_GROUP?>
 <?shape-offset-y:(position()-1)*100?>
<?end for-each?>


where

for-each@shape opens the for-each loop for the shape context

SHAPE_GROUP is the name of the repeating element from the XML file. For each occurrence of the element SHAPE_GROUP a new shape is created.

shape-offset-y: is the command to offset the shape along the y-axis.

(position()-1)*100) sets the offset in pixels per occurrence. The XSL position command returns the record counter in the group (that is 1,2,3,4); one is subtracted from that number and the result is multiplied by 100. Therefore for the first occurrence the offset would be 0: (1-1) * 100. The offset for the second occurrence would be 100 pixels: (2-1) *100. And for each subsequent occurrence the offset would be another 100 pixels down the page.






4.7.11 Adding Text to Shapes

You can add text to a shape dynamically either from the incoming XML data or from a parameter value. In the property dialog enter the following syntax:


<?shape-text:SHAPETEXT?>


where SHAPETEXT is the element name in the XML data. At runtime the text is inserted into the shape.






4.7.12 Adding Text Along a Path

You can add text along a line or curve from incoming XML data or a parameter. After drawing the line, in the property dialog enter:


<?shape-text-along-path:SHAPETEXT?>


where SHAPETEXT is the element from the XML data. At runtime the value of the element SHAPETEXT is inserted above and along the line.






4.7.13 Moving a Shape

You can move a shape or transpose it along both the x and y-axes based on the XML data. For example to move a shape 200 pixels along the y-axis and 300 along the x-axis, enter the following commands in the property dialog of the shape:


<?shape-offset-x:300?>
<?shape-offset-y:200?>






4.7.14 Rotating a Shape

To rotate a shape about a specified axis based on the incoming data, use the following command:


<?shape-rotate:ANGLE;'POSITION'?>


where

ANGLE is the number of degrees to rotate the shape. If the angle is positive, the rotation is clockwise; if negative, the rotation is counterclockwise.

POSITION is the point about which to carry out the rotation, for example, 'left/top'. Valid values are combinations of left, right, or center with center, top, or bottom. The default is left/top. Figure 4-21 shows these valid values.


Figure 4-21 Shape Rotation Values

[image: Description of Figure 4-21 follows]

Description of "Figure 4-21 Shape Rotation Values"





To rotate this rectangle shape about the bottom right corner, enter the following syntax:


<?shape-rotate:60,'right/bottom'?>


You can also specify an x,y coordinate within the shape itself about which to rotate.






4.7.15 Skewing a Shape

You can skew a shape along its x or y axis using the following commands:


<?shape-skew-x:ANGLE;'POSITION'?>
<?shape-skew-y:ANGLE;'POSITION'?>


where

ANGLE is the number of degrees to skew the shape. If the angle is positive, the skew is to the right.

POSITION is the point about which to carry out the rotation, for example, 'left/top'. Valid values are combinations of left, right, or center with center, top, or bottom. See Figure 4-21. The default is 'left/top'.

For example, to skew a shape by 30 degrees about the bottom right hand corner, enter the following:


<?shape-skew-x:number(.)*30;'right/bottom'?>






4.7.16 Changing the Size of Shapes

You can change the size of a shape using the appropriate commands either along a single axis or both axes. To change a shape's size along both axes, use:


<?shape-size:RATIO?>


where RATIO is the numeric ratio to increase or decrease the size of the shape. Therefore a value of 2 would generate a shape twice the height and width of the original. A value of 0.5 would generate a shape half the size of the original.

To change a shape's size along the x or y axis, use:


<?shape-size-x:RATIO?>
<?shape-size-y:RATIO?>


Changing only the x or y value has the effect of stretching or shrinking the shape along an axis. This can be data driven.






4.7.17 Combining Commands

You can also combine these commands to carry out multiple transformations on a shape at one time. For example, you can replicate a shape and for each replication, rotate it by some angle and change the size at the same time.

The following example shows how to replicate a shape, move it 50 pixels down the page, rotate it by five degrees about the center, stretch it along the x-axis and add the number of the shape as text:


<for-each@shape:SHAPE_GROUP?>
 <?shape-text:position()?>
 <?shape-offset-y:position()*50?>
 <?shape-rotate:5;'center/center'?>
 <?shape-size-x:position()+1?>
<end for-each?>


These commands generate the output shown in Figure 4-22.


Figure 4-22 Shape Transformation

[image: Description of Figure 4-22 follows]

Description of "Figure 4-22 Shape Transformation"









4.7.18 CD Ratings Example

This example demonstrates how to set up a template that generates a star-rating based on data from an incoming XML file.

Assume the following incoming XML data:


<CATALOG>
 <CD>
  <TITLE>Empire Burlesque</TITLE>
  <ARTIST>Bob Dylan</ARTIST>
  <COUNTRY>USA</COUNTRY>
  <COMPANY>Columbia</COMPANY>
  <PRICE>10.90</PRICE>
  <YEAR>1985</YEAR>
  <USER_RATING>4</USER_RATING>
 </CD>
 <CD>
  <TITLE>Hide Your Heart</TITLE>
  <ARTIST>Bonnie Tylor</ARTIST>
  <COUNTRY>UK</COUNTRY>
  <COMPANY>CBS Records</COMPANY>
  <PRICE>9.90</PRICE>
  <YEAR>1988</YEAR>
  <USER_RATING>3</USER_RATING>
 </CD>
 <CD>
  <TITLE>Still got the blues</TITLE>
  <ARTIST>Gary More</ARTIST>
  <COUNTRY>UK</COUNTRY>
  <COMPANY>Virgin Records</COMPANY>
  <PRICE>10.20</PRICE>
  <YEAR>1990</YEAR>
  <USER_RATING>5</USER_RATING>
 </CD>
 <CD>
  <TITLE>This is US</TITLE>
  <ARTIST>Gary Lee</ARTIST>
  <COUNTRY>UK</COUNTRY>
  <COMPANY>Virgin Records</COMPANY>
  <PRICE>12.20</PRICE>
  <YEAR>1990</YEAR>
  <USER_RATING>2</USER_RATING>
 </CD>
<CATALOG>


Notice there is a USER_RATING element for each CD. Using this data element and the shape manipulation commands, you can create a visual representation of the ratings so that the reader can compare them at a glance. A template to achieve this is shown in Figure 4-23.


Figure 4-23 Visual Representation of Ratings

[image: Description of Figure 4-23 follows]

Description of "Figure 4-23 Visual Representation of Ratings"





The values for the fields are shown in Table 4-2.


Table 4-2 Values for Fields

	Field	Form Field Entry
	
F

	
<?for-each:CD?>


	
TITLE

	
<?TITLE?>


	
ARTIST

	
<?ARTIST?>


	
E

	
<?end for-each?>


	
(star shape)

	
Web Tab Entry:

<?for-each@shape:xdoxslt:foreach_number($_XDOCTX,1,USER_RATING,1)?>

<?shape-offset-x:(position()-1)*25?>

<?end for-each?>








The form fields hold the simple element values. The only difference with this template is the value for the star shape. The replication command is placed in the Web tab of the Format AutoShape dialog.

In the for-each@shape command you can use a command to create a "for...next loop" construct. Specify 1 as the starting number; the value of USER_RATING as the final number; and 1 as the step value. As the template loops through the CDs, it creates an inner loop to repeat a star shape for every USER_RATING value (that is, a value of 4 generates 4 stars). The output from this template and the XML sample is shown in Figure 4-24.


Figure 4-24 Ratings Data from XML File

[image: Description of Figure 4-24 follows]

Description of "Figure 4-24 Ratings Data from XML File"









4.7.19 Grouped Shape Example

This example shows how to combine shapes into a group and have them react to the incoming data both individually and as a group. Assume the following XML data:


<SALES>
 <SALE>
  <REGION>Americas</REGION>
  <SOFTWARE>1200</SOFTWARE>
  <HARDWARE>850</HARDWARE>
  <SERVICES>2000</SERVICES>
 </SALE>
 <SALE>
  <REGION>EMEA</REGION>
  <SOFTWARE>1000</SOFTWARE>
  <HARDWARE>800</HARDWARE>
  <SERVICES>1100</SERVICES>
 </SALE>
 <SALE>
  <REGION>APAC</REGION>
  <SOFTWARE>900</SOFTWARE>
  <HARDWARE>1200</HARDWARE>
  <SERVICES>1500</SERVICES>
 </SALE>
</SALES>


You can create a visual representation of this data so that users can very quickly understand the sales data across all regions. Do this by first creating the composite shape in Microsoft Word that you want to manipulate. Figure 4-25 shows a composite shape comprised of four components.


Figure 4-25 Composite Shape

[image: Description of Figure 4-25 follows]

Description of "Figure 4-25 Composite Shape"





The shape consists of three cylinders: red, yellow, and blue. These represent the data elements software, hardware, and services. The combined object also contains a rectangle that is enabled to receive text from the incoming data.

The following commands are entered into the Web tab:

Red cylinder: <?shape-size-y:SOFTWARE div 1000;'left/bottom'?>

Yellow cylinder: <?shape-size-y:HARDWARE div 1000;'left/bottom'?>

Blue cylinder: <?shape-size-y:SERVICES div 1000;'left/bottom'?>

The shape-size command is used to stretch or shrink the cylinder based on the values of the elements SOFTWARE, HARDWARE, and SERVICES. The value is divided by 1000 to set the stretch or shrink factor. For example, if the value is 2000, divide that by 1000 to get a factor of 2. The shape generates as twice its current height.

The text-enabled rectangle contains the following command in its Web tab:


<?shape-text:REGION?>


At runtime the value of the REGION element is displayed in the rectangle.

All of these shapes were then grouped together and in the Web tab for the grouped object, the following syntax is added:


<?for-each@shape:SALE?>
<?shape-offset-x:(position()-1)*110?>
<?end for-each?>


In this set of commands, the for-each@shape loops over the SALE group. The shape-offset command moves the next shape in the loop to the right by a specific number of pixels. The expression (position()-1) sets the position of the object. The position() function returns a record counter while in the loop, so for the first shape, the offset would be 1-1*110, or 0, which would place the first rendering of the object in the position defined in the template. Subsequent occurrences would be rendered at a 110 pixel offset along the x-axis (to the right).

At runtime three sets of shapes are rendered across the page, as shown in Figure 4-26.


Figure 4-26 Rendering Sets of Composite Shapes

[image: Description of Figure 4-26 follows]

Description of "Figure 4-26 Rendering Sets of Composite Shapes"





To make an even more visually representative report, these shapes can be superimposed onto a world map. Just use the Order dialog in Microsoft Word to layer the map behind the grouped shapes.

	
Microsoft Word 2000 Users: After you add the background map and overlay the shape group, use the Grouping dialog to make the entire composition one group.


	
Microsoft Word 2002/3 Users: These versions of Word have an option under Tools > Options, General tab to "Automatically generate drawing canvas when inserting autoshapes". Using this option removes the need to do the final grouping of the map and shapes. You can now generate a visually appealing output for the report as seen in Figure 4-27.





Figure 4-27 Shapes on World Map

[image: Description of Figure 4-27 follows]

Description of "Figure 4-27 Shapes on World Map"











4.8 Supported Formatting Features of Microsoft Word

In addition to the features already listed, BI Publisher supports the features of Microsoft Word that are described in the following sections:

	
Section 4.8.1, "General Features of Microsoft Word"


	
Section 4.8.2, "Aligning Objects"


	
Section 4.8.3, "Inserting Tables"


	
Section 4.8.4, "Inserting Date Fields"


	
Section 4.8.5, "Inserting Multiple Columns on Pages"


	
Section 4.8.6, "Inserting Backgrounds and Watermarks"


	
Section 4.8.7, "Microsoft Word Features That Are Not Supported"






4.8.1 General Features of Microsoft Word

	
Large blocks of text


	
Page breaks

(Not supported for HTML output) To insert a page break, press Ctrl+Enter right before the closing tag of a group. For example if you want the template to start a new page for every Supplier in the Payables Invoice Register:

	
Place the cursor just before the Supplier group's closing <?end for-each?> tag.


	
Press Ctrl+Enter to insert a page break.




At runtime each Supplier starts on a new page.

Using this Microsoft Word native feature causes a single blank page to print at the end of the report output. To avoid this single blank page, use BI Publisher's page break alias. See Section 4.9.1, "Inserting Page Breaks."


	
Page numbering

Insert page numbers into the final report by using the page numbering methods of the word processor. For example, if you are using Microsoft Word:

	
From the Insert menu, select Page Numbers...


	
Select the Position, Alignment, and Format as desired.




At runtime the page numbers are displayed as selected.

Note that page numbering is not supported for HTML output and has limited support in RTF output. After the RTF report is generated, press F9 to reset the page numbers.


	
Hidden text

You can format text as "hidden" in Microsoft Word and the hidden text is maintained in RTF output reports.









4.8.2 Aligning Objects

Use the word processor's alignment features to align text, graphics, objects, and tables. Bidirectional languages are handled automatically using the word processor's left/right alignment controls.






4.8.3 Inserting Tables

The following Microsoft Word features are supported in BI Publisher:

	
Nested Tables


	
Cell Alignment

You can align any object in the template using the word processor's alignment tools. This alignment is reflected in the final report output.


	
Row spanning and column spanning

To span both columns and rows in the template:

	
Select the cells that you want to merge.


	
From the Table menu, select Merge Cells.


	
Align the data within the merged cell as you would normally.




At runtime the cells appear merged.


	
Table Autoformatting

BI Publisher recognizes the table autoformats available in Microsoft Word.

To autoformat tables:

	
Select the table that you want to format.


	
From the Table menu, select Autoformat.


	
Select the desired table format.




At runtime, the table is formatted using your selection.


	
Cell patterns and colors

To highlight cells or rows of a table with a pattern or color:

	
Select the cell(s) or table.


	
From the Table menu, select Table Properties.


	
From the Table tab, select the Borders and Shading... button.


	
Add borders and shading as desired.





	
Repeating table headers




	
Note:

This feature is not supported for RTF output.









If the data is displayed in a table and you expect the table to extend across multiple pages, then you can define the header rows that you want to repeat at the start of each page.

To repeat header rows:

	
Select the row(s) that you want to repeat on each page.


	
From the Table menu, select Heading Rows Repeat.





	
Prevent rows from breaking across pages.

If you want to ensure that data within a row of a table is kept together on a page, you can set this as an option using Microsoft Word's Table Properties.

To keep a row's contents together on one page:

	
Select the row(s) that you want to ensure do not break across a page.


	
From the Table menu, select Table Properties.


	
From the Row tab, deselect the check box "Allow row to break across pages".





	
Fixed-width columns

To set the widths of table columns:

	
Select a column and then select Table > Table Properties.


	
In the Table Properties dialog, select the Column tab.


	
Enable the Preferred width checkbox and then enter the width as a Percent or in Inches.


	
Select the Next Column button to set the width of the next column.




Note that the total width of the columns must add up to the total width of the table.


	
Text truncation

By default, if the text within a table cell does not fit within the cell, then the text is wrapped. To truncate the text instead, use the table properties dialog.

Note that table text truncation is supported for PDF and PPT outputs only.

To truncate the text within a table cell:

	
Place the cursor in the cell in which you want the text truncated.


	
Right-click and select Table Properties... from the menu, or navigate to Table > Table Properties...


	
From the Table Properties dialog, select the Cell tab, then select Options...


	
Deselect the Wrap Text check box.







An example of truncation is shown in Figure 4-28.


Figure 4-28 Truncated Text

[image: Description of Figure 4-28 follows]

Description of "Figure 4-28 Truncated Text"








	
Note:

When using multibyte characters (for example, simplified Chinese) in tables, ensure that the column widths are large enough to contain the width of the largest character plus the cell's left and right margins to avoid unexpected character display in your final output.














4.8.4 Inserting Date Fields

Insert dates using the date feature of the word processor. Note that this date corresponds to the publishing date, not to the request run date.






4.8.5 Inserting Multiple Columns on Pages

BI Publisher supports Microsoft Word's Columns function to enable you to publish the output in multiple columns on a page. (Note that this is not supported for HTML output.)

Select Format, then Columns to display the Columns dialog to define the number of columns for the template.

To generate address labels in a two-column format:

	
Divide the page into two columns using the Columns command.


	
Define the repeatable group in the first column. Note that you define the repeatable group only in the first column, as shown in Figure 4-29.





Figure 4-29 Repeatable Groups in First Column

[image: Description of Figure 4-29 follows]

Description of "Figure 4-29 Repeatable Groups in First Column"








	
Tip:

To prevent the address block from breaking across pages or columns, embed the label block inside a single-celled table. Then specify in the Table Properties that the row should not break across pages. See Section 4.8.3, "Inserting Tables."









This template produces the multicolumn output that is shown in Figure 4-30.


Figure 4-30 Multicolumn Output

[image: Description of Figure 4-30 follows]

Description of "Figure 4-30 Multicolumn Output"









4.8.6 Inserting Backgrounds and Watermarks

BI Publisher supports the "Background" feature in Microsoft Word. You can specify a single, graduated color or an image background for the template to be displayed in the PDF output. Note that this feature is supported for PDF output and PPT output only.

To add a background to the template, use the Format > Background menu option.



4.8.6.1 Adding a Background Using Microsoft Word 2000

From the Background pop up menu, you can:

	
Select a single color background from the color palette


	
Select Fill Effects to open the Fill Effects dialog.

From this dialog, select one of the following supported options:

	
Gradient: This can be either one or two colors


	
Texture: Select one of the textures provided, or load your own


	
Pattern: Select a pattern and background/foreground colors


	
Picture: Load a picture to use as a background image












4.8.6.2 Adding a Text or Image Watermark Using Microsoft Word 2002 or Later

These versions of Microsoft Word allow you to add either a text or image watermark.

From the Format menu, select Background, then Printed Watermark to select the following in the dialog:

	
Picture Watermark - Load an image and define how it should be scaled on the document


	
Text Watermark - Use the predefined text options or enter your own, then specify the font, size and how the text should be rendered.

Figure 4-31 shows the Printed Watermark dialog completed to display a text watermark:





Figure 4-31 Printed Watermark Dialog

[image: Description of Figure 4-31 follows]

Description of "Figure 4-31 Printed Watermark Dialog"











4.8.7 Microsoft Word Features That Are Not Supported

Do not use soft returns in your RTF template to achieve specific text placement. Instead use hard carriage returns. A soft return my have unexpected results in your generated output.








4.9 Template Features

BI Publisher supports the template features that are described in the following sections:

	
Section 4.9.1, "Inserting Page Breaks"


	
Section 4.9.2, "Inserting an Initial Page Number"


	
Section 4.9.3, "Specifying Last Page Only Content"


	
Section 4.9.4, "Ending on Even or Odd Pages"


	
Section 4.9.5, "Inserting Hyperlinks"


	
Section 4.9.6, "Including a Table of Contents"


	
Section 4.9.7, "Generating Bookmarks in PDF Output"


	
Section 4.9.8, "Inserting Check Boxes"


	
Section 4.9.9, "Inserting Drop-Down Lists"






4.9.1 Inserting Page Breaks




	
Note:

Page breaks are supported for PDF, RTF, and PPT output. Page breaks are not supported for HTML output.









To create a page break after the occurrence of a specific element use the "split-by-page-break" alias. This causes the report output to insert a hard page break between every instance of a specific element.

To insert a page break between each occurrence of a group, insert the "split-by-page-break" form field within the group immediately before the <?end for-each?> tag that closes the group. In the Help Text of this form field enter the syntax:

<?split-by-page-break:?>

For the following XML, assume you want to create a page break for each new supplier:


<SUPPLIER>
 <NAME>My Supplier</NAME>
 <INVOICES>
  <INVOICE>
   <INVNUM>10001-1</INVNUM>
   <INVDATE>1-Jan-2005</INVDATE>
   <INVAMT>100</INVOICEAMT>
  </INVOICE>
  <INVOICE>
   <INVNUM>10001-2</INVNUM>
   <INVDATE>10-Jan-2005</INVDATE>
   <INVAMT>200</INVOICEAMT>
  </INVOICE>
 </INVOICES>
</SUPPLIER>
<SUPPLIER>
 <NAME>My Second Supplier</NAME>
 <INVOICES>
  <INVOICE>
   <INVNUM>10001-1</INVNUM>
   <INVDATE>11-Jan-2005</INVDATE>
   <INVAMT>150</INVOICEAMT>
  </INVOICE>
…


In the template sample shown in Figure 4-32, the field called PageBreak contains the split-by-page-break syntax:


Figure 4-32 Inserting Page Breaks

[image: Description of Figure 4-32 follows]

Description of "Figure 4-32 Inserting Page Breaks"





Place the PageBreak field with the <?split-by-page-break:?> syntax immediately before the <?end for-each?> field. The PageBreak field sits inside the end of the SUPPLIER loop. This ensures that a page break is inserted before the occurrence of each new supplier. This method avoids the ejection of an extra page at the end of the group when using the native Microsoft Word page break after the group.






4.9.2 Inserting an Initial Page Number




	
Note:

Initial page number is supported for PDF and PPT output. It is not supported for HTML and RTF output.









Some reports require that the initial page number be set at a specified number. For example, monthly reports may be required to continue numbering from month to month. BI Publisher allows you to set the page number in the template to support this requirement.

Use the following syntax in the template to set the initial page number:


<?initial-page-number:pagenumber?>


where pagenumber is the XML element or parameter that holds the numeric value.

BI Publisher also supports continuing the page number from a previous section. The default behavior of a new section in a document is to reset the page numbering. However, if the report requires that the page numbering continue into the next section, use the following command:


<?initial-page-number:'auto'?>


This command allows the continuation of the page numbering from the previous section.

Example 1 - Set page number from XML data element

If the XML data contains an element to carry the initial page number, for example:


<REPORT>
  <PAGESTART>200<\PAGESTART>
  ....
</REPORT>


Enter the following in the template:


<?initial-page-number:PAGESTART?>



The initial page number is the value of the PAGESTART element, which in this case is 200.

Example 2 - Set page number by passing a parameter value

If you define a parameter called PAGESTART, then you can pass the initial value by calling the parameter.

Enter the following in the template:


<?initial-page-number:$PAGESTART?>






	
Note:

You must first declare the parameter in the template. See Section 4.13.2, "Setting Parameters."














4.9.3 Specifying Last Page Only Content




	
Note:

This feature is supported for PDF and PPT output only.









BI Publisher supports the Microsoft Word functionality to specify a different page layout for the first page, odd pages, and even pages. To implement these options, simply select Page Setup from the File menu, then select the Layout tab. BI Publisher recognizes the settings that you make in this dialog.

However, Microsoft Word does not provide settings for a different last page only. This is useful for documents such as checks, invoices, or purchase orders on which you may want the content such as the check or the summary in a specific place only on the last page. BI Publisher provides this ability.

To specify last page only content:

	
Create a section break in the template to ensure the content of the final page is separated from the rest of the report.


	
Insert the following syntax on the final page:

<?start@last-page:body?>

<?end body?>




Any content on the page that occurs above or below these two tags is displayed only on the last page of the report. Also, note that because this command explicitly specifies the content of the final page, any desired headers or footers previously defined for the report must be reinserted on the last page.

This example uses the last page only feature for a report that generates an invoice listing with a summary to appear at the bottom of the last page.

Assume the following XML:


<?xml version="1.0" encoding="WINDOWS-1252"?>
<INVOICELIST>
 <VENDOR>
  <VENDOR_NAME>Nuts and Bolts Limited</VENDOR_NAME>
  <ADDRESS>1 El Camino Real, Redwood City, CA 94065</ADDRESS>
  <INVOICE>
   <INV_TYPE>Standard</INV_TYPE>
   <INVOICE_NUM>981110</INVOICE_NUM>
   <INVOICE_DATE>10-NOV-04</INVOICE_DATE>
   <INVOICE_CURRENCY_CODE>EUR</INVOICE_CURRENCY_CODE>
   <ENT_AMT>122</ENT_AMT>
   <ACCTD_AMT>122</ACCTD_AMT>
   <VAT_CODE>VAT22%</VAT_CODE>
  </INVOICE>
  <INVOICE>
   <INV_TYPE>Standard</INV_TYPE>
   <INVOICE_NUM>100000</INVOICE_NUM>
   <INVOICE_DATE>28-MAY-04</INVOICE_DATE>
   <INVOICE_CURRENCY_CODE>FIM</INVOICE_CURRENCY_CODE>
   <ENT_AMT>122</ENT_AMT>
   <ACCTD_AMT>20.33</ACCTD_AMT>
   <VAT_CODE>VAT22%</VAT_CODE>
  </INVOICE>
 </VENDOR>
 <VENDOR>
  ...
<INVOICE>
 ...
  </INVOICE>
 </VENDOR>
 <SUMMARY>
  <SUM_ENT_AMT>61435</SUM_ENT_AMT>
  <SUM_ACCTD_AMT>58264.68</SUM_ACCTD_AMT>
  <TAX_CODE>EU22%</TAX_CODE>
 </SUMMARY>
</INVOICELIST>


The report should show each VENDOR and their INVOICE data with a SUMMARY section that appears only on the last page, placed at the bottom of the page. The template for this is shown in Figure 4-33.


Figure 4-33 Template Page One

[image: Description of Figure 4-33 follows]

Description of "Figure 4-33 Template Page One"





Insert a Microsoft Word section break (type: next page) on the first page of the template. For the final page, insert new line characters to position the summary table at the bottom of the page. The summary table is shown in Figure 4-34.


Figure 4-34 Last Page Only Layout

[image: Description of Figure 4-34 follows]

Description of "Figure 4-34 Last Page Only Layout"





In this example:

	
The F and E components contain the for-each grouping statements.


	
The grayed report fields are placeholders for the XML elements.


	
The "Last Page Placeholder" field contains the syntax:

<?start@last-page:body?> <?end body?>

to declare the last page layout. Any content above or below this statement is displayed on the last page only. The content above the statement is regarded as the header and the content below the statement is regarded as the footer.




If the reports contains headers and footers that you want to carry over onto the last page, you must reinsert them on the last page. For more information, see Section 4.5, "Defining Headers and Footers."

You must insert a section break (type: next page) into the document to specify the last page layout. This example is available in the samples folder of the Oracle BI Publisher Template Builder for Word installation.

Because the default behavior of a new section in a document is to reset the page numbering the page number on the last page is reset. To continue the page numbering from the previous section, use the following command:


<?initial-page-number:'auto'?>


This command allows the continuation of the page numbering from the previous section.

It is important to note that if the report is only one page in length, the first page layout is used. If the report requires that a single page report should default to the last page layout (such as in a check printing implementation), then you can use the following alternate syntax for the "Last Page Placeholder" on the last page:

<?start@last-page-first:body?> <?end body?>

Substituting this syntax results in the last page layout for reports that are only one page long.






4.9.4 Ending on Even or Odd Pages




	
Note:

This feature is supported for PDF and PDF output only. It is not supported for RTF and HTML output.









If the report has different odd and even page layouts, then you might want to force the report to end specifically on an odd or even page. For example, you may include the terms and conditions of a purchase order in the footer of the report using the different odd/even footer functionality (see Section 4.5.4, "Defining Different First Page and Different Odd and Even Pages") and you want to ensure that the terms and conditions are printed on the final page.

Or, you may have binding requirements to have the report end on an even page, without specific layout.

To end on an even page with layout:

	
Insert the following syntax in a form field in the template:


<?section:force-page-count;'end-on-even-layout'?>




To end on an odd page layout:

	
Insert the following syntax in a form field in the template:


<?section:force-page-count;'end-on-odd-layout'?>




If you do not have layout requirements for the final page, but would like a blank page ejected to force the page count to the preferred odd or even, then use the following syntax:


<?section:force-page-count;'end-on-even'?>


or


<?section:force-page-count;'end-on-odd'?>






4.9.5 Inserting Hyperlinks




	
Note:

Hyperlinks are supported for PDF, RTF, HTML, PPT, and Excel output.









BI Publisher supports several different types of hyperlinks. The hyperlinks can be fixed or dynamic and can link to either internal or external destinations. Hyperlinks can also be added to shapes.

	
To insert static hyperlinks to either text or a shape, use the word processor's insert hyperlink feature.

To insert a static hyperlink to a text or a shape:

	
Select the text or shape.


	
Use the right-mouse menu to select Hyperlink; or, select Hyperlink from the Insert menu.


	
Enter the URL using any of the methods provided on the Insert Hyperlink dialog box.




Figure 4-35 shows the insertion of a static hyperlink using Microsoft Word's Insert Hyperlink dialog.


Figure 4-35 Static Hyperlink

[image: Description of Figure 4-35 follows]

Description of "Figure 4-35 Static Hyperlink"





	
If the input XML data includes an element that contains a hyperlink or part of one, then you can create dynamic hyperlinks at runtime. In the Type the file or Web page name field of the Insert Hyperlink dialog, enter the following syntax:

{URL_LINK}

where URL_LINK is the incoming data element name.

If you have a fixed URL that you want to add elements from the XML data file to construct the URL, enter the following syntax:

http://www.example.com?product={PRODUCT_NAME}

where PRODUCT_NAME is the incoming data element name.

In both these cases, at runtime the dynamic URL is constructed.

Figure 4-36 shows the insertion of a dynamic hyperlink using Microsoft Word's Insert Hyperlink dialog. The data element SUPPLIER_URL from the incoming XML file contains the hyperlink that is inserted into the report at runtime.


Figure 4-36 Dynamic Hyperlink

[image: Description of Figure 4-36 follows]

Description of "Figure 4-36 Dynamic Hyperlink"





	
You can also pass parameters at runtime to construct a dynamic URL.

Enter the parameter and element names surrounded by braces to build up the URL as follows:


{$SERVER_URL}{$REPORT}/cstid={CUSTOMER_ID}


where SERVER_URL and REPORT are parameters passed to the template at runtime (note the $ sign) and CUSTOMER_ID is an XML data element. This link may render as:

http://myserver.domain:8888/CustomerReport/cstid=1234




To add the target attribute to a URL, add the following to the URL string:


??target=_target_value


For example:


http://www.example.com??target=_top 


Values for the target attribute are:

	
_top


	
_blank


	
_self


	
_parent


	
framename




You can pass in the value of target dynamically, using the following syntax:


http://www.example.com/index.html??target={$myTarget} 



where myTarget is the name of the parameter that holds the value.



4.9.5.1 Inserting Internal Links

Insert internal links into the template using Microsoft Word's Bookmark feature.

To insert internal links:

	
Position the cursor in the desired destination in the document.


	
From the Insert menu, select Bookmark.


	
In the Bookmark dialog, enter a name for this bookmark, and select Add.


	
Select the text or shape in the document that you want to link back to the Bookmark target.


	
Use the right-mouse menu to select Hyperlink; or select Hyperlink from the Insert menu.


	
On the Insert Hyperlink dialog, select Bookmark.


	
Select the bookmark that you created from the list.




At runtime, the link is maintained in the generated report.








4.9.6 Including a Table of Contents




	
Note:

Table of contents feature is supported for PDF and PPT output. RTF support is limited: After report generation, the user must press F9 to reset the page numbers.









BI Publisher supports the table of contents generation feature of the RTF specification. Follow the word processor's procedures for inserting a table of contents.

BI Publisher also provides the ability to create dynamic section headings in the document from the XML data. You can then incorporate these into a table of contents.

To create dynamic headings:

	
Enter a placeholder for the heading in the body of the document, and format it as a "Heading", using the word processor's style feature. You cannot use form fields for this functionality.

For example, you want the report to display a heading for each company reported. The XML data element tag name is <COMPANY_NAME>. In the template, enter <?COMPANY_NAME?> where you want the heading to appear. Now format the text as a Heading.


	
Create a table of contents using the word processor's table of contents feature.




At runtime, the TOC placeholders and heading text are substituted.






4.9.7 Generating Bookmarks in PDF Output

If you have defined a table of contents in the RTF template, then you can use the table of contents definition to generate links in the Bookmarks tab in the navigation pane of the output PDF. The bookmarks can be either static or dynamically generated.




	
Note:

Bookmark support in RTF templates is limited to a single-point bookmark. This is to allow link (Goto) functionality within the document. Arrays in bookmarks are not supported.









For information on creating the table of contents, see Section 4.9.6, "Including a Table of Contents."

	
To create links for a static table of contents:

Enter the syntax:

<?copy-to-bookmark:?>

directly above the table of contents and

<?end copy-to-bookmark:?>

directly below the table of contents.


	
To create links for a dynamic table of contents:

Enter the syntax:

<?convert-to-bookmark:?>

directly above the table of contents and

<?end convert-to-bookmark:?>

directly below the table of contents.




To control the initial state of the bookmark when the PDF file is opened, use the following command:


<?collapse-bookmark:state;level?>


where

state can have the following values:

	
hide - Collapses the table of contents entries


	
show - Expands the table of contents entries




and

level sets the table of contents collapse level. For example: "1" collapses the first level of entries in the table of contents; "2" collapses the and first and second level entries.

Use this command with <?copy-to-bookmark:?> and <?convert-to-bookmark:?> as shown in the following examples:

	
To create a static table of contents that hides level 1 and level 2 of the table of contents entries, enter the following:


<?copy-to-bookmark:?> 
<?collapse-bookmark:hide;2?>


directly above the table of contents and


<?end copy-to-bookmark:?> 


directly below the table of contents.


	
To create links for a dynamic table of contents that shows levels 1 and 2 of the table of contents expanded, enter the following:


<?convert-to-bookmark:>
<?collapse-bookmark:show;2?>


directly above the table of contents and


<?end convert-to-bookmark:?>


directly below the table of contents.









4.9.8 Inserting Check Boxes




	
Note:

Check boxes are supported in PDF output only.









You can include a check box in the template that you can define to display as checked or unchecked based on a value from the incoming data.

To define a check box in the template:

	
Position the cursor in the template where you want the check box to display, and select the Check Box Form Field from the Forms tool bar, as shown in Figure 4-37.


Figure 4-37 Check Box Form Field

[image: Description of Figure 4-37 follows]

Description of "Figure 4-37 Check Box Form Field"





	
Right-click the field to open the Check Box Form Field Options dialog.


	
Specify the Default value as either Checked or Not Checked.


	
In the Form Field Help Text dialog, enter the criteria for how the box should behave. This must be a boolean expression (that is, one that returns a true or false result).

For example, suppose the XML data contains an element called <population>. You want the check box to appear checked if the value of <population> is greater than 10,000. Enter the following in the help text field:


<?population>10000?>


The help text coding is shown in Figure 4-38.


Figure 4-38 Sample Help Text Coding

[image: Description of Figure 4-38 follows]

Description of "Figure 4-38 Sample Help Text Coding"





Note that you do not have to construct an "if" statement. The expression is treated as an "if" statement.

See Section 4.9.9, "Inserting Drop-Down Lists" for a sample template using a check box.









4.9.9 Inserting Drop-Down Lists

BI Publisher allows you to use the drop-down form field to create a cross-reference in the template from the XML data to some other value that you define in the drop-down form field.

For example, suppose you have the following XML:


<countries>
 <country>
  <name>Chad</name>
  <population>7360000</population>
  <continentIndex>5</continentIndex>
 </country>
 <country>
  <name>China</name>
  <population>1265530000</population>
  <continentIndex>1</continentIndex>
 </country>
 <country>
  <name>Chile</name>
  <population>14677000</population>
  <continentIndex>3</continentIndex>
 </country>
. . . 
</countries>


Notice that each <country> entry has a <continentindex> entry, which is a numeric value to represent the continent. Using the drop-down form field, you can create an index in the template that cross-references the <continentindex> value to the actual continent name. You can then display the name in the published report.

To create the index for the continent example:

	
Position the cursor in the template where you want the value from the drop-down list to display, and select the Drop-Down Form Field from the Forms tool bar, as shown in Figure 4-39.


Figure 4-39 Drop-Down Form Field

[image: Description of Figure 4-39 follows]

Description of "Figure 4-39 Drop-Down Form Field"





	
Right-click the field to display the Drop-Down Form Field Options dialog.


	
Add each value to the Drop-down item field and the click Add to add it to the Items in drop-down list group. The values are indexed starting from one for the first, and so on. For example, the list of continents is stored as shown in Table 4-3.


Table 4-3 Indexed Values for Continents

	Index	Value
	
1

	
Asia


	
2

	
North America


	
3

	
South America


	
4

	
Europe


	
5

	
Africa


	
6

	
Australia








	
Now use the Help Text box to enter the XML element name that holds the index for the drop-down field values.

For this example, enter


<?continentIndex?>


Figure 4-40 shows the Drop-Down Form Field Options dialogs for this example:


Figure 4-40 Drop-Down Form Field Options

[image: Description of Figure 4-40 follows]

Description of "Figure 4-40 Drop-Down Form Field Options"







Using the check box and drop-down list features, you can create a report to display population data with check boxes to demonstrate figures that reach a certain limit. An example is shown in Figure 4-41.


Figure 4-41 Report of Population Data with Check Boxes

[image: Description of Figure 4-41 follows]

Description of "Figure 4-41 Report of Population Data with Check Boxes"





The template to create this report is shown in Figure 4-42 and the fields have the values shown in Table 4-4.


Figure 4-42 Template for Population Data Report

[image: Description of Figure 4-42 follows]

Description of "Figure 4-42 Template for Population Data Report"






Table 4-4 Fields for Drop-Down List

	Field	Form Field Entry	Description
	
FE

	
<?for-each:country?>

	
Begins the country repeating group.


	
China

	
<?name?>

	
Placeholder for the name element.


	
1,000,000

	
<?population?>

	
Placeholder for the population element.


	
(check box)

	
<?population>1000000?>

	
Establishes the condition for the check box. If the value for the population element is greater than 1,000,000, the check box is displayed as checked.


	
Asia

	
<?contintentIndex?>

	
The drop-down form field for the continentIndex element. See the preceding description for its contents. At runtime, the value of the XML element is replaced with the value it is cross-referenced to in the drop-down form field.


	
EFE

	
<?end for-each?>

	
Ends the country group.














4.10 Using Conditional Formatting




	
Note:

For information about using the Template Builder to insert conditional regions and conditional formatting, see Section 5.4.8, "Inserting and Editing Conditional Regions" and Section 5.4.9, "Inserting Conditional Formatting."









Conditional formatting occurs when a formatting element appears only when a certain condition is met. BI Publisher supports the usage of simple "if" statements, as well as more complex "choose" expressions.

The conditional formatting that you specify can be XSL or XSL:FO code, or you can specify actual RTF objects such as a table or data. For example, you can specify that if reported numbers reach a certain threshold, they are displayed shaded in red. Or, you can use this feature to hide table columns or rows depending on the incoming XML data.

This section covers the following topics of conditional formatting:

	
Section 4.10.1, "Using If Statements"


	
Section 4.10.2, "Using If Statements in Boilerplate Text"


	
Section 4.10.3, "Using If-Then-Else Statements"


	
Section 4.10.4, "Inserting Choose Statements"


	
Section 4.10.5, "Formatting Columns"


	
Section 4.10.6, "Formatting Rows"


	
Section 4.10.7, "Highlighting Cells"






4.10.1 Using If Statements

Use an if statement to define a simple condition; for example, if a data field is a specific value.

To use an if statement:

	
Insert the following syntax to designate the beginning of the conditional area.

<?if:condition?>


	
Insert the following syntax at the end of the conditional area: <?end if?>.




For example, to set up the Payables Invoice Register to display invoices only when the Supplier name is "Company A", insert the syntax <?if:VENDOR_NAME='COMPANY A'?> before the Supplier field on the template.

Enter the <?end if?> tag after the invoices table.

This example is displayed in Figure 4-43. Note that you can insert the syntax in form fields, or directly into the template.


Figure 4-43 Sample IF Statement

[image: Description of Figure 4-43 follows]

Description of "Figure 4-43 Sample IF Statement"









4.10.2 Using If Statements in Boilerplate Text

Assume that you want to incorporate an "if" statement into the following free-form text:

The program was (not) successful.

You want the "not" to display only if the value of an XML tag called <SUCCESS> equals "N".

To achieve this requirement, use the BI Publisher context command to place the if statement into the inline sequence rather than into the block (the default placement).




	
Note:

For more information on context commands, see Section 4.18, "Controlling the Placement of Instructions Using the Context Commands."









For example, if you construct the code as follows:


The program was <?if:SUCCESS='N'?>not<?end if?> successful.


The following undesirable result occurs:


The program was
not
successful.


because BI Publisher applies the instructions to the block by default. To specify that the if statement should be inserted into the inline sequence, enter the following:


The program was <?if@inlines:SUCCESS='N'?>not<?end if?> 
successful.


This construction results in the following display:


The program was successful.


If SUCCESS does not equal 'N';

or


The program was not successful.


If SUCCESS equals 'N'.




	
Note:

If you use @inlines with if syntax, any other if syntax inside the statement must use the context command @inline.If you use @inlines with FOR-EACH syntax any other if or FOR-EACH syntax inside the statement must use the context command @inline.














4.10.3 Using If-Then-Else Statements

BI Publisher supports the common programming construct "if-then-else". This is extremely useful when you must test a condition and conditionally show a result. For example:


IF X=0 THEN
 Y=2
ELSE
 Y=3
END IF


You can also nest these statements as follows:


IF X=0 THEN
 Y=2
ELSE
 IF X=1 THEN
   Y=10
 ELSE Y=100
END IF


Use the following syntax to construct an if-then-else statement in the RTF template:


<?xdofx:if element_condition then result1 else result2 end if?>


For example, the following statement tests the AMOUNT element value. If the value is greater than 1000, show the word "Higher"; if it is less than 1000, show the word "Lower"; if it is equal to 1000, show "Equal":


<?xdofx:if AMOUNT > 1000 then 'Higher'
  else
  if AMOUNT < 1000 then 'Lower'
   else
   'Equal'
end if?>






4.10.4 Inserting Choose Statements

Use the choose, when, and otherwise elements to express multiple conditional tests. If certain conditions are met in the incoming XML data, then specific sections of the template are rendered. This is a very powerful feature of the RTF template. In regular XSL programming, if a condition is met in the choose command then further XSL code is executed. In the template, however, you can actually use visual widgets in the conditional flow (in the following example, a table).

Use the following syntax for these elements:

<?choose:?>

<?when:expression?>

<?otherwise?>



4.10.4.1 Conditional Formatting Example

This example shows a choose expression in which the display of a row of data depends on the value of the fields EXEMPT_FLAG and POSTED_FLAG. When the EXEMPT_FLAG equals "^", the row of data renders light gray. When POSTED_FLAG equals "*" the row of data renders shaded dark gray. Otherwise, the row of data renders with no shading.

In Figure 4-44, the form field default text is displayed. The form field help text entries are shown in Table 4-5.


Figure 4-44 Conditional Formatting Example

[image: Description of Figure 4-44 follows]

Description of "Figure 4-44 Conditional Formatting Example"






Table 4-5 Form Field Default Text

	Default Text Entry in Example Form Field	Help Text Entry in Form Field
	
<Grp:VAT

	
<?for-each:G_VAT?> starts the G_VAT group


	
<Choose

	
<?choose:?> opens the choose statement


	
<When EXEMPT_FLAG='^'

	
<?when: EXEMPT_FLAG='^'?> tests the EXEMPT_FLAG element, if true, use the first table shown


	
End When>

	
<?end when?> ends the EXEMPT_FLAG test


	
<When POSTED_FLAG='*'

	
<?when:POSTED_FLAG='*'?> tests the POSTED_FLAG element, if true, use the table following


	
End When>

	
<?end when?> ends the POSTED_FLAG test


	
Otherwise

	
<?otherwise:?> If none of above are true then use the following table


	
End Otherwise>

	
<?end otherwise?> ends the otherwise statement


	
End Choose>

	
<?end choose?> ends the choose statement


	
End Vat>

	
<?end for-each?> ends the G_VAT group














4.10.5 Formatting Columns

You can conditionally show and hide columns of data in the document output. The following example demonstrates how to set up a table so that a column is only displayed based on the value of an element attribute.

This example shows a report of a price list, represented by the following XML:


<items type="PUBLIC"> <! -  can be marked 'PRIVATE'  - >
 <item>
  <name>Plasma TV</name>
  <quantity>10</quantity>
  <price>4000</price>
 </item>
 <item>
  <name>DVD Player</name>
  <quantity>3</quantity>
  <price>300</price>
 </item>
 <item>
  <name>VCR</name>
  <quantity>20</quantity>
  <price>200</price>
 </item>
 <item>
  <name>Receiver</name>
  <quantity>22</quantity>
  <price>350</price>
 </item>
</items>


Notice the "type" attribute associated with the items element. In this XML it is marked as "PUBLIC" meaning the list is a public list rather than a "PRIVATE" list. For the "public" version of the list, the quantity column should not be shown in the output, but you want to develop only one template for both versions based on the list type.

Figure 4-45 contains a simple template that conditionally shows or hides the quantity column.


Figure 4-45 Showing or Hiding the Quantity Column

[image: Description of Figure 4-45 follows]

Description of "Figure 4-45 Showing or Hiding the Quantity Column"





Table 4-6 shows the entries made in the template that is shown in Figure 4-45.


Table 4-6 Template Entries

	Default Text	Form Field Entry	Description
	
grp:Item

	
<?for-each:item?>

	
Holds the opening for-each loop for the item element.


	
Plasma TV

	
<?name?>

	
The placeholder for the name element from the XML file.


	
IF

	
<?if@column:/items/@type="PRIVATE"?>

	
The opening of the if statement to test for the attribute value "PRIVATE" in the column header. Note that this syntax uses an XPath expression to navigate back to the "items" level of the XML to test the attribute. For more information about using XPath in templates, see Section 4.19, "Using XPath Commands."


	
Quantity

	
N/A

	
Boilerplate heading


	
end-if

	
<?end if?>

	
Ends the if statement.


	
IF

	
<?if@cell:/items/@type="PRIVATE"?>

	
The opening of the if statement to test for the attribute value "PRIVATE" in the column data.


	
20

	
<?quantity?>

	
The placeholder for the quantity element.


	
end-if

	
<?end if?>

	
Ends the if statement.


	
1,000.00

	
<?price?>

	
The placeholder for the price element.


	
end grp

	
<?end for-each?>

	
Closing tag of the for-each loop.








The conditional column syntax is the "if" statement syntax with the addition of the @column clause. It is the @column clause that instructs BI Publisher to hide or show the column based on the outcome of the if statement.

If you did not include the @column the data would not display in the report as a result of the if statement, but the column still would because you had drawn it in the template.




	
Note:

The @column clause is an example of a context command. For more information, see Section 4.18, "Controlling the Placement of Instructions Using the Context Commands."









The example renders the output that is shown in Figure 4-46.


Figure 4-46 Sample Price Report

[image: Description of Figure 4-46 follows]

Description of "Figure 4-46 Sample Price Report"





If the same XML data contained the type attribute set to "PRIVATE", then the output that is shown in Figure 4-47 is rendered from the same template.


Figure 4-47 Sample Quantity and Price Report

[image: Description of Figure 4-47 follows]

Description of "Figure 4-47 Sample Quantity and Price Report"









4.10.6 Formatting Rows

BI Publisher allows you to specify formatting conditions as the row-level of a table. Examples of row-level formatting are:

	
Highlighting a row when the data meets a certain threshold.


	
Alternating background colors of rows to ease readability of reports.


	
Showing only rows that meet a specific condition.




Conditionally Displaying a Row

To display only rows that meet a certain condition, insert the <?if:condition?> <?end if?> tags at the beginning and end of the row, within the for-each tags for the group. These tags are demonstrated in the sample template that is shown in Figure 4-48.


Figure 4-48 Template for Conditionally Displaying Rows

[image: Description of Figure 4-48 follows]

Description of "Figure 4-48 Template for Conditionally Displaying Rows"





Table 4-7 describes the fields from the template in Figure 4-48.


Table 4-7 Form Fields for Conditionally Displaying Rows

	Default Text Entry	Form Field Help Text	Description
	
for-each SALE

	
<?for-each:SALE?>

	
Opens the for-each loop to repeat the data belonging to the SALE group.


	
if big

	
<?if:SALES>5000?>

	
If statement to display the row only if the element SALES has a value greater than 5000.


	
INDUSTRY

	
<?INDUSTRY?>

	
Data field


	
YEAR

	
<?YEAR?>

	
Data field


	
MONTH

	
<?MONTH?>

	
Data field


	
SALES end if

	
<?end if?>

	
Closes the if statement.


	
end SALE

	
<?end for-each?>

	
Closes the SALE loop.








Conditionally Highlighting a Row

This example demonstrates how to set a background color on every other row. The template to create this effect is shown in Figure 4-49.


Figure 4-49 Template for Conditionally Highlighting Rows

[image: Description of Figure 4-49 follows]

Description of "Figure 4-49 Template for Conditionally Highlighting Rows"





Table 4-8 shows values of the form fields from the template in Figure 4-49.


Table 4-8 Form Fields to Highlight Rows

	Default Text Entry	Form Field Help Text	Description
	
for-each SALE

	
<?for-each:SALE?>

	
Defines the opening of the for-each loop for the SALE group.


	
format;

	
<?if@row:position() mod 2=0?> <xsl:attribute name="background-color" xdofo:ctx="incontext">lightgray</xsl:attribute><?end if?>

	
For each alternate row, the background color attribute is set to gray for the row.


	
INDUSTRY

	
<?INDUSTRY?>

	
Data field


	
YEAR

	
<?YEAR?>

	
Data field


	
MONTH

	
<?MONTH?>

	
Data field


	
SALES

	
<?SALES?>

	
Data field


	
end SALE

	
<?end for-each?>

	
Closes the SALE for-each loop.








In Table 4-8, note the "format;" field. It contains an if statement with a "row" context (@row). This sets the context of the if statement to apply to the current row. If the condition is true, then the <xsl:attribute> for the background color of the row is set to light gray. This setting results in the output that is shown in Figure 4-50.


Figure 4-50 Industry Sales Report

[image: Description of Figure 4-50 follows]

Description of "Figure 4-50 Industry Sales Report"








	
Note:

For more information about context commands, see Section 4.18, "Controlling the Placement of Instructions Using the Context Commands."














4.10.7 Highlighting Cells

The following example demonstrates how to conditionally highlight a cell based on a value in the XML file.

This example uses the following XML code:


<accounts>
 <account>
  <number>1-100-3333</number>
  <debit>100</debit>
  <credit>300</credit>
 </account>
 <account>
  <number>1-101-3533</number>
  <debit>220</debit>
  <credit>30</credit>
 </account>
 <account>
  <number>1-130-3343</number>
  <debit>240</debit>
  <credit>1100</credit>
 </account>
 <account>
  <number>1-153-3033</number>
  <debit>3000</debit>
  <credit>300</credit>
 </account>
</accounts>


The template lists the accounts and their credit and debit values. The final report will highlight in red any cell whose value is greater than 1000. The template for this is shown in figure Figure 4-51:


Figure 4-51 Sample Template to Conditionally Highlight Cells

[image: Sample template to conditionally highlight cells]



The field definitions for the template are shown in Table 4-9.


Table 4-9 Form Fields for Highlighting Cells

	Default Text Entry	Form Field Entry	Description
	
FE:Account

	
<?for-each:account?>

	
Opens the for each-loop for the element account.


	
1-232-4444

	
<?number?>

	
The placeholder for the number element from the XML file.


	
CH1

	
<?if:debit>1000?><xsl:attribute xdofo:ctx="block" name="background-color">red</xsl:attribute><?end if?>

	
This field holds the code to highlight the cell red if the debit amount is greater than 1000.


	
100.00

	
<?debit?>

	
The placeholder for the debit element. IMPORTANT: The <?debit?> element must reside in its own field.


	
CH2

	
<?if:credit>1000?><xsl:attribute xdofo:ctx="block" name="background-color">red</xsl:attribute><?end if?>

	
This field holds the code to highlight the cell red if the credit amount is greater than 1000.


	
100.00

	
<?credit?>

	
The placeholder for the credit element.


	
EFE

	
<?end for-each?>

	
Closes the for-each loop.








The code to highlight the debit column as shown in the table is:


<?if:debit>1000?>
  <xsl:attribute 
   xdofo:ctx="block" name="background-color">red
  </xsl:attribute>
<?end if?>


The "if" statement is testing if the debit value is greater than 1000. If it is, then the next lines are invoked. Notice that the example embeds native XSL code inside the "if" statement.

The "attribute" element allows you to modify properties in the XSL.

The xdofo:ctx component is an BI Publisher feature that allows you to adjust XSL attributes at any level in the template. In this case, the background color attribute is changed to red.

To change the color attribute, you can use either the standard HTML names (for example, red, white, green) or you can use the hexadecimal color definition (for example, #FFFFF).

This template results in the output that is shown in Figure 4-52.


Figure 4-52 Debit and Credit Report

[image: Description of Figure 4-52 follows]

Description of "Figure 4-52 Debit and Credit Report"











4.11 Inserting Page-Level Calculations

BI Publisher supports the page-level calculations that are described in the following sections for PDF and PPT outputs only:

	
Section 4.11.1, "Displaying Page Totals"


	
Section 4.11.2, "Inserting Brought Forward and Carried Forward Totals"


	
Section 4.11.3, "Inserting Running Totals"






4.11.1 Displaying Page Totals

BI Publisher allows you to display calculated page totals in the report. Because the page is not created until publishing time, the totaling function must be executed by the formatting engine.




	
Note:

Page totaling is performed in the PDF-formatting layer. Therefore this feature is not available for other outputs types: HTML, RTF, Excel. This page totaling function works only if the source XML code has raw numeric values. The numbers must not be preformatted.









Because the page total field does not exist in the XML input data, you must define a variable to hold the value. When you define the variable, you associate it with the element from the XML file that is to be totaled for the page. Once you define total fields, you can also perform additional functions on the data in those fields.

To declare the variable that is to hold the page total, insert the following syntax immediately following the placeholder for the element that is to be totaled:


<?add-page-total:TotalFieldName;'element'?>


where

TotalFieldName is the name you assign to the total (to reference later) and

'element' is the XML element field to be totaled.

You can add this syntax to as many fields as you want to total.

Then when you want to display the total field, enter the following syntax:


<?show-page-total:TotalFieldName;'Oracle-number-format' number-separators="{$_XDONFSEPARATORS}"?>


where

TotalFieldName is the name you assigned to give the page total field above and

Oracle-number-format is the format you want to use to for the display, using the Oracle format mask (for example: 'C9G999D00'). For the list of Oracle format mask symbols, see Section 4.15.12, "Oracle Abstract Format Masks."

number-separators="{$_XDONFSEPARATORS}" is a required attribute to apply the grouping separator and decimal separator for the format mask you defined.

The following example shows how to set up page total fields in a template to display total credits and debits that have displayed on the page, and then calculate the net of the two fields.

This example uses the following XML code:


<balance_sheet>
 <transaction>
  <debit>100</debit>
  <credit>90</credit>
 </transaction>
 <transaction>
  <debit>110</debit>
  <credit>80</credit>
 </transaction>
…
<\balance_sheet>


Figure 4-53 shows the table to insert in the template to hold the values.


Figure 4-53 Table for Inserting Values

[image: Description of Figure 4-53 follows]

Description of "Figure 4-53 Table for Inserting Values"





Table 4-10 shows the form field entries made in the template whose table is shown in Figure 4-53.


Table 4-10 Fields for Displaying Totals

	Default Text Entry	Form Field Help Text Entry	Description
	
FE

	
<?for-each:transaction?>

	
This field defines the opening "for-each" loop for the transaction group.


	
100.00

	
<?debit?><?add-page-total:dt;'debit'?>

	
This field is the placeholder for the debit element from the XML file. To total this field by page, the page total declaration syntax is added. The variable defined to hold the total for the debit element is dt.


	
90.00

	
<?credit?> <?add-page-total:ct;'credit'?>

	
This field is the placeholder for the credit element from the XML file. To total this field by page, the page total declaration syntax is added. The variable defined to hold the total for the credit element is ct.


	
Net

	
<add-page-total:net;'debit - credit'?>

	
Creates a net page total by subtracting the credit values from the debit values.


	
EFE

	
<?end for-each?>

	
Closes the for-each loop.








Note that on the variable defined as "net" you perform a calculation on the values of the credit and debit elements.

Now that you have declared the page total fields, you can insert a field in the template where you want the page totals to appear. Reference the calculated variables using the names you supplied (in the example, ct and dt). The syntax to display the page totals is as follows:

For example, to display the debit page total, enter the following:

<?show-page-total:dt;'C9G990D00';'(C9G990D00)' number-separators="{$_XDONFSEPARATORS}"?>

Therefore to complete the example, place the following at the bottom of the template page, or in the footer:

Page Total Debit: <?show-page-total:dt;'C9G990D00';'(C9G990D00)' number-separators="{$_XDONFSEPARATORS}"?>

Page Total Credit: <?show-page-total:ct;'C9G990D00';'(C9G990D00)' number-separators="{$_XDONFSEPARATORS}"?>

Page Total Balance: <?show-page-total:net;'C9G990D00';'(C9G990D00)' number-separators="{$_XDONFSEPARATORS}"?>

The output for this report is shown in Figure 4-54.


Figure 4-54 Debit and Credit Report Totals

[image: Description of Figure 4-54 follows]

Description of "Figure 4-54 Debit and Credit Report Totals"









4.11.2 Inserting Brought Forward and Carried Forward Totals

Many reports require that a page total be maintained throughout the report output and be displayed at the beginning and end of each page. These totals are known as "brought forward and carried forward" totals.




	
Note:

The totaling for the brought forward and carried forward fields is performed in the PDF-formatting layer. Therefore this feature is not available for other outputs types such as HTML, RTF, and Excel.









An example is displayed in the Figure 4-55.


Figure 4-55 Report of Forward Totals

[image: Description of Figure 4-55 follows]

Description of "Figure 4-55 Report of Forward Totals"





At the end of the first page, the page total for the Amount element is displayed as the Carried Forward total. At the top of the second page, this value is displayed as the Brought Forward total from the previous page. At the bottom of the second page, the brought forward value plus the total for that page is calculated and displayed as the new Carried Forward value, and this continues throughout the report.

This functionality is an extension of the Displaying Page Totals feature. The following example walks through the syntax and setup required to display the brought forward and carried forward totals in the published report.

Assume that you have the following XML code:


<?xml version="1.0" encoding="WINDOWS-1252"?>
<INVOICES>
 <INVOICE>
  <INVNUM>10001-1</INVNUM>
  <INVDATE>1-Jan-2005</INVDATE>
  <INVAMT>100</INVOICEAMT>
 </INVOICE>
 <INVOICE>
  <INVNUM>10001-2</INVNUM>
  <INVDATE>10-Jan-2005</INVDATE>
  <INVAMT>200</INVOICEAMT>
 </INVOICE>
 <INVOICE>
  <INVNUM>10001-1</INVNUM>
  <INVDATE>11-Jan-2005</INVDATE>
  <INVAMT>150</INVOICEAMT>
 </INVOICE>
. . .
</INVOICES>


The sample template that is shown in Figure 4-56 creates the invoice table and declares a placeholder that holds the page total.


Figure 4-56 Template for Totals

[image: Description of Figure 4-56 follows]

Description of "Figure 4-56 Template for Totals"





Table 4-11 shows the fields in the template that is shown in Figure 4-56.


Table 4-11 Fields for Totals

	Field	Form Field Help Text Entry	Description
	
Init PTs

	
<?init-page-total: InvAmt?>

	
Declares "InvAmt" as the placeholder that holds the page total.


	
FE

	
<?for-each:INVOICE?>

	
Begins the INVOICE group.


	
10001-1

	
<?INVNUM?>

	
Placeholder for the Invoice Number tag.


	
1-Jan-2005

	
<?INVDATE?>

	
Placeholder for the Invoice Date tag.


	
100.00

	
<?INVAMT?>

	
Placeholder for the Invoice Amount tag.


	
InvAmt

	
<?add-page-total:InvAmt;INVAMT?>

	
Assigns the "InvAmt" page total object to the INVAMT element in the data.


	
EFE

	
<?end for-each?>

	
Closes the INVOICE group.


	
End PTs

	
<?end-page-total:InvAmt?>

	
Closes the "InvAmt" page total.








To display the brought forward total at the top of each page (except the first), use the following syntax:


<xdofo:inline-total
  display-condition="exceptfirst"
  name="InvAmt">
   Brought Forward:
<xdofo:show-brought-forward
  name="InvAmt"
  format="99G999G999D00" number-separators="{$_XDONFSEPARATORS}"/>/>
</xdofo:inline-total>


The following list describes the elements that comprise the brought forward syntax:

	
inline-total - This element has two properties:

	
name - Specifies the name of the variable you declared for the field.


	
display-condition - Sets the display condition. This is an optional property that takes one of the following values:

	
first - Contents are displayed only on the first page.


	
last - Contents are displayed only on the last page.


	
exceptfirst - Contents are displayed on all pages except first.


	
exceptlast - Contents are displayed on all pages except last.


	
everytime - (Default) Contents are displayed on every page.




In this example, display-condition is set to "exceptfirst" to prevent the value from appearing on the first page where the value would be zero.





	
Brought Forward: - This string is optional and is displayed as the field name on the report.


	
show-brought-forward - Shows the value on the page. It has the following properties:

	
name - The name of the field to show. In this case, "InvAmt". This property is mandatory.


	
format - The Oracle number format to apply to the value at runtime. This property is optional, but if you want to supply a format mask, you must use the Oracle format mask. For more information, see Section 4.15.12, "Oracle Abstract Format Masks."


	
number-separators="{$_XDONFSEPARATORS}" - This attribute is required to apply the grouping separator and number separator for the format mask you defined.







Insert the brought forward object at the top of the template where you want the brought forward total to display. If you place it in the body of the template, then you can insert the syntax in a form field.

If you want the brought forward total to display in the header, you must insert the full code string into the header because Microsoft Word does not support form fields in the header or footer regions. However, you can alternatively use the start body/end body syntax, which allows you to define what the body area of the report is. BI Publisher recognizes any content above the defined body area as header content, and any content below as the footer. This allows you to use form fields. See Section 4.5.3, "Creating Multiple or Complex Headers and Footers" for details.

Place the carried forward object at the bottom of the template where you want the total to display. The carried forward object for our example is as follows:


<xdofo:inline-total
  display-condition="exceptlast"
  name="InvAmt">
   Carried Forward:
<xdofo:show-carry-forward
  name="InvAmt"
  format="99G999G999D00" number-separators="{$_XDONFSEPARATORS}"/>
</xdofo:inline-total>


Note the following differences with the brought-forward object:

	
The display-condition is set to exceptlast so that the carried forward total is displayed on every page except the last page.


	
The display string is "Carried Forward".


	
The show-carry-forward element is used to show the carried forward value. It has the same properties as brought-carried-forward, described above.




You are not limited to a single value in the template, you can create multiple brought forward/carried forward objects in the template pointing to various numeric elements in the data.




	
Note:

Ensure that you do not include the commands <?init-page-total:invAmnt?> and <?end-page-total:InvAmt?> as shown in the preceding example. The display-condition logic computation depends on these commands to function correctly.














4.11.3 Inserting Running Totals

The variable functionality (see Section 4.13.1, "Setting Variables") can be used to add a running total to the invoice listing report. This example assumes the following XML structure:


<?xml version="1.0" encoding="WINDOWS-1252"?>
<INVOICES>
 <INVOICE>
  <INVNUM>10001-1</INVNUM>
  <INVDATE>1-Jan-2005</INVDATE>
  <INVAMT>100</INVOICEAMT>
 </INVOICE>
 <INVOICE>
  <INVNUM>10001-2</INVNUM>
  <INVDATE>10-Jan-2005</INVDATE>
  <INVAMT>200</INVOICEAMT>
 </INVOICE>
 <INVOICE>
  <INVNUM>10001-1</INVNUM>
  <INVDATE>11-Jan-2005</INVDATE>
  <INVAMT>150</INVOICEAMT>
 </INVOICE>
</INVOICES>


You can use this XML code to create a report that contains running totals as shown in Figure 4-57.


Figure 4-57 Report of Running Totals

[image: Description of Figure 4-57 follows]

Description of "Figure 4-57 Report of Running Totals"





To create the Running Total field, define a variable to track the total and initialize it to 0. The template is shown in Figure 4-58.


Figure 4-58 Template for Running Total Field

[image: Description of Figure 4-58 follows]

Description of "Figure 4-58 Template for Running Total Field"





The values for the form fields in the template that is shown in Figure 4-58 are described in Table 4-12.


Table 4-12 Fields for Running Totals

	Form Field	Syntax	Description
	
RtotalVar

	
<?xdoxslt:set_variable($_XDOCTX, 'RTotalVar', 0)?>

	
Declares the "RTotalVar" variable and initializes it to 0.


	
FE

	
<?for-each:INVOICE?>

	
Starts the Invoice group.


	
10001-1

	
<?INVNUM?>

	
Invoice Number tag


	
1-Jan-2005

	
<?INVDATE?>

	
Invoice Date tag


	
100.00

	
<?xdoxslt:set_variable($_XDOCTX, 'RTotalVar', xdoxslt:get_variable($_XDOCTX, 'RTotalVar') + INVAMT)?> <?xdoxslt:get_variable($_XDOCTX, 'RTotalVar')?>

	
Sets the value of RTotalVar to the current value plus the new Invoice Amount. Retrieves the RTotalVar value for display.


	
EFE

	
<?end for-each?>

	
Ends the INVOICE group.














4.12 Handling Data

The following sections describe methods for handling data in templates:

	
Section 4.12.1, "Sorting Data"


	
Section 4.12.2, "Checking for Null Values"


	
Section 4.12.3, "Regrouping the XML Data"






4.12.1 Sorting Data

You can sort a group by any element within the group. Insert the following syntax within the group tags:

<?sort:element name; order; data-type?>

where

element name is the name of the element you want the group sorted by

order is 'ascending' or 'descending'

data-type is the element data type. Valid values are: 'text' and 'number'.

If the order is not specified, by default, the sort order is ascending. If the data type is not specified, the type is assumed to be text.

For example, to sort a data set by an element named SALARY so that the highest salaries appear first, enter the following:


<?sort:SALARY;'descending';'number'?>


When you are sorting within a for-each group, enter the sort statement after the for-each statement. For example, to sort the Payables Invoice Register (shown at the beginning of this chapter) by Supplier (VENDOR_NAME), enter the following:

<?for-each:G_VENDOR_NAME?><?sort:VENDOR_NAME?>

To sort a group by multiple fields, just enter additional sort statements in the appropriate order. For example, to sort by Supplier and then by Invoice Number, enter the following

<?sort:VENDOR_NAME?> <?sort:INVOICE_NUM;'ascending';'number'?>






4.12.2 Checking for Null Values

Within the XML data there are three possible scenarios for the value of an element:

	
The element is present in the XML data, and it has a value


	
The element is present in the XML data, but it does not have a value


	
The element is not present in the XML data, and therefore there is no value




In the report layout, you may want to specify a different behavior depending on the presence of the element and its value. The following examples show how to check for each of these conditions using an "if" statement. The syntax can also be used in other conditional formatting constructs.

	
To define behavior when the element is present and the value is not null, use the following:

<?if:element_name!=' '?> desired behavior <?end if?>


	
To define behavior when the element is present, but is null, use the following:

<?if:element_name and element_name="?> desired behavior <?end if?>


	
To define behavior when the element is not present, use the following:

<?if:not(element_name)?> desired behavior <?end if?>









4.12.3 Regrouping the XML Data

The RTF template supports the XSL 2.0 for-each-group standard that allows you to regroup XML data into hierarchies that are not present in the original data. With this feature, the template does not have to follow the hierarchy of the source XML file. You are therefore no longer limited by the structure of the data source.



4.12.3.1 XML Sample

To demonstrate the for-each-group standard, the following XML data sample of a CD catalog listing is regrouped in a template:


<CATALOG>
   <CD>
      <TITLE>Empire Burlesque</TITLE>
      <ARTIST>Bob Dylan</ARTIST>
      <COUNTRY>USA</COUNTRY>
      <COMPANY>Columbia</COMPANY>
      <PRICE>10.90</PRICE>
      <YEAR>1985</YEAR>
   </CD>
   <CD>
      <TITLE>Hide Your Heart</TITLE>
      <ARTIST>Bonnie Tylor</ARTIST>
      <COUNTRY>UK</COUNTRY>
      <COMPANY>CBS Records</COMPANY>
      <PRICE>9.90</PRICE>
      <YEAR>1988</YEAR>
   </CD>
   <CD>
      <TITLE>Still got the blues</TITLE>
      <ARTIST>Gary More</ARTIST>
      <COUNTRY>UK</COUNTRY>
      <COMPANY>Virgin Records</COMPANY>
      <PRICE>10.20</PRICE>
      <YEAR>1990</YEAR>
   </CD>
   <CD>
      <TITLE>This is US</TITLE>
      <ARTIST>Gary Lee</ARTIST>
      <COUNTRY>UK</COUNTRY>
      <COMPANY>Virgin Records</COMPANY>
      <PRICE>12.20</PRICE>
      <YEAR>1990</YEAR>
   </CD>


Using the regrouping syntax, you can create a report of this data that groups the CDs by country and then by year. You are not limited by the data structure presented.






4.12.3.2 Regrouping Syntax

To regroup the data, use the following syntax:


<?for-each-group: BASE-GROUP;GROUPING-ELEMENT?>


For example, to regroup the CD listing by COUNTRY, enter the following in the template:


<?for-each-group:CD;COUNTRY?>


The elements that were at the same hierarchy level as COUNTRY are now children of COUNTRY. You can then refer to the elements of the group to display the values desired.

To establish nested groupings within the already defined group, use the following syntax:


<?for-each:current-group(); GROUPING-ELEMENT?>


For example, after declaring the CD grouping by COUNTRY, you can then further group by YEAR within COUNTRY as follows:


<?for-each:current-group();YEAR?> 


At runtime, BI Publisher loops through the occurrences of the new groupings, displaying the fields that you defined in the template.




	
Note:

This syntax is a simplification of the XSL for-each-group syntax. If you choose not to use the simplified syntax above, you can use the XSL syntax as shown below. The XSL syntax can only be used within a form field of the template.










<xsl:for-each-group
  select=expression
  group-by="string expression"
  group-adjacent="string expression"
  group-starting-with=pattern>
  <!--Content: (xsl:sort*, content-constructor) -->
</xsl:for-each-group>






4.12.3.3 Template Example

Figure 4-59 shows a template that displays the CDs by Country, then Year, and lists the details for each CD.


Figure 4-59 Template for Regrouping

[image: Description of Figure 4-59 follows]

Description of "Figure 4-59 Template for Regrouping"





Table 4-13 shows the BI Publisher syntax entries made in the form fields of the template that is shown in Figure 4-59.


Table 4-13 Syntax Entries for Regrouping XML Data

	Default Text Entry	Form Field Help Text Entry	Description
	
Group by Country

	
<?for-each-group:CD;COUNTRY?>

	
The <?for-each-group:CD;COUNTRY?> tag declares the new group. It regroups the existing CD group by the COUNTRY element.


	
USA

	
<?COUNTRY?>

	
Placeholder to display the data value of the COUNTRY tag.


	
Group by Year

	
<?for-each-group:current-group();YEAR?>

	
The <?for-each-group:current-group();YEAR?> tag regroups the current group (that is, COUNTRY), by the YEAR element.


	
2000

	
<?YEAR?>

	
Placeholder to display the data value of the YEAR tag.


	
Group: Details

	
<?for-each:current-group()?>

	
Once the data is grouped by COUNTRY and then by YEAR, the <?for-each:current-group()?> command is used to loop through the elements of the current group (that is, YEAR) and render the data values (TITLE, ARTIST, and PRICE) in the table.


	
My CD

	
<?TITLE?>

	
Placeholder to display the data value of the TITLE tag.


	
John Doe

	
<?ARTIST?>

	
Placeholder to display the data value of the ARTIST tag.


	
1.00

	
<?PRICE?>

	
Placeholder to display the data value of the PRICE tag.


	
End Group

	
<?end for-each?>

	
Closes out the <?for-each:current-group()?> tag.


	
End Group by Year

	
<?end for-each-group?>

	
Closes out the <?for-each-group:current-group();YEAR?> tag.


	
End Group by Country

	
<?end for-each-group?>

	
Closes out the <?for-each-group:CD;COUNTRY?> tag.








This template produces the report that is shown in Figure 4-60 when merged with the XML file.


Figure 4-60 Report of Regrouping

[image: Description of Figure 4-60 follows]

Description of "Figure 4-60 Report of Regrouping"









4.12.3.4 Regrouping by an Expression

Regrouping by an expression allows you to apply a function or command to a data element, and then group the data by the returned result.

To use this feature, state the expression within the regrouping syntax as follows:


<?for-each:BASE-GROUP;GROUPING-EXPRESSION?>


To demonstrate this feature, an XML data sample that simply contains average temperatures per month is used as input to a template that calculates the number of months having an average temperature within a certain range.

The following XML code is composed of <temp> groups. Each <temp> group contains a <month> element and a <degree> element, which contains the average temperature for that month:


<temps>
  <temp>
    <month>Jan</month>
    <degree>11</degree>
  </temp> 
  <temp>
    <month>Feb</month>
    <degree>14</degree>
  </temp>  
  <temp>
    <month>Mar</month>
    <degree>16</degree>
  </temp> 
  <temp>
    <month>Apr</month>
    <degree>20</degree>
  </temp> 
  <temp>
    <month>May</month>
    <degree>31</degree>
  </temp>
  <temp>
    <month>Jun</month>
    <degree>34</degree>
  </temp> 
  <temp>
    <month>Jul</month>
    <degree>39</degree>
  </temp> 
  <temp>
    <month>Aug</month>
    <degree>38</degree>
  </temp>
  <temp>
    <month>Sep</month>
    <degree>24</degree>
  </temp>  
  <temp>
    <month>Oct</month>
    <degree>28</degree>
  </temp> 
  <temp>
    <month>Nov</month>
    <degree>18</degree>
  </temp> 
  <temp>
    <month>Dec</month>
    <degree>8</degree>
  </temp> 
</temps>         


You want to display this data in a format showing temperature ranges and a count of the months that have an average temperature to satisfy those ranges, as shown in Figure 4-61.


Figure 4-61 Report of Annual Temperature

[image: Description of Figure 4-61 follows]

Description of "Figure 4-61 Report of Annual Temperature"





Using the for-each-group command you can apply an expression to the <degree> element that enables you to group the temperatures by increments of 10 degrees. You can then display a count of the members of each grouping, which is the number of months having an average temperature that falls within each range.

Figure 4-62 shows the template to create the report that is shown in Figure 4-61.


Figure 4-62 Template for Annual Temperature

[image: Description of Figure 4-62 follows]

Description of "Figure 4-62 Template for Annual Temperature"





Table 4-14 shows the form field entries made in the template that is shown in Figure 4-62.


Table 4-14 Form Fields for Regrouping Data

	Default Text Entry	Form Field Help Text Entry
	
Group by TmpRng

	
<?for-each-group:temp;floor(degree div 10)?> <?sort:floor(degree div 10)?>


	
Range

	
<?concat(floor(degree div 10)*10,' F to ',floor(degree div 10)*10+10, 'F')?>


	
Months

	
<?count(current-group())?>


	
End TmpRng

	
<?end for-each-group?>








Note the following about the form field tags:

	
The <?for-each-group:temp;floor(degree div 10)?> is the regrouping tag. It specifies that for the existing <temp> group, the elements are to be regrouped by the expression, floor(degree div 10). The floor function is an XSL function that returns the highest integer that is not greater than the argument (for example, 1.2 returns 1, 0.8 returns 0).

In this case, it returns the value of the <degree> element, which is then divided by 10. This generates the following values from the XML data: 1, 1, 1, 2, 3, 3, 3, 3, 2, 2, 1, and 0.

These are sorted, so that when processed, the following four groups are created: 0, 1, 2, and 3.


	
The <?concat(floor(degree div 10)*10,'F to ', floor(degree div 10)*10+10,'F'?> displays the temperature ranges in the row header in increments of 10. The expression concatenates the value of the current group times 10 with the value of the current group times 10 plus 10.

Therefore, for the first group, 0, the row heading displays 0 to (0 +10), or "0 F to 10 F".


	
The <?count(current-group())?> uses the count function to count the members of the current group (the number of temperatures that satisfy the range).


	
The <?end for-each-group?> tag closes out the grouping.













4.13 Setting Variables, Parameters, and Properties

This section covers the following topics:

	
Section 4.13.1, "Setting Variables"


	
Section 4.13.2, "Setting Parameters"


	
Section 4.13.3, "Setting Properties"






4.13.1 Setting Variables

Updatable variables differ from standard XSL variables <xsl:variable> in that they are updatable during the template application to the XML data. This allows you to create many new features in the templates that require updatable variables.

The variables use a "set and get" approach for assigning, updating, and retrieving values.

Use the following syntax to declare/set a variable value:


<?xdoxslt:set_variable($_XDOCTX, 'variable name', value)?>


Use the following syntax to retrieve a variable value:


<?xdoxslt:get_variable($_XDOCTX, 'variable name')?>


You can use this method to perform calculations. For example:


<?xdoxslt:set_variable($_XDOCTX, 'x', xdoxslt:get_variable($_XDOCTX, 'x' + 1)?> 


This sets the value of variable 'x' to its original value plus 1, much like using "x = x + 1".

The $_XDOCTX specifies the global document context for the variables. In a multi-threaded environment there may be many transformations occurring at the same time, therefore the variable must be assigned to a single transformation.

See Section 4.11.3, "Inserting Running Totals" for an example of the usage of updatable variables.






4.13.2 Setting Parameters

You can pass runtime parameter values into the template. These can then be referenced throughout the template to support many functions. For example, you can filter data in the template, use a value in a conditional formatting block, or pass property values (such as security settings) into the final document.




	
Note:

For BI Publisher Enterprise users, all name-value parameter pairs are passed to the template. You must register the parameters that you want to utilize in the template using the syntax described below.









To use a parameter in a template:

	
Declare the parameter in the template.

Use the following syntax to declare the parameter:


<?param@begin:parameter_name;parameter_value?>


where

parameter_name is the name of the parameter

parameter_value is the default value for the parameter (the parameter_value is optional)

param@begin: is a required string to push the parameter declaration to the top of the template at runtime so that it can be referred to globally in the template.

The syntax must be declared in the Help Text field of a form field. The form field can be placed anywhere in the template.


	
Refer to the parameter in the template by prefixing the name with a "$" character. For example, if you declare the parameter name to be "InvThresh", then reference the value using "$InvThresh".


	
If you are not using BI Publisher Enterprise, but only the core libraries:

At runtime, pass the parameter to the BI Publisher engine programmatically.

Prior to calling the FOProcessor API create a Properties class and assign a property to it for the parameter value as follows:


Properties prop = new Properties();
prop.put("xslt.InvThresh", "1000");




Example: Passing an invoice threshold parameter

This example illustrates how to declare a parameter in the template that filters the data based on the value of the parameter.

The following XML sample lists invoice data:


<INVOICES>
 <INVOICE>
  <INVOICE_NUM>981110</INVOICE_NUM>
  <AMOUNT>1100</AMOUNT>
 </INVOICE>
 <INVOICE>
  <INVOICE_NUM>981111</INVOICE_NUM>
  <AMOUNT>250</AMOUNT>
 </INVOICE>
 <INVOICE>
  <INVOICE_NUM>981112</INVOICE_NUM>
  <AMOUNT>8343</AMOUNT>
 </INVOICE>
. . .
</INVOICES>


Figure 4-63 shows a template that accepts a parameter value to limit the invoices displayed in the final document based on the parameter value.


Figure 4-63 Template for Accepting Parameter Values

[image: Description of Figure 4-63 follows]

Description of "Figure 4-63 Template for Accepting Parameter Values"





Table 4-15 describes the fields for defining parameters as shown in the template in Figure 4-63.


Table 4-15 Fields for Defining Parameters

	Field	Form Field Help Text Entry	Description
	
InvThreshDeclaration

	
<?param@begin:InvThresh?>

	
Declares the parameter InvThresh.


	
FE

	
<?for-each:INVOICE?>

	
Begins the repeating group for the INVOICE element.


	
IF

	
<?if:AMOUNT>$InvThresh?>

	
Tests the value of the AMOUNT element to determine if it is greater than the value of InvThresh.


	
13222-2

	
<?INVOICE_NUM?>

	
Placeholder for the INVOICE_NUM element.


	
$100.00

	
<?AMOUNT?>

	
Placeholder for the AMOUNT element.


	
EI

	
<?end if?>

	
Closing tag for the if statement.


	
EFE

	
<?end for-each?>

	
Closing tag for the for-each loop.








In this template, only INVOICE elements with an AMOUNT greater than the InvThresh parameter value are displayed. If you pass in a parameter value of 1,000, then the report that is shown in Figure 4-64 is produced.


Figure 4-64 Report of Invoices

[image: Description of Figure 4-64 follows]

Description of "Figure 4-64 Report of Invoices"





Notice the second invoice does not display because its amount was less than the parameter value.






4.13.3 Setting Properties

BI Publisher properties that are available in the BI Publisher Configuration file can alternatively be embedded into the RTF template. The properties set in the template are resolved at runtime by the BI Publisher engine. You can either hard code the values in the template or embed the values in the incoming XML data. Embedding the properties in the template avoids the use of the configuration file.




	
Note:

See the appendix "Configuration File Reference" in Oracle Fusion Middleware Administrator's Guide for Oracle Business Intelligence Publisher for more information about the BI Publisher Configuration file and the available properties.









For example, if you use a nonstandard font in the template, then rather than specify the font location in the configuration file, you can embed the font property inside the template. If you must secure the generated PDF output, then you can use the BI Publisher PDF security properties and obtain the password value from the incoming XML data.

To add an BI Publisher property to a template, use the Microsoft Word Properties dialog (available from the File menu), and enter the following information:

	
Name - Enter the BI Publisher property name prefixed with "xdo-"


	
Type - Select "Text"


	
Value - Enter the property value. To reference an element from the incoming XML data, enter the path to the XML element enclosed by curly braces. For example: {/root/password}




Embedding a Font Reference

For this example, suppose you want to use a font in the template called "XMLPScript". This font is not available on the server; therefore you must tell BI Publisher where to find the font at runtime. You tell BI Publisher where to find the font by setting the "font" property. Assume the font is located in "/tmp/fonts", then you would enter the following in the Properties dialog:

	
Name - xdo-font.XMLPScript.normal.normal


	
Type - Text


	
Value - truetype./tmp/fonts/XMLPScript.ttf




When the template is applied to the XML data on the server, BI Publisher looks for the font in the /tmp/fonts directory. Note that if the template is deployed in multiple locations, then you must ensure that the path is valid for each location.

For more information about setting font properties, see the section "Font Definitions" in Oracle Fusion Middleware Administrator's Guide for Oracle Business Intelligence Publisher.

Securing a PDF Output

For this example, suppose you want to use a password from the XML data to secure the PDF output document. The XML data is as follows:


<PO>
 <security>true</security>
 <password>welcome</password>
 <PO_DETAILS>
 ..
</PO>



In the Properties dialog set two properties: pdf-security to set the security feature as enabled or not, and pdf-open-password to set the password. Enter the following in the Properties dialog:

	
Name: xdo-pdf-security


	
Type: Text


	
Value: {/PO/security}


	
Name: xdo-pdf-open-password


	
Type: Text


	
Value: {/PO/password}




Storing the password in the XML data is not recommended if the XML persists in the system for any length of time. To avoid this potential security risk, you can use a template parameter value that is generated and passed into the template at runtime.

For example, you could set up the following parameters:

	
PDFSec - To pass the value for the xdo-pdf-security property


	
PDFPWD - To pass the value for the password




You would then enter the following in the Properties dialog:

	
Name - xdo-pdf-security


	
Type - Text


	
Value - {$PDFSec}


	
Name - xdo-pdf-open-password


	
Type - Text


	
Value - {$PDFPWD}




For more information about template parameters, see Section 4.13.2, "Setting Parameters."








4.14 Using Advanced Report Layouts

This section describes the following tasks for advanced report layouts:

	
Section 4.14.1, "Creating Batch Reports"


	
Section 4.14.2, "Handling No Data Found Conditions"


	
Section 4.14.3, "Inserting Pivot Tables"


	
Section 4.14.4, "Constructing Dynamic Data Columns"






4.14.1 Creating Batch Reports

It is a common requirement to print a batch of documents, such as invoices or purchase orders in a single PDF file. Because these documents are intended for different customers, each document requires that the page numbering be reset and that page totals are specific to the document. If the header and footer display fields from the data (such as customer name), then these must be reset as well.

BI Publisher supports this requirement through the use of a context command. This command allows you to define elements of the report to a specific section. When the section changes, these elements are reset.

The following example demonstrates how to reset the header and footer and page numbering within an output file:

The following XML code is a report that contains multiple invoices:


...
<LIST_G_INVOICE>
   <G_INVOICE>
      <BILL_CUST_NAME>Vision, Inc. </BILL_CUST_NAME>
      <TRX_NUMBER>2345678</TRX_NUMBER>
      ...
   </G_INVOICE>
   <G_INVOICE>
      <BILL_CUST_NAME>Oracle, Inc. </BILL_CUST_NAME>
      <TRX_NUMBER>2345685</TRX_NUMBER>
      ...
   </G_INVOICE>
   ...
</LIST_G_INVOICE>
...


Each G_INVOICE element contains an invoice for a potentially different customer. To instruct BI Publisher to start a new section for each occurrence of the G_INVOICE element, add the @section command to the opening for-each statement for the group, using the following syntax:

<?for-each@section:group name?>

where group_name is the name of the element for which you want to begin a new section.

For example, the for-each grouping statement for this example is as follows:

<?for-each@section:G_INVOICE?>

The closing <?end for-each?> tag is not changed.

Figure 4-65 shows a sample template. Note that the G_INVOICE group for-each declaration is still within the body of the report, even though the headers are reset by the command.


Figure 4-65 Template for Batch Reports

[image: Description of Figure 4-65 follows]

Description of "Figure 4-65 Template for Batch Reports"





Table 4-16 shows the values of the form fields from the template in Figure 4-65.


Table 4-16 Fields for Creating Batch Reports

	Default Text Entry	Form Field Help Text	Description
	
for-each G_INVOICE

	
<?for-each@section:G_INVOICE?>

	
Begins the G_INVOICE group, and defines the element as a Section. For each occurrence of G_INVOICE, a new section is started.


	
<?TRX_NUMBER?>

	
N/A

	
Microsoft Word does not support form fields in the header, therefore the placeholder syntax for the TRX_NUMBER element is placed directly in the template.


	
end G_INVOICE

	
<?end for-each?>

	
Closes the G_INVOICE group.








Now for each new occurrence of the G_INVOICE element, a new section begins. The page numbers restart, and if header or footer information is derived from the data, it is reset as well.






4.14.2 Handling No Data Found Conditions

When you use @section with the BI Publisher commands for-each or for-each-group (for example: <?for-each@section:ELEMENT_NAME?>), and the input data file has no data, then an empty or invalid PDF output document may be generated for that for-each loop. To prevent this from happening, edit the RTF template.

To handle no data found conditions:

	
At the end of the RTF template, add a section break


	
On the last page (the new section page), add the command <?if@section:not(ELEMENT_NAME)?>No Data Found<?end if?>

where ELEMENT_NAME is the same data element that you are using in the for-each@section loop.

Now if no data exists for ELEMENT_NAME, a valid PDF is generated with the text "No Data Found".









4.14.3 Inserting Pivot Tables




	
Note:

For more information, see Section 5.4.5, "Inserting a Pivot Table."









The columns of a pivot table are data dependent. At design time you do not know how many columns are reported, or what the appropriate column headings are. Moreover, if the columns should break onto a second page, you must be able to define the row label columns to repeat onto subsequent pages. The following example shows how to design a simple pivot tale report that supports these features.

This example uses the following XML sample:


<ROWSET>
  <RESULTS>
    <INDUSTRY>Motor Vehicle Dealers</INDUSTRY>
    <YEAR>2005</YEAR>
    <QUARTER>Q1</QUARTER>
    <SALES>1000</SALES>
 </RESULTS>
  <RESULTS>
    <INDUSTRY>Motor Vehicle Dealers</INDUSTRY>
    <YEAR>2005</YEAR>
    <QUARTER>Q2</QUARTER>
    <SALES>2000</SALES>
  </RESULTS>
  <RESULTS>
    <INDUSTRY>Motor Vehicle Dealers</INDUSTRY>
    <YEAR>2004</YEAR>
    <QUARTER>Q1</QUARTER>
    <SALES>3000</SALES>
  </RESULTS>
  <RESULTS>
    <INDUSTRY>Motor Vehicle Dealers</INDUSTRY>
    <YEAR>2004</YEAR>
    <QUARTER>Q2</QUARTER>
    <SALES>3000</SALES>
  </RESULTS>
  <RESULTS>
    <INDUSTRY>Motor Vehicle Dealers</INDUSTRY>
    <YEAR>2003</YEAR>
     ...
  </RRESULTS>
  <RESULTS>
    <INDUSTRY>Home Furnishings</INDUSTRY>
     ...
  </RESULTS>
  <RESULTS>
    <INDUSTRY>Electronics</INDUSTRY>
     ...
  </RESULTS>
  <RESULTS>
    <INDUSTRY>Food and Beverage</INDUSTRY>
     ...
  </RESULTS>
            
</ROWSET>


From this XML code, a report is generated that shows each industry and totals the sales by year as shown in Figure 4-66.


Figure 4-66 Report of Yearly Totals

[image: Description of Figure 4-66 follows]

Description of "Figure 4-66 Report of Yearly Totals"





Figure 4-67 shows the template to generate the report that is shown in Figure 4-66.


Figure 4-67 Template for Yearly Totals

[image: Description of Figure 4-67 follows]

Description of "Figure 4-67 Template for Yearly Totals"





The form fields in the template that is shown in Figure 4-67 have the values that are described in Table 4-17.


Table 4-17 Fields for Inserting Tables

	Default Text Entry	Form Field Help Text	Description
	
header column

	
<?horizontal-break-table:1?>

	
Defines the first column as a header that should repeat if the table breaks across pages. For more information about this syntax, see Section 4.14.4.1, "Defining Columns to Repeat Across Pages."


	
for:

	
<?for-each-group@column:RESULTS;YEAR?>

	
Uses the regrouping syntax (see Section 4.12.3, "Regrouping the XML Data") to group the data by YEAR; and the @column context command to create a table column for each group (YEAR). For more information about context commands, see Section 4.18, "Controlling the Placement of Instructions Using the Context Commands."


	
YEAR

	
<?YEAR?>

	
Placeholder for the YEAR element.


	
end

	
<?end for-each-group?>

	
Closes the for-each-group loop.


	
for:

	
<?for-each-group:RESULTS;INDUSTRY?>

	
Begins the group to create a table row for each INDUSTRY.


	
INDUSTRY

	
<?INDUSTRY?>

	
Placeholder for the INDUSTRY element.


	
for:

	
<?for-each-group@cell:current-group();YEAR?>

	
Uses the regrouping syntax (see Section 4.12.3, "Regrouping the XML Data") to group the data by YEAR; and the @cell context command to create a table cell for each group (YEAR).


	
sum(Sales)

	
<?sum(current-group()//SALES)?>

	
Sums the sales for the current group (YEAR).


	
end

	
<?end for-each-group?>

	
Closes the for-each-group statement.


	
end

	
<?end for-each-group?>

	
Closes the for-each-group statement.








Note that only the first row uses the @column context to determine the number of columns for the table. All remaining rows must use the @cell context to create the table cells for the column. (For more information about context commands, see Section 4.18, "Controlling the Placement of Instructions Using the Context Commands.")






4.14.4 Constructing Dynamic Data Columns

The ability to construct dynamic data columns is a very powerful feature of the RTF template. Using this feature you can design a template that correctly renders a table when the number of columns that is required by the data is variable.

For example, you are designing a template to display columns of test scores within specific ranges. However, you do not how many ranges have data to report. You can define a dynamic data column to split into the correct number of columns at runtime.

Use the following tags to accommodate the dynamic formatting required to render the data correctly:

	
Dynamic Column Header

<?split-column-header:group element name?>

Use this tag to define which group to split for the column headers of a table.


	
Dynamic Column <?split-column-data:group element name?>

Use this tag to define which group to split for the column data of a table.


	
Dynamic Column Width

<?split-column-width:name?> or

<?split-column-width:@width?>

Use one of these tags to define the width of the column when the width is described in the XML data. The width can be described in two ways:

	
An XML element stores the value of the width. In this case, use the syntax <?split-column-width:name?>, where name is the XML element tag name that contains the value for the width.


	
If the element defined in the split-column-header tag, contains a width attribute, use the syntax <?split-column-width:@width?> to use the value of that attribute.





	
Dynamic Column Width's unit value (in points) <?split-column-width-unit:value?>

Use this tag to define a multiplier for the column width. If the column widths are defined in character cells, then you must use the appropriate multiplier value to render the columns to the correct width in points. For example, if you are using 10 point courier font in the table, you would use a multiplier of 6, which is the approximate width of a character displayed in 10 point courier font. If the multiplier is not defined, then the widths of the columns are calculated as a percentage of the total width of the table. The width calculation is illustrated in Table 4-18.


Table 4-18 Calculating Column Widths

	Width Definition	Column 1 (Width = 10)	Column 2 (Width = 12)	Column 3 (Width = 14)
	
Multiplier not present -% width

	
10/10+12+14*100 28%

	
%Width = 33%

	
%Width =39%


	
Multiplier = 6 - width

	
60 pts

	
72 pts

	
84 pts












4.14.4.1 Defining Columns to Repeat Across Pages

If the table columns expand horizontally across more than one page, you can define how many row heading columns you want to repeat on every page. Use the following syntax to specify the number of columns to repeat:

<?horizontal-break-table:number?>

where number is the number of columns (starting from the left) to repeat.

Note that this functionality is supported for PDF output only.






4.14.4.2 Example of Dynamic Data Columns

A template is required to display test score ranges for school exams. Logically, you want the report to be arranged as shown in Table 4-19.


Table 4-19 Dynamic Data Columns

	Test Score	Test Score Range 1	Test Score Range 2	Test Score Range 3	...Test Score Range n
	
Test Category

	
# students in Range 1

	
# students in Range 2

	
# students in Range 3

	
# of students in Range n








However, you do not know how many Test Score Ranges are reported. The number of Test Score Range columns is dynamic, depending on the data.

The following XML data describes these test scores. The number of occurrences of the element <TestScoreRange> determine how many columns are required. In this case there are five columns: 0-20, 21-40, 41-60, 61-80, and 81-100. For each column there is an amount element (<NumOfStudents>) and a column width attribute (<TestScore width="15">).


<?xml version="1.0" encoding="utf-8"?>
 <TestScoreTable>
  <TestScores>
    <TestCategory>Mathematics</TestCategory>
    <TestScore width ="15">
    <TestScoreRange>0-20</TestScoreRange>
    <NumofStudents>30</NumofStudents>
 </TestScore>
    <TestScore width ="20">
    <TestScoreRange>21-40</TestScoreRange>
    <NumofStudents>45</NumofStudents>
 </TestScore>
   <TestScore width ="15">
    <TestScoreRange>41-60</TestScoreRange>
    <NumofStudents>50</NumofStudents>
 </TestScore>
    <TestScore width ="20">
    <TestScoreRange>61-80</TestScoreRange>
    <NumofStudents>102</NumofStudents>
 </TestScore> 
    <TestScore width ="15"> 
    <TestScoreRange>81-100</TestScoreRange>
   <NumofStudents>22</NumofStudents>
 </TestScore>
 </TestScores> 
  <TestScoreTable> 


Using the dynamic column tags in form fields, set up the table in two columns as shown in Figure 4-68. The first column, "Test Score" is static. The second column, "Column Header and Splitting" is the dynamic column. At runtime this column is split according to the data, and the header for each column is appropriately populated. The Default Text entry and Form Field Help entry for each field are listed in Table 4-20. (See Section 4.3.1.2, "Using the Form Field Method" for more information on using form fields).


Figure 4-68 Dynamic Data Columns

[image: Description of Figure 4-68 follows]

Description of "Figure 4-68 Dynamic Data Columns"






Table 4-20 Fields for Dynamic Data Columns

	Default Text Entry	Form Field Help Text Entry
	
Group:TestScores

	
<?for-each:TestScores?>


	
Test Category

	
<?TestCategory?>


	
Column Header and Splitting

	
<?split-column-header:TestScore?> <?split-column-width:@width?> <?TestScoreRange?>%


	
Content and Splitting

	
<?split-column-data:TestScore?> <?NumofStudents?>


	
end:TestScores

	
<?end for-each?>








	
Test Score is the boilerplate column heading.


	
Test Category is the placeholder for the<TestCategory> data element, that is, "Mathematics," which is also the row heading.


	
The second column is the one to be split dynamically. The width you specify is divided by the number of columns of data. In this case, there are 5 data columns.


	
The second column contains the dynamic "range" data. The width of the column is divided according to the split column width. Because this example does not contain the unit value tag (<?split-column-width-unit:value?>), the column is split on a percentage basis. Wrapping of the data occurs if required.

If the tag (<?split-column-width-unit:value?>) were present, then the columns have a specific width in points. If the total column widths were wider than the allotted space on the page, then the table breaks onto another page.

The "horizontal-break-table" tag could then be used to specify how many columns to repeat on the subsequent page. For example, a value of "1" would repeat the column "Test Score" on the subsequent page, with the continuation of the columns that did not fit on the first page.




The template renders the output that is shown in Figure 4-69.


Figure 4-69 Report of Test Scores

[image: Description of Figure 4-69 follows]

Description of "Figure 4-69 Report of Test Scores"













4.15 Formatting Numbers, Dates, and Currencies

This section provides details for formatting numbers, dates, and currencies.



4.15.1 Formatting Numbers

BI Publisher supports two methods for specifying the number format:

	
Oracle's format-number function (recommended)


	
Microsoft Word's Native number format mask







	
Note:

You can also use the native XSL format-number function to format numbers. For information, see Section 4.21.2.8, "Formatting Native XSL Numbers."









Use only one of these methods. If the number format mask is specified using both methods, then the data is formatted twice, causing unexpected behavior.

The group separator and the number separator are set at runtime based on the template locale. If you are working in a locale other than en-US, or the templates require translation, use the Oracle format masks.






4.15.2 Data Source Requirements

To use the Oracle format mask or the Microsoft format mask, the numbers in the data source must be in a raw format, with no formatting applied (for example: 1000.00). If the number has been formatted for European countries (for example: 1.000,00) then the format does not work.

The BI Publisher parser requires the Java BigDecimal string representation. This consists of an optional sign ("-") followed by a sequence of zero or more decimal digits (the integer), optionally followed by a fraction, and optionally followed by an exponent. For example: -123456.3455e-3.






4.15.3 Localization Considerations

If you are working in a locale other than en-US, or the templates require translation, then use the Oracle format masks. The Microsoft format masks can generate unexpected results in templates run in different locale settings.

Do not include "%" in the format mask because this fixes the location of the percent sign in the number display, while the desired position could be at the beginning or the end of a number, depending on the locale.






4.15.4 Using the Microsoft Number Format Mask

To format numeric values, use Microsoft Word's field formatting features available from the Text Form Field Options dialog.

To apply a number format to a form field:

	
Open the Form Field Options dialog for the placeholder field.


	
Set the Type to Number.


	
Select the appropriate Number format from the list of options.









4.15.5 Supported Microsoft Format Mask Definitions

Table 4-21 lists the supported Microsoft format mask definitions.


Table 4-21 Supported Microsoft Format Mask Definitions

	Symbol	Location	Meaning
	
0

	
Number

	
Digit. Each explicitly set 0 appears, if no other number occupies the position.

Example:

Format mask: 00.0000

Data: 1.234

Display: 01.2340


	
#


	
Number

	
Digit. When set to #, only the incoming data is displayed.

Example:

Format mask: ##.####

Data: 1.234

Display: 1.234


	
.

	
Number

	
Determines the position of the decimal separator. The decimal separator symbol used is determined at runtime based on template locale.

Example:

Format mask: #,##0.00

Data: 1234.56

Display for English locale: 1,234.56

Display for German locale: 1.234,56


	
-

	
Number

	
Determines placement of minus sign for negative numbers.


	
,

	
Number

	
Determines the placement of the grouping separator. The grouping separator symbol used is determined at runtime based on template locale.

Example:

Format mask: #,##0.00

Data: 1234.56

Display for English locale: 1,234.56

Display for German locale: 1.234,56


	
E

	
Number

	
Separates mantissa and exponent in a scientific notation.

Example:

0.###E+0 plus sign always shown for positive numbers

0.###E-0 plus sign not shown for positive numbers


	
;

	
Subpattern boundary

	
Separates positive and negative subpatterns. See the Note that follows the table.


	
%


	
Prefix or Suffix

	
Multiply by 100 and show as percentage


	
'

	
Prefix or Suffix

	
Used to quote special characters in a prefix or suffix.











	
Note:

Subpattern boundary: A pattern contains a positive and negative subpattern, for example, "#,##0.00;(#,##0.00)". Each subpattern has a prefix, numeric part, and suffix. The negative subpattern is optional. If absent, the positive subpattern prefixed with the localized minus sign ("-" in most locales) is used as the negative subpattern. That is, "0.00" alone is equivalent to "0.00;-0.00". If there is an explicit negative subpattern, it serves only to specify the negative prefix and suffix. The number of digits, minimal digits, and other characteristics are all the same as the positive pattern. That means that "#,##0.0#;(#)" produces precisely the same behavior as "#,##0.0#;(#,##0.0#)".














4.15.6 Using the Oracle Format Mask

To apply the Oracle format mask to a form field:

	
Open the Form Field Options dialog box for the placeholder field.


	
Set the Type to "Regular text".


	
In the Form Field Help Text field, enter the mask definition according to the following example:

<?format-number:fieldname;'999G999D99'?>




where

fieldname is the XML tag name of the data element you are formatting and

999G999D99 is the mask definition.

Figure 4-70 shows an example Form Field Help Text dialog entry for the data element "empno".


Figure 4-70 Form Field Help Text Entry

[image: Description of Figure 4-70 follows]

Description of "Figure 4-70 Form Field Help Text Entry"





Table 4-22 lists the supported Oracle number format mask symbols and their definitions.


Table 4-22 Supported Oracle Number Format Mask Symbols

	Symbol	Meaning
	
0

	
Digit. Each explicitly set 0 appears, if no other number occupies the position. Example: Format mask: 00.0000 Data: 1.234 Display: 01.2340


	
9

	
Digit. Returns value with the specified number of digits with a leading space if positive or a leading minus if negative. Leading zeros are blank, except for a zero value, which returns a zero for the integer part of the fixed-point number. Example: Format mask: 99.9999 Data: 1.234 Display: 1.234


	
C

	
Returns the ISO currency symbol in the specified position.


	
D

	
Determines the placement of the decimal separator. The decimal separator symbol used is determined at runtime based on template locale. For example: Format mask: 9G999D99 Data: 1234.56 Display for English locale: 1,234.56 Display for German locale: 1.234,56


	
EEEE

	
Returns a value in scientific notation.


	
G

	
Determines the placement of the grouping (thousands) separator. The grouping separator symbol used is determined at runtime based on template locale. For example: Format mask: 9G999D99 Data: 1234.56 Display for English locale: 1,234.56 Display for German locale: 1.234,56


	
L

	
Returns the local currency symbol in the specified position.


	
MI

	
Displays negative value with a trailing "-".


	
PR

	
Displays negative value enclosed by <>


	
PT

	
Displays negative value enclosed by ()


	
S (before number)

	
Displays positive value with a leading "+" and negative values with a leading "-"


	
S (after number)

	
Displays positive value with a trailing "+" and negative value with a trailing "-"












4.15.7 Formatting Dates

BI Publisher supports three methods for specifying the date format:

	
Specify an explicit date format mask using Microsoft Word's native date format mask.


	
Specify an explicit date format mask using Oracle's format-date function.


	
Specify an abstract date format mask using Oracle's abstract date format masks. (Recommended for multilingual templates.)




Only one method should be used. If both the Oracle and MS format masks are specified, the data is formatted twice, which causes unexpected behavior.






4.15.8 Data Source Requirements

To use the Microsoft format mask or the Oracle format mask, the date from the XML data source must be in canonical format. This format is:

YYYY-MM-DDThh:mm:ss+HH:MM

where

	
YYYY is the year


	
MM is the month


	
DD is the day


	
T is the separator between the date and time component


	
hh is the hour in 24-hour format


	
mm is the minutes


	
ss is the seconds


	
+HH:MM is the time zone offset from Universal Time (UTC), or Greenwich Mean Time




An example of this construction is:

2005-01-01T09:30:10-07:00

The data after the "T" is optional, therefore the following date: 2005-01-01 can be formatted using either date formatting option.




	
Note:

If the time component and time zone offset are not included in the XML source date, then BI Publisher assumes it represents 12:00 AM UTC (that is, yyyy-mm-ddT00:00:00-00:00).














4.15.9 Using the Microsoft Date Format Mask

To apply a date format to a form field:

	
Open the Form Field Options dialog box for the placeholder field.


	
Set the Type to Date, Current Date, or Current Time.


	
Select the appropriate Date format from the list of options.




If you do not specify the mask in the Date format field, then the abstract format mask "MEDIUM" is used as default. See Section 4.15.12, "Oracle Abstract Format Masks" for the description.

Table 4-23 lists the supported Microsoft date format mask components.


Table 4-23 Supported Microsoft Date Format Mask Components

	Symbol	Meaning
	
d

	
The day of the month. Single-digit days do not have a leading zero.


	
dd

	
The day of the month. Single-digit days have a leading zero.


	
ddd

	
The abbreviated name of the day of the week, as defined in AbbreviatedDayNames.


	
dddd

	
The full name of the day of the week, as defined in DayNames.


	
M

	
The numeric month. Single-digit months do not have a leading zero.


	
MM

	
The numeric month. Single-digit months have a leading zero.


	
MMM

	
The abbreviated name of the month, as defined in AbbreviatedMonthNames.


	
MMMM

	
The full name of the month, as defined in MonthNames.


	
yy

	
The year without the century. If the year without the century is less than 10, the year is displayed with a leading zero.


	
yyyy

	
The year in four digits.


	
gg

	
The period or era. This pattern is ignored if the date to be formatted does not have an associated period or era string.


	
h

	
The hour in a 12-hour clock. Single-digit hours do not have a leading zero.


	
hh

	
The hour in a 12-hour clock. Single-digit hours have a leading zero.


	
H

	
The hour in a 24-hour clock. Single-digit hours do not have a leading zero.


	
HH

	
The hour in a 24-hour clock. Single-digit hours have a leading zero.


	
m

	
The minute. Single-digit minutes do not have a leading zero.


	
mm

	
The minute. Single-digit minutes have a leading zero.


	
s

	
The second. Single-digit seconds do not have a leading zero.


	
ss

	
The second. Single-digit seconds do have a leading zero.


	
f

	
Displays seconds fractions represented in one digit.


	
ff

	
Displays seconds fractions represented in two digits.


	
fff

	
Displays seconds fractions represented in three digits.


	
ffff

	
Displays seconds fractions represented in four digits.


	
fffff

	
Displays seconds fractions represented in five digits.


	
ffffff

	
Displays seconds fractions represented in six digits.


	
fffffff

	
Displays seconds fractions represented in seven digits.


	
tt

	
The AM/PM designator defined in AMDesignator or PMDesignator, if any.


	
z

	
Displays the time zone offset for the system's current time zone in whole hours only. (This element can be used for formatting only)


	
zz

	
Displays the time zone offset for the system's current time zone in whole hours only. (This element can be used for formatting only)


	
zzz

	
Displays the time zone offset for the system's current time zone in hours and minutes.


	
:

	
The default time separator defined in TimeSeparator.


	
/


	
The default date separator defined in DateSeparator.


	
'

	
Quoted string. Displays the literal value of any string between two ' characters.


	
"

	
Quoted string. Displays the literal value of any string between two " characters.












4.15.10 Using the Oracle Format Mask

To apply the Oracle format mask to a date field:

	
Open the Form Field Options dialog box for the placeholder field.


	
Set the Type to Regular Text.


	
Select the Add Help Text... button to open the Form Field Help Text dialog.


	
Insert the following syntax to specify the date format mask:

<?format-date:date_string; 'ABSTRACT_FORMAT_MASK';'TIMEZONE'?>

or

<?format-date-and-calendar:date_string; 'ABSTRACT_FORMAT_MASK';'CALENDAR_NAME';'TIMEZONE'?>

where time zone is optional. The detailed usage of format mask, calendar and time zone is described below.

If no format mask is specified, then the abstract format mask "MEDIUM" is used as the default.

Example form field help text entry:

<?format-date:hiredate;'YYYY-MM-DD'?>




Table 4-24 lists the supported Oracle format mask components.


Table 4-24 Supported Oracle Format Mask Components

	Symbol	Meaning
	
- / , . ; : "text"

	
Punctuation and quoted text are reproduced in the result.


	
AD A.D.

	
AD indicator with or without periods.


	
AM A.M.

	
Meridian indicator with or without periods.


	
BC B.C.

	
BC indicator with or without periods.


	
CC

	
Century. For example, 2002 returns 21; 2000 returns 20.


	
DAY

	
Name of day, padded with blanks to length of 9 characters.


	
D

	
Day of week (1-7).


	
DD

	
Day of month (1-31).


	
DDD

	
Day of year (1-366).


	
DL

	
Returns a value in the long date format.


	
DS

	
Returns a value in the short date format.


	
DY

	
Abbreviated name of day.


	
E

	
Abbreviated era name.


	
EE

	
Full era name.


	
FF[1..9]

	
Fractional seconds. Use the numbers 1 to 9 after FF to specify the number of digits in the fractional second portion of the datetime value returned.

Example:

'HH:MI:SS.FF3'


	
HH

	
Hour of day (1-12).


	
HH12

	
Hour of day (1-12).


	
HH24

	
Hour of day (0-23).


	
MI

	
Minute (0-59).


	
MM

	
Month (01-12; JAN = 01).


	
MON

	
Abbreviated name of month.


	
MONTH

	
Name of month, padded with blanks to length of 9 characters.


	
PM P.M.

	
Meridian indicator with or without periods.


	
RR

	
Lets you store 20th century dates in the 21st century using only two digits.


	
RRRR

	
Round year. Accepts either 4-digit or 2-digit input. If 2-digit, provides the same return as RR. If you don't want this functionality, then simply enter the 4-digit year.


	
SS

	
Seconds (0-59).


	
TZD

	
Daylight savings information. The TZD value is an abbreviated time zone string with daylight savings information. It must correspond to the region specified in TZR.

Example:

PST (for Pacific Standard Time)

PDT (for Pacific Daylight Time)


	
TZH

	
Time zone hour. (See TZM format element.)


	
TZM

	
Time zone minute. (See TZH format element.)

Example:

'HH:MI:SS.FFTZH:TZM'


	
TZR

	
Time zone region information. The value must be one of the time zone regions supported in the database.

Example:

PST (Pacific Standard Time)


	
WW

	
Week of year (1-53) where week 1 starts on the first day of the year and continues to the seventh day of the year.


	
W

	
Week of month (1-5) where week 1 starts on the first day of the month and ends on the seventh.


	
X

	
Local radix character.


	
YYYY

	
4-digit year.


	
YY Y

	
Last 2, or 1 digit(s) of year.












4.15.11 Default Format Mask

If you do not want to specify a format mask with either the MS method or the Oracle method, you can omit the mask definition and use the default format mask. The default format mask is the MEDIUM abstract format mask from Oracle. (See Section 4.15.12, "Oracle Abstract Format Masks" for the definition.)

To use the default option using the Microsoft method, set the Type to Date, but leave the Date format field blank in the Text Form Field Options dialog.

To use the default option using the Oracle method, do not supply a mask definition to the "format-date" function call, for example:

<?format-date:hiredate?>






4.15.12 Oracle Abstract Format Masks

The abstract date format masks reflect the default implementations of date/time formatting in the I18N library. When you use one of these masks, the output generated depends on the locale that is associated with the report.

Specify the abstract mask using the following syntax:


<?format-date:fieldname;'MASK'?>


where fieldname is the XML element tag and

MASK is the Oracle abstract format mask name

For example:


<?format-date:hiredate;'SHORT'?>
<?format-date:hiredate;'LONG_TIME_TZ'?>
<?format-date:xdoxslt:sysdate_as_xsdformat();'MEDIUM'?>


Table 4-25 lists the abstract format masks and the sample output that would be generated for the US locale.


Table 4-25 Abstract Format Masks and Sample Output

	Mask	Output for US Locale
	
SHORT

	
2/31/99


	
MEDIUM

	
Dec 31, 1999


	
LONG

	
Friday, December 31, 1999


	
SHORT_TIME

	
12/31/99 6:15 PM


	
MEDIUM_TIME

	
Dec 31, 1999 6:15 PM


	
LONG_TIME

	
Friday, December 31, 1999 6:15 PM


	
SHORT_TIME_TZ

	
12/31/99 6:15 PM GMT


	
MEDIUM_TIME_TZ

	
Dec 31, 1999 6:15 PM GMT


	
LONG_TIME_TZ

	
Friday, December 31, 1999 6:15 PM GMT












4.15.13 Displaying the System Date (sysdate) in Reports

To correctly display the sysdate, use the function xdoxslt:sysdate_as_xsdformat() with the <?format-date:?> command.

For example:


<?format-date:xdoxslt:sysdate_as_xsdformat();'MEDIUM'?> 




<?format-date:xdoxslt:sysdate_as_xsdformat();'LONG'?>



<?format-date:xdoxslt:sysdate_as_xsdformat();'LONG_TIME_TZ'?> 




<?format-date-and-calendar:xdoxslt:sysdate_as_xsdformat(); 
    'LONG_TIME';'ROC_OFFICIAL';?> 







4.15.14 Formatting Currencies

BI Publisher enables you to define specific currency format masks to apply to the published data at runtime.

To utilize currency formatting in the RTF template:

	
Set up the currency formats in BI Publisher's runtime configuration properties. The currency formats can be defined at the system level or at the report level.

When you set up the currency format property, you define the format to be used for a specified currency, using the International Standards Organization (ISO) currency code. A sample is shown in Figure 4-71.


Figure 4-71 Sample Currency Codes

[image: Description of Figure 4-71 follows]

Description of "Figure 4-71 Sample Currency Codes"





See Section 2.8.5, "Configuring Currency Formats" for more information.


	
Enter the format-currency command in the RTF template to apply the format to the field at runtime, as described in Section 4.15.15, "Applying a Currency Format to a Field."









4.15.15 Applying a Currency Format to a Field

The parameters for the format-currency function are as follows:


<?format-currency:Amount_Field;CurrencyCode;displaySymbolOrNot?>


where

Amount_Field takes the tag name of the XML element that holds the amount value in the data.

CurrencyCode can either be set to a static value or it can be set dynamically. If the value is static for the report, then enter the ISO three-letter currency code in single-quotes, for example, 'USD'.

To set the value dynamically, enter the tag name of the XML element that holds the ISO currency code. Note that an element that contains the currency code must be present in the data.

At runtime, the Amount_Field is formatted according to the format you set up for the currency code in the report properties.

displaySymbolOrNot takes one of the following values as shown in single quotes: 'true' or 'false'. When set to 'true', the currency symbol is displayed in the report based on the value for CurrencyCode. If you do not want the currency symbol to be displayed, then you can either enter 'false' or simply do not specify the parameter.






4.15.16 Example: Displaying Multiple Currency Formats in a Report

Table 4-26 provides an example that assumes you have set up the various currency formats in the report properties.


Table 4-26 display multiple currency formats

	Currency Code	Format Mask
	
USD

	
9G999D99


	
INR

	
9G99G99G999D99








In this example, you need not set the currency code dynamically. You have the following elements in the XML data:


<TOTAL_SALES>
    <US_SALES>8596526459.56</US_SALES>
    <INDIA_SALES>60000000</INDIA_SALES>
</TOTAL_SALES>


You want to display these two total fields in the template.

For US_SALES, the syntax in the BI Publisher properties field is as follows:


<?format-currency:US_SALES;'USD'?>


Figure 4-72 shows the two fields in a template with the BI Publisher Properties dialog displaying the entry for INDIA_SALES;


Figure 4-72 Properties to Display Sales

[image: Description of Figure 4-72 follows]

Description of "Figure 4-72 Properties to Display Sales"





At runtime, the fields are displayed as shown in Figure 4-73.


Figure 4-73 Displaying Sales Fields

[image: Description of Figure 4-73 follows]

Description of "Figure 4-73 Displaying Sales Fields"









4.15.17 Example: Displaying Multiple Currency Codes in a Single Report

The following simple XML code includes an element that contains the Amount (Trans_amount) and an element that contains the ISO currency code (Cur_Code):


<ROW>
  <Trans_Amount>123</Trans_Amount>
  <Cur_Code>USD</Cur_Code>
</ROW>
<ROW>
  <Trans_Amount>-456</Trans_Amount>
  <Cur_Code>GBP</Cur_Code>
</ROW>
<ROW>
  <Trans_Amount>748</Trans_Amount>
  <Cur_Code>EUR</Cur_Code>
</ROW>
<ROW>
  <Trans_Amount>-987</Trans_Amount>
  <Cur_Code>JPY</Cur_Code>
</ROW>


To display each of these amounts with the appropriate currency symbol, enter the following in the template for the field in which you want the amounts to display:


<?format-currency:Trans_Amount;Cur_Code;'true'?>


Figure 4-74 shows the report that is generated.


Figure 4-74 Multiple Currency Report

[image: Description of Figure 4-74 follows]

Description of "Figure 4-74 Multiple Currency Report"











4.16 Supporting Calendars and Time Zones

This section describes support for calendars and time zones.



4.16.1 Calendar Specification

The term "calendar" refers to the calendar date displayed in the published report. The following types are supported:

	
GREGORIAN


	
ARABIC_HIJRAH


	
ENGLISH_HIJRAH


	
JAPANESE_IMPERIAL


	
THAI_BUDDHA


	
ROC_OFFICIAL (Taiwan)




Use one of the following methods to set the calendar type:

	
Call the format-date-and-calendar function and declare the calendar type.

For example:<?format-date-and-calendar:hiredate;'LONG_TIME_TZ';'ROC_OFFICIAL';?>

Figure 4-75 shows the output generated using this definition with locale set to zh-TW and time zone set to Asia/Taipei:


Figure 4-75 Output with Locale Set to zh-TW

[image: Description of Figure 4-75 follows]

Description of "Figure 4-75 Output with Locale Set to zh-TW"





	
Set the calendar type using the profile option XDO: Calendar Type (XDO_CALENDAR_TYPE).







	
Note:

The calendar type that is specified in the template overrides the calendar type set in the profile option.














4.16.2 Time Zone Specification

There are two ways to specify time zone information:

	
Call the format-date or format-date-and-calendar function with the Oracle format.


	
Set the user profile option Client Timezone (CLIENT_TIMEZONE_ID) in Oracle Applications.




If no time zone is specified, then the report time zone is used.

In the template, the time zone must be specified as a Java time zone string, for example, America/Los Angeles. The following example shows the syntax to enter in the help text field of the template:

<?format-date:hiredate;'LONG_TIME_TZ';'Asia/Shanghai'?>








4.17 Using External Fonts

BI Publisher enables you to use external fonts in the output that are not normally available on the server. To set up a new font for the report output, use the font to design the template on your client machine, then make it available on the server, and configure BI Publisher to access the font at runtime.




	
Note:

External fonts are supported for PDF output only.









To use external fonts:

	
Use the font in the template.

	
Copy the font to the <WINDOWS_HOME>/fonts directory.


	
Open Microsoft Word and build the template.


	
Insert the font in the template: Select the text or form field and then select the desired font from the font dialog box (Format > Font) or font drop down list.

Figure 4-76 shows an example of the form field method and the text method.


Figure 4-76 Form Field and Text Methods

[image: Description of Figure 4-76 follows]

Description of "Figure 4-76 Form Field and Text Methods"








	
Place the font on the BI Publisher server in the ORACLE_HOME/common/fonts directory.




	
Note:

The predefined fonts are located in the Oracle Business Intelligence Oracle home, in: ORACLE_HOME/common/fonts. The font location is set by the XDO_FONT_DIR variable. If this variable is not set in your environment, then the fonts are located in $JAVA_HOME/jre/lib/fonts.










	
Set the BI Publisher "font" property.

You can set the font property for the report in the BI Publisher Font Mappings page, or in the configuration file.

To set the property in the Font Mappings page:

	
Open the report in the report editor.


	
Click Properties, then click Font Mappings.


	
Enter the font and then select the font to which you want to map it. See Section 2.8, "Configuring Report Properties."




To set the property in the configuration file:

	
Update the BI Publisher configuration file "fonts" section with the font name and its location on the server. For example, the new entry for a TrueType font is structured as follows:


<font family="MyFontName" style="normal" weight="normal">
    <truetype path="\user\fonts\MyFontName.ttf"/>
</font>





See the appendix "Configuration File Reference" in Oracle Fusion Middleware Administrator's Guide for Oracle Business Intelligence Publisher for more information.




Now you can run the report and BI Publisher uses the font in the output as designed. For PDF output, the advanced font handling features of BI Publisher embed the external font glyphs directly into the final document. The embedded font only contains the glyphs required for the document and not the complete font definition. Therefore the document is completely self-contained, eliminating the need to have external fonts installed on the printer.



4.17.1 Using the Barcode Fonts Shipped with BI Publisher

Table 4-27 describes the barcodes that are included with BI Publisher.


Table 4-27 Barcodes Included with BI Publisher

	Font File	Supported Algorithm
	
128R00.TTF

	
code128a, code128b, and code128c


	
B39R00.TTF

	
code39, code39mod43


	
UPCR00.TTF

	
upca, upce








When you use one of these prepackaged fonts, BI Publisher executes the preprocessing on the data prior to applying the barcode font to the data in the output document. For example, to calculate checksum values or start and end bits for the data before formatting them.

At design time it is not necessary that you apply the barcode font to the field in Microsoft Word. Instead, you can map the font that you apply to the field using BI Publisher's font mapping. At runtime, BI Publisher applies the barcode font to any field using the base font you specified in the font mapping. Be sure to choose a font that is not used elsewhere in the template. For information on font mapping, see Section 2.8, "Configuring Report Properties."

If you want to use the font directly in Microsoft Word, then add the appropriate .TTF file to the C:\WINDOWS\Fonts directory. To use the Template Builder Preview function, map the font in the Template Builder configuration file. See Section 4.22.5, "Configuring Fonts for the BI Publisher Template Builder."

To use the barcode fonts in the report output:

	
Insert a field in the template where the barcode is to display in the report output.


	
In the form field, enter the following command:

<?format-barcode:data;'barcode_type'?>

where

data is the element from the XML data source to be encoded. For example: INVOICE_NO

barcode_type is one of the supported algorithms listed above.

Examples:


<?format-barcode:INVOICE_NO;'code128a'?>

<?format-barcode:INVOICE_NO;'code39mod43'?>

<?format-barcode:INVOICE_NO;'upca'?> 


	
In Microsoft Word, apply the font to the field. If you have not installed the barcode fonts on your client machine, then select a font that is not used elsewhere in the template, for example, Bookman.


	
Configure the font in the Font Mapping page. For more information about the Font Mapping page, see Section 2.8, "Configuring Report Properties."




Note the following:

	
Microsoft Word may not render the barcode fonts properly even when they are installed on your client. To work around this issue, apply a different font to the field and map the font as described above.


	
The upca alogrithm accepts only UPC-A message string and encodes into UPC-A barcode.


	
A string of 12 characters is treated as UPC-A message with a check digit, 11 is without a check digit.


	
The upce algorithm accepts only UPC-E message strings and encodes into UPC-E barcode.


	
A string of 8 characters is treated as a UPC-E message with both a front and end guard bar; a string of 6 characters is without guard bars.









4.17.2 Implementing Custom Barcode Formats

If you choose to use a custom barcode instead, use this procedure to implement a custom barcode.

BI Publisher offers the ability to execute preprocessing on the data prior to applying a barcode font to the data in the output document. For example, you might need to calculate checksum values or start and end bits for the data before formatting them.

The solution requires that you register a barcode encoding class with BI Publisher that can then be instantiated at runtime to apply the formatting in the template. For information, see the section "Advanced Barcode Font Formatting" in Oracle Fusion Middleware Developer's Guide for Oracle Business Intelligence Publisher.

To enable the formatting feature in the template, you must use two commands in the template. The first command registers the barcode encoding class with BI Publisher. This must be declared somewhere in the template prior to the encoding command. The second is the encoding command to identify the data to be formatted.



4.17.2.1 Registering the Barcode Encoding Class

Use the following syntax in a form field in the template to register the barcode encoding class:


<?register-barcode-vendor:java_class_name;barcode_vendor_id?>


This command requires a Java class name (this carries out the encoding) and a barcode vendor ID as defined by the class. This command must be placed in the template before the commands to encode the data in the template. For example:


<?register-barcode-vendor:'oracle.xdo.template.rtf.util.barcoder.BarcodeUtil';'XMLPBarVendor'?>


where

oracle.xdo.template.rtf.util.barcoder.BarcodeUtil is the Java class and

XMLPBarVendor is the vendor ID that is defined by the class.






4.17.2.2 Encoding the Data

To format the data, use the following syntax in a form field in the template:


<?format-barcode:data;'barcode_type';'barcode_vendor_id'?>


where

data is the element from the XML data source to be encoded. For example: LABEL_ID

barcode_type is the method in the encoding Java class used to format the data (for example: Code128a).

barcode_vendor_id is the ID defined in the register-barcode-vendor field of the first command you used to register the encoding class.

For example:


<?format-barcode:LABEL_ID;'Code128a';'XMLPBarVendor'?>


At runtime, the barcode_type method is called to format the data value and the barcode font is then be applied to the data in the final output.










4.18 Controlling the Placement of Instructions Using the Context Commands

The BI Publisher syntax is simplified XSL instructions. This syntax, along with any native XSL commands you may use in the template, is converted to XSL-FO at runtime. The placement of these instructions within the converted stylesheet determines the behavior of the template.

BI Publisher's RTF processor places these instructions within the XSL-FO stylesheet according to the most common context. However, sometimes you must define the context of the instructions differently to create a specific behavior. To support this requirement, BI Publisher provides a set of context commands that allow you to define the context (or placement) of the processing instructions. For example, using context commands, you can:

	
Specify an if statement in a table to refer to a cell, a row, a column or the whole table.


	
Specify a for-each loop to repeat either the current data or the complete section (to create new headers and footers and restart the page numbering)


	
Define a variable in the current loop or at the beginning of the document.




You can specify a context for both processing commands using the BI Publisher syntax and those using native XSL.

	
To specify a context for a processing command using the simplified BI Publisher syntax, simply add @context to the syntax instruction. For example:

	
<?for-each@section:INVOICE?> - Specifies that the group INVOICE should begin a new section for each occurrence. By adding the section context, you can reset the header and footer and page numbering.

If you do not wnat to restart the page numbering, then add the command: <?initial-page-number:'auto'?> after the @section command to continue the page numbering across sections.


	
<?if@column:VAT?>  - Specifies that the if statement should apply to the VAT column only.





	
To specify a context for an XSL command, add the xdofo:ctx="context" attribute to the tags to specify the context for the insertion of the instructions. The value of the context determines where the code is placed.

For example:

<xsl:for-each xdofo:ctx="section" select ="INVOICE">

<xsl:attribute xdofo:ctx="inblock" name="background-color">red</xsl:attribute>




BI Publisher supports the context types that are described in Table 4-28.


Table 4-28 Supported Context Types

	Context	Description
	
section

	
The statement affects the whole section including the header and footer. For example, a for-each@section context command creates a new section for each occurrence - with restarted page numbering and header and footer. Note that you can retain continuous page numbering across sections by using the <?initial-page-number:'auto'?> command. See Section 4.14.1, "Creating Batch Reports" for an example of this usage.


	
column

	
The statement affects the whole column of a table. This context is typically used to show and hide table columns depending on the data. See Section 4.10.5, "Formatting Columns" for an example.


	
cell

	
The statement affects the cell of a table. This is often used together with @column in pivot tables to create a dynamic number of columns. See Section 4.14.3, "Inserting Pivot Tables" for an example.


	
block

	
The statement affects multiple complete fo:blocks (RTF paragraphs). This context is typically used for if and for-each statements. It can also be used to apply formatting to a paragraph or a table cell. See Section 4.10.7, "Highlighting Cells" for an example.


	
inline

	
The context becomes the single statement inside an fo:inline block. This context is used for variables.


	
incontext

	
The statement is inserted immediately after the surrounding statement. This is the default for <?sort?> statements that must follow the surrounding for-each as the first element.


	
inblock

	
The statement becomes a single statement inside an fo:block (RTF paragraph). This is typically not useful for control statements (such as if and for-each) but is useful for statements that generate text, such as call-template.


	
inlines

	
The statement affects multiple complete inline sections. An inline section is text that uses the same formatting, such as a group of words rendered as bold. See Section 4.10.2, "Using If Statements in Boilerplate Text."

If you use @inlines with if syntax, any other if syntax inside the statement must use the context command @inline.If you use @inlines with FOR-EACH syntax any other if or FOR-EACH syntax inside the satement must use the context command @inline.


	
begin

	
The statement is placed at the beginning of the XSL stylesheet. This is required for global variables. See Section 4.13.2, "Setting Parameters."


	
end

	
The statement is placed at the end of the XSL stylesheet.








Table 4-29 shows the default context for the BI Publisher commands.


Table 4-29 Default Context for BI Publisher Commands

	Command	Context
	
apply-template

	
inline


	
attribute

	
inline


	
call-template

	
inblock


	
choose

	
block


	
for-each

	
block


	
if

	
block


	
import

	
begin


	
param

	
begin


	
sort

	
incontext


	
template

	
end


	
value-of

	
inline


	
variable

	
end












4.19 Using XPath Commands

XPath is an industry standard developed by the World Wide Web Consortium (W3C). It is the method used to navigate through an XML document. XPath is a set of syntax rules for addressing the individual pieces of an XML document. You might not know it, but you have already used XPath; RTF templates use XPath to navigate through the XML data at runtime.

This section contains a brief introduction to XPath principles. For more information, see the W3C Web site: http://www.w3.org/TR/xpath

XPath follows the Document Object Model (DOM), which interprets an XML document as a tree of nodes. A node can be one of seven types:

	
root


	
element


	
attribute


	
text


	
namespace


	
processing instruction


	
comment




Many of these elements are shown in the following sample XML, which contains a catalog of CDs:


<?xml version="1.0" encoding="UTF-8"?>
<! -  My CD Listing  - >
<CATALOG>
 <CD cattype=Folk>
  <TITLE>Empire Burlesque</TITLE>
  <ARTIST>Bob Dylan</ARTIST>
  <COUNTRY>USA</COUNTRY>
  <PRICE>10.90</PRICE>
  <YEAR>1985</YEAR>
 </CD>
 <CD cattype=Rock>
  <TITLE>Hide Your Heart</TITLE>
  <ARTIST>Bonnie Tylor</ARTIST>
  <COUNTRY>UK</COUNTRY>
  <PRICE>9.90</PRICE>
  <YEAR>1988</YEAR>
  </CD>
</CATALOG>


The root node in this example is CATALOG. CD is an element, and it has an attribute cattype. The sample contains the comment My CD Listing. Text is contained within the XML document elements.



4.19.1 Locating Data

Locate information in an XML document using location-path expressions.

A node is the most common search element that you encounter. Nodes in the example CATALOG XML include CD, TITLE, and ARTIST. Use a path expression to locate nodes within an XML document. For example, the following path returns all CD elements:


//CATALOG/CD


where

the double slash (//) indicates that all elements in the XML document that match the search criteria are to be returned, regardless of the level within the document.

the slash (/) separates the child nodes. All elements matching the pattern are returned.

To retrieve the individual TITLE elements, use the following command:


/CATALOG/CD/TITLE


This example returns the following XML:


<CATALOG>
 <CD cattype=Folk>
  <TITLE>Empire Burlesque</TITLE>
  </CD>
 <CD cattype=Rock>
  <TITLE>Hide Your Heart</TITLE>
  </CD>
</CATALOG>


Further limit the search by using square brackets. The brackets locate elements with certain child nodes or specified values. For example, the following expression locates all CDs recorded by Bob Dylan:


/CATALOG/CD[ARTIST="Bob Dylan"]


Or, if each CD element did not have an PRICE element, you could use the following expression to return only those CD elements that include a PRICE element:


/CATALOG/CD[PRICE]


Use the bracket notation to leverage the attribute value in the search. Use the @ symbol to indicate an attribute. For example, the following expression locates all Rock CDs (all CDs with the cattype attribute value Rock):


//CD[@cattype="Rock"]


This returns the following data from the sample XML document:


<CD cattype=Rock>
  <TITLE>Hide Your Heart</TITLE>
  <ARTIST>Bonnie Tylor</ARTIST>
  <COUNTRY>UK</COUNTRY>
  <PRICE>9.90</PRICE>
  <YEAR>1988</YEAR>
</CD>



You can also use brackets to specify the item number to retrieve. For example, the first CD element is read from the XML document using the following XPath expression:


/CATALOG/CD[1]


The sample returns the first CD element:


<CD cattype=Folk>
  <TITLE>Empire Burlesque</TITLE>
  <ARTIST>Bob Dylan</ARTIST>
  <COUNTRY>USA</COUNTRY>
  <PRICE>10.90</PRICE>
  <YEAR>1985</YEAR>
 </CD>



XPath also supports wildcards to retrieve every element contained within the specified node. For example, to retrieve all the CDs from the sample XML, use the following expression:


/CATALOG/*


You can combine statements with Boolean operators for more complex searches. The following expression retrieves all Folk and Rock CDs, thus all the elements from the sample:


//CD[@cattype="Folk"]|//CD[@cattype="Rock"]


The pipe (|) is equal to the logical OR operator. In addition, XPath recognizes the logical OR and AND, as well as the equality operators: <=, <, >, >=, ==, and !=. For example, you can find all CDs released in 1985 or later using the following expression:


/CATALOG/CD[YEAR >=1985]






4.19.2 Starting Reference

The first character in an XPath expression determines the point at which it should start in the XML tree. Statements beginning with a forward slash (/) are considered absolute. No slash indicates a relative reference. An example of a relative reference is:


CD/*


This statement begins the search at the current reference point. That means if the example occurred within a group of statements the reference point left by the previous statement would be utilized.

As noted earlier, double forward slashes (//) retrieve every matching element regardless of location in the document, therefore the use of double forward slashes (//) should be used only when necessary to improve performance.






4.19.3 Specifying Context and Parents

To select current and parent elements, XPath recognizes the dot notation commonly used to navigate directories. Use a single period (.) to select the current node and use double periods (..) to return the parent of the current node. For example, to retrieve all child nodes of the parent of the current node, use:


../*


Therefore, to access all CDs from the sample XML, use the following expression:


/CATALOG/CD/..


You could also access all the CD tittles released in 1988 using the following:


/CATALOG/CD/TITLE[../YEAR=1988]


The two periods (..) are used to navigate up the tree of elements to find the YEAR element at the same level as the TITLE, where it is then tested for a match against "1988". You could also use // in this case, but if the element YEAR is used elsewhere in the XML document, then you might get erroneous results.

XPath is an extremely powerful standard when combined with RTF templates allowing you to use conditional formatting and filtering in the template.








4.20 Declaring Namespaces

If the XML data contains namespaces, you must declare them in the template prior to referencing the namespace in a placeholder. Declare the namespace in the template using either the basic RTF method or in a form field. Enter the following syntax:

<?namespace:namespace name= namespace url?>

For example:

<?namespace:fsg=http://www.example.com/fsg/2002-30-20/?>

Once declared, you can use the namespace in the placeholder markup, for example: <?fsg:ReportName?>






4.21 Using FO Elements and XSL Elements

This section describes how to use FO elements and XSL elements.



4.21.1 Using FO Elements

You can use the native FO syntax inside the Microsoft Word form fields.

For more information on XSL-FO see the W3C Website at http://www.w3.org/2002/08/XSLFOsummary.html

The full list of FO elements that BI Publisher supports is in Appendix D, "Supported XSL-FO Elements."






4.21.2 Using XSL Elements

You can use any XSL element in the template by inserting the XSL syntax into a form field.

If you are using the basic RTF method, you cannot insert XSL syntax directly into the template. BI Publisher has extended the following XSL elements for use in RTF templates.

To use these in a basic-method RTF template, you must use the BI Publisher Tag form of the XSL element. If you are using form fields, use either option.



4.21.2.1 Applying a Template Rule

Use this element to apply a template rule to the current element's child nodes.

XSL Syntax: <xsl:apply-templates select="name">

BI Publisher Tag: <?apply:name?>

This function applies to <xsl:template-match="n"> where n is the element name.






4.21.2.2 Copying the Current Node

Use this element to create a copy of the current node.

XSL Syntax: <xsl:copy-of select="name">

BI Publisher Tag: <?copy-of:name?>






4.21.2.3 Calling a Named Template

Use this element to call a named template to be inserted into or applied to the current template. For example, use this feature to render a table multiple times.

XSL Syntax: <xsl:call-template name="name">

BI Publisher Tag: <?call-template:name?>






4.21.2.4 Declaring a Template

Use this element to apply a set of rules when a specified node is matched.

XSL Syntax: <xsl:template name="name">

BI Publisher Tag: <?template:name?>






4.21.2.5 Declaring a Variable

Use this element to declare a local or global variable.

XSL Syntax: <xsl:variable name="name">

BI Publisher Tag: <?variable:name?>

Example:


<xsl:variable name="color" select="'red'"/> 


Assigns the value "red" to the "color" variable. The variable can then be referenced in the template.






4.21.2.6 Importing a Style Sheet

Use this element to import the contents of one style sheet into another.




	
Note:

An imported style sheet has lower precedence than the importing style sheet.









XSL Syntax: <xsl:import href="url">

BI Publisher Tag: <?import:url?>






4.21.2.7 Defining the Root Element of the Style Sheet

This and the <xsl:stylesheet> element are completely synonymous elements. Both are used to define the root element of the style sheet.




	
Note:

An included style sheet has the same precedence as the including style sheet.









XSL Syntax: <xsl:stylesheet xmlns:x="url">

BI Publisher Tag: <?namespace:x=url?>




	
Note:

The namespace must be declared in the template. See Section 4.20, "Declaring Namespaces."














4.21.2.8 Formatting Native XSL Numbers

The native XSL format-number function takes the basic format:


format-number(number,format,[decimalformat])


The following list describes the parameters:

	
number - Required. Specifies the number to be formatted.


	
format - Required. Specifies the format pattern. Use the following characters to specify the pattern:

	
# (Denotes a digit. Example: ####)


	
0 (Denotes leading and following zeros. Example: 0000.00)


	
. (The position of the decimal point Example: ###.##)


	
, (The group separator for thousands. Example: ###,###.##)


	
% (Displays the number as a percentage. Example: ##%)


	
; (Pattern separator. The first pattern is used for positive numbers and the second for negative numbers)





	
decimalformat - Optional. For more information on the decimal format, consult any basic XSLT manual.













4.22 Guidelines for Designing RTF Templates for Microsoft PowerPoint Output

BI Publisher can generate the RTF template as PowerPoint output enabling you to get report data into key business presentations. Currently, the PowerPoint document generated is a simple export of the formatted data and charts to PowerPoint.



4.22.1 Limitations

Following are limitations when working with PowerPoint as an output:

	
When designing tables for a PowerPoint slide, you must define the table border type as a single line (double border, dash, and other types are not supported).


	
Hyperlinks are not supported.


	
Shapes are not supported.


	
Text position may be slightly incorrect if you use right-align.


	
Paper size must be the same on all pages of the RTF template. You cannot have mixed paper sizes in the same document.


	
Bidirectional languages are not supported.


	
Text position may be slightly incorrect for Chinese, Japanese, and Korean fonts when using bold or italic effects on characters. This is because Microsoft uses bold or italic emulation when there is no bold or italic font.


	
All Unicode languages, except bidirectional languages, are supported.


	
BI Publisher's font fallback mechanism is not supported for PowerPoint templates. If you want to use a font that is not installed, then ensure that you have configured it with BI Publisher.









4.22.2 Usage Guidelines

Following are guidelines to help you when designing an RTF template intended for PowerPoint output:

	
PowerPoint output preserves the page orientation (portrait or landscape) defined in the RTF template. Most presentations are oriented in landscape so this is the recommended orientation of an RTF template.


	
A page break in an RTF template generates a new slide.


	
The background color of the slides are always generated as white. If you prefer a different background color, then you must change the color after the PowerPoint file is generated.


	
When highlighting characters in the page header or footer, when the font is not predefined in xdo.cfg, ensure that you specify the font for the whole tag "<?XXXXXX?>", including the "<?" and "?>" in the template.


	
When using multibyte characters (for example, simplified Chinese) in tables, ensure that the column widths are large enough to contain the width of the largest character plus the cell's left and right margins to avoid unexpected character display.









4.22.3 About Charts in PowerPoint Output

BI Publisher supports native PowerPoint charts for certain chart types rendered in PowerPoint2007 output. When the chart is inserted as a native chart, you can modify it in PowerPoint. If the chart is not inserted as a native chart, then BI Publisher inserts a PNG image that cannot be updated.

The following chart types can be rendered as native PowerPoint charts in PowerPoint2007 output:

	
Pie


	
Ring


	
Line


	
Area


	
Radar


	
Bubble


	
Pareto


	
Combination


	
Stock




Any chart type that is not native to PowerPoint (for example, gauge or funnel) is converted to a bar chart.

By default, native chart insertion is enabled. To disable native chart insertion for a report, set the report property Enable PPTX native chart support to false. See Chapter 10, "Setting Report Processing and Output Document Properties" for more information.

Note that when Enable PPTX native chart support is set to false, all charts are rendered as images in PowerPoint2007 output. Therefore, set this option to false only when a report includes the non-native chart types.






4.22.4 Configuring Fonts for the BI Publisher Server

Support for PowerPoint output does not include the font fallback mechanism that is used for other types of output in BI Publisher. If you are using a nonstandard font in the template, then you must configure the BI Publisher server for each font used in the RTF template for generating PowerPoint output. You must copy these fonts to the BI Publisher Server and define the Font Mappings for RTF templates. This can be done for the entire system or for individual reports. See Section 10.16, "Defining Font Mappings" for more details.






4.22.5 Configuring Fonts for the BI Publisher Template Builder

When using the BI Publisher Template Builder to design a report, to correctly preview PPT output that uses non-English or non-standard fonts, you must define the fonts in the BI Publisher configuration file. This configuration file is called xdo.cfg and is typically found in:

C:\Oracle\BI Publisher\BI Publisher Desktop\Template Builder for Word\config\

Note that if you have not used this file yet you might find the file "xdo example.cfg" instead. This file must be saved with an encoding of UTF-8 and provide a full and absolute path for each font defined. Otherwise, you encounter issues such as characters overlays and wrapping that does not work.

To configure fonts for the BI Publisher Template Builder:

	
Navigate to C:\Oracle\BI Publisher\BI Publisher Desktop\Template Builder for Word\config\


	
Open the xdo.cfg file and update the font mappings. For information on updating font mappings directly in the xdo.cfg file, see the section "Font Definitions" in Oracle Fusion Middleware Administrator's Guide for Oracle Business Intelligence Publisher.


	
Save the xdo.cfg in UTF-8 format.

Figure 4-77 shows a sample xdo.cfg file.





Figure 4-77 Sample xdo.cfg File

[image: Description of Figure 4-77 follows]

Description of "Figure 4-77 Sample xdo.cfg File"











4.23 Rendering HTML Formatted Data in a Report

This section describes how to preserve HTML formatting from a data source in your final output report. It contains the following topics:

	
Supported HTML Features


	
Data Model Requirements


	
RTF Template Requirements


	
Example






4.23.1 Supported HTML Features

Supported HTML features are:

	
Hyperlink


	
List

	
Bulleted list


	
Ordered list





	
Paragraph


	
Font style (bold, italic, plain, underline, subscript, superscript, strike-through)


	
Font size


	
Font family


	
Background color


	
Foreground color


	
Paragraph alignment (center, left, right, and justify)


	
Paragraph indent




The following HTML features are not supported:

	
Nested list (list with indent)


	
Any HTML tags or attributes manually inserted by modifying the HTML source code; for example, inserted tables or images.









4.23.2 Data Model Requirements

The XML data used as input to the report must wrap the HTML portion of the data in a CDATA section. See "Handling XHTML Data Stored in a CLOB Column" in the Oracle Fusion Middleware Data Modeling Guide for Oracle Business Intelligence Publisher for information about retrieving the HTML data for display in the report.






4.23.3 RTF Template Requirements

To render the HTML in your report, use the following tag in the RTF template:


<?html2fo: elementname?>


where elementname is the XML element name that contains the HTML data.






4.23.4 Example

This example uses the following XML data with embedded HTML data:


<?xml version="1.0" encoding="UTF-8"?>
<RTECODE>
<![CDATA[
<p><font style="font-style: italic; font-weight: bold;" size="3">
<a href="http://www.oracle.com">oracle</a></font> </p>
<p><font size="6"><a href="http://docs.oracle.com/">Oracle Documentation</a>
</font></p>
]]>
</RTECODE>

 


To render this sample as formatted HTML a report, enter the following in your RTF template:

<?html2fo: RTECODE?>

Figure 4-78 shows how the sample will render in the output report:


Figure 4-78 HTML Formatting from Data Rendered in Report

[image: HTML formatting from data rendered in report]










